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Serendipity Blackmagic User Manual

Copyright © Serendipity Software Pty Ltd

Reproduction of any part of this user manual is strictly forbidden without prior written permission from Serendipity
Software Pty Ltd. All company names, product names and trademarks mentioned in this manual are the property of the
respective company.

Important Notice

Every effort is made to ensure the information contained within this user manual is correct. Serendipity Software Pty
Ltd cannot be held responsible for any errors contained within this user manual and will not enter into any
negotiations for claims of compensation relating to actions taken resulting from the information provided in this user
manual for any reason whatsoever.

Serendipity Software Pty Ltd is constantly making improvements to the software and as such, this user manual may not
contain the latest information. Every effort is made to maintain the user manual and for the latest version please check
the website:

http://www.serendipity-software.com.au

If there are any errors within this user manual, please detail them in an email to: support@serendipity-software.com.au

Tutorials and HowTo documents are available on our website in the Serendipity Software Knowledge Base:

http://skb.serendipity-software.com.au/
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Product Overview

Serendipity Blackmagic is used to proof post-RIP data to either an output device, such as an Inkjet printer or to one of
several file formats.

Serendipity Blackmagic runs in a Server and Client configuration. The Server runs on a network computer and is
protected by a USB dongle. The dongle licenses the level of software and the input filters and output drivers purchased.

The Client is used as the configuration tool and monitoring application for the Server. It can be run on the same
machine, or on another locally (LAN) or remotely (WAN) networked computer. The Client connects to the Server via
standard TCP/IP network protocol and is not licensed, so it can be run multiple times on the network.

Serendipity Blackmagic has an input filter for most of the major manufacturers proprietary RIPs. The input filters read
the native RIP format and understand how jobs are assembled, the plates associated with a job and the directory
structure. RIPs that include databases and impositions are also read and understood. Jobs are proofed using the same
post-RIP data that goes to the press, thus maintaining data integrity and accuracy of the proofs.

Files are ripped once by the proprietary RIP and output as many times as desired. The jobs reside on the RIP, are
monitored by the Serendipity Blackmagic Server and are displayed by the Client in the RIPMonitor, with all associated
plates stitched together. The files can be selected and submitted for processing by the Server as desired, or can be
configured to process automatically. At the processing point, jobs are copied (spooled) over from the RIP to the Server,
leaving the original untouched. Once the whole job is spooled, the Server begins to work on the files.

Imaging is the first process to take place. Imaging interprets the file format, completes any imposition assembling
required (for supported imposition RIPs) or any merging of CT/LW files, preserves any screening on the files and
samples the jobs resolution to change it to that of the output format configured. An intermediate file format is created
at this point, called the Imaged File. The Imaged File can be viewed using the SoftProof utility. The file format maintains
all the plates associated with the job and is viewed at the full output resolution. The Imaged File can also be re-
submitted at any time for processing to the same or a different output. There is no need to spool and interpret the job
again. *

After the imaging process has completed, the job is passed to the rendering engine. This takes the Imaged File and
creates the file ready for output. The process includes applying any output characteristics such as orientation, cropping,
colour management (ICC Profiles) and creation of the configured format, whether for an Inkjet printer or a file format,
such as PDF.

The Imaged File can be rendered as many times as desired. Each time, any of the output characteristics can be changed
prior to rendering.

Once the job is rendered, it is submitted for printing to the output device or file format. Multiple output queues can be
created and multiple devices can be printed to simultaneously. Most of the output devices supported use a direct
printer driver allowing the Server more control of options, such as the selection of specific media and print directions.

The Client monitors the whole process from start to finish, showing a jobs progress in a QueueManager and
QueueStatus window. Jobs can be managed separately by placing a job on hold, releasing a job, cancelling or promoting
as desired. The processes (queues) can be paused at any time, holding all jobs from spooling, imaging, rendering or
printing. If a job fails, the error can be examined, rectified and the job retried. There are logs reporting all Server and
Client functionality and job information from first detection on the RIP to final output. The logs can be searched, filtered
or saved to a file.

The system creates a database of all configurations, calibration curves and other settings. This database can be backed-
up on demand or automatically, so a working copy is always available. It can be copied to any other Serendipity
Blackmagic as a whole database or as individual items.

*This applies to any output characteristics. If any changes are required for the Imaged File, e.g., changing plates, resolution etc, the file will need to be

re-submitted from the RIPMonitor.
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Installation

The installation section describes the process for each platform in turn.

The software is supplied on one DVD for Mac OS X, Linux and Windows versions. All versions come with a dongle and
require a dongle driver be installed. Existing installations of the software are given the opportunity to upgrade,
preserving any existing configurations.

What's on the DVD?

The DVD contains all elements required to run Serendipity Blackmagic and associated programs.

They are divided into directories, detailed below:

¢ Agent - Contains the Agent software for all supported platforms. Choose the subdirectory that matches the
required operating system.

* Docs - Contains all documentation.

* Dongle - Contains the dongle drivers for Linux, MacOSX and Windows.

* Drivers - Contains the Megarip PPDs for all supported platforms.

¢ Extras - Contains additional components and print drivers loaded as part of the install process.

¢ HTML - Contains the information required for the web browser install. This automatically launches the default
browser for installation to begin.

¢ Linux - Contains the Serendipity Blackmagic and AppleTalk installation packages for Linux.

* MacOSX - Contains the Serendipity Blackmagic installation package for MacOSX.

* Serendipity Client - Contains the Serendipity Client for all supported platforms.

* Testprn - Contains Serendipity internal test prints.

¢ Windows - Contains the Serendipity Blackmagic installation package for Windows.
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Windows Installation

Administrator rights are required to install Serendipity Blackmagic and the Serendipity Agent. If upgrading from an
existing installation to version 5.4, see “Upgrading to Version 5.4” within this manual.

Installing the Dongle Driver
The first step is to install the dongle driver.

To install:
1. Remove all SuperPro USB dongles.
2. Onthe DVD, navigate to the dongle/windows folder.
3. Double click the Sentinel Protection Installer.exe file to launch the installer.
4. Follow the onscreen instructions to complete the installation.
5. Restart the computer when finished.

Installing Serendipity Blackmagic
The next step once the dongle driver is installed is to install Serendipity Blackmagic. There are two (2) Windows files
available for installation — 32 bit or 64 bit version. Select the appropriate file for your system to install.

1. Either select and run the Blackmagic installer by clicking the link on the browser page (if it pops up as an
Autoplay when the disk is inserted), or go to the DVD and navigate to the Windows directory to run the file
blackmagic.msi (32 or 64 bit version)

2. Follow the onscreen instructions to complete the installation.

Note: You can type your own path and the installation program will make the folder for you, provided your chosen
location has valid permissions. Use back slashes (\) to separate directories.

Installation of the Serendipity Agent

If you are polling a RIP (or RIP folder) on a Windows machine, the most efficient method is to use the Serendipity
Remote Agent. This runs a service on the Windows machine where the RIP is located. Serendipity Blackmagic
communicates with the Agent to poll and transfer jobs.

To install:

1. Either
a. Select and run the Blackmagic installer by clicking the link on the browser page (if it pops up as an
Autoplay when the disk is inserted), or
b. Run the agent32.msi (32-bit) or agent64.msi (64-bit) file, located in the /agent/windows folder of
the installation DVD.
2. Follow the onscreen instructions to complete the installation.

Once the installation has finished, proceed to the “Running the Software” section of this manual.
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Mac OS X Installation

Administrator rights are required to install Serendipity Blackmagic and the Serendipity Agent. If upgrading from an
existing installation to version 5.4, see the “Upgrading to Version 5.4” section within this manual.

Installing the Dongle Driver
The first step is to install the dongle driver.

To install:
1. Remove all SuperPro USB dongles.
2. Onthe DVD, navigate to the dongle/macosx folder.
3. Double click the Sentinel System Driver.pkg file to launch the installer.
4. Follow the onscreen instructions to complete the installation.
5. Restart the computer when finished.

Installing the Serendipity Printer Drivers
The Serendipity Printer Drivers are used when setting up a Published Pagesetup for printing from a third party
application (e.g. Photoshop) directly to Blackmagic.

The installation package is located on the Blackmagic 5.4 Installation DVD:

1. Navigate to the /drivers/mac folder and run the file Serendipity Printer Drivers.pkg
2. An installer window will appear. Follow the prompts to complete the installation of the drivers. The installer
will require administrator access privileges.

Installing Serendipity Blackmagic

1. Go to the macosx folder on the Blackmagic installation DVD.
2. Double click the file Serendipity Blackmagic.pkg to launch the installer.
3. Follow the onscreen instructions to complete the installation.

Important Note: Before starting the software after installation, see the Running the Software section (Mac OS X only).

Installation of the Serendipity Agent

If you are polling a RIP (or RIP folder) on a Mac OS X machine, the most efficient method is to use the Serendipity
Remote Agent. This runs a service on the Mac OS X machine where the RIP is located. Serendipity Blackmagic
communicates with the Agent to poll and transfer jobs.

To install:

1. Select and run Serendipity Agent.pkg file located in the /agent/macosx folder on the installation DVD.
2. Follow the onscreen instructions to complete the installation.

Once the installation has finished, proceed to the “Running the Software” section of this manual.

Creating Dock Start Icons
To make it easy to start the Server and Client, it is recommended you create a Dock shortcut. To do this:

1. Run the Blackmagic Server and Client applications from the installation location.

2. Once the Server and Client icons appear in the dock, right click (or CTRL+click) the mouse and select Keep
in Dock from the menu.

3. Alternatively, drag the Server and Client icons directly onto the Dock before they have been launched.

4. Toremove the Dock icons, drag them off the Dock onto the desktop and release.

Serendipity Blackmagic User Manual - Version 5.4 9



Linux Installation

Installing the Dongle Driver
The first step is to install the dongle driver.

To install:
1. Remove all SuperPro USB dongles.

2. Navigate to the dongle/linux folder on the installation DVD.
3. Double-click the sntl-sud-7.5.1-0.i386.rpm file to install the driver.

Installing Serendipity Blackmagic

Important Note: Before installing on a Linux x64 operating system please ensure the following 1686 (32-bit) libraries
are installed.

¢ libstdc++.i686 GNU Standard C++ Library

* mesa-libGLU.i686 Mesa libGLU runtime library

* zlib.i686 The zlib compression and decompression library

* freetype.i686 A free and portable font rendering engine

¢ libXrender.i686 X.0rg X11 libXrender runtime library

* fontconfig.i686 Font configuration and customisation library

¢ glib2.i686 A library of handy utility functions

* libpng.i686 A library of functions for manipulating PNG image format files
¢ libSM.i686 X.0rg X11 Sm runtime library

If the Package Installer can not locate the libraries, open a terminal window, go to the /root directory and install each
library using the following command:

yum install name of library

To install Blackmagic:

Navigate to the linux folder on the installation DVD.

Double-click the install.sh file and select “Run in Terminal”.

A terminal window will pop-up and the installer will display the default installation directory.
Press Enter to install or type an alternative path then press Enter.

W

Note: If using an alternate install path, ensure the folder exists and that the current user has read/write/execute
permissions for the folder.

5. When the installation is complete the terminal window will close.

Once the installation has finished, proceed to the “Running the Software” section of this manual.
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Upgrading to Version 5.4

This section details upgrading an existing Blackmagic installation to version 5.4. The Installer automatically upgrades
the existing database to the current 5.4 format. As a precaution before upgrading, it is recommended that the
Blackmagic database and ICC profiles are backed-up using the Archives application (see Windows Upgrade or Mac 0S X
Upgrade sections for details), or by copying the database directories (see Copying the Database and ICC Folders section
for details).

Important Note: Pagesetups imported from Version 3 archives will automatically be split into Media and Pagesetup
data types but remain functionally linked. Version 5.4 archives cannot be opened or imported into previous versions of
Blackmagic.

Windows - Upgrading to Version 5.4

Archiving Current Installations
To Archive a Database:

1. Run the existing Blackmagic Server and Serendipity Client.
2. Go to the Serendipity Client Application menu > Archives
(This application is called Archiver in earlier versions).

3. Select File menu > Perform Full Backup.

4. Alternatively, select Edit menu > Add to Archive (all) and
add all database items to the archive file, or right-click in
the Archives window and select Add to Archive (all) >
Everything from the contextual menu.

5. Once all database items have appeared in the Archives
window, select File menu > Save Archive to save the .sdb
archive file to a chosen location.

6. Close the Archives application when finished.

Installing the Dongle Driver Update
Version 5 dongles (new or upgraded) require an up-to-date Safenet dongle driver in order to function.

To upgrade:

1. Make sure the Blackmagic Server and Client are not running and remove any Blackmagic (or any other
SuperPro USB) dongles from the computer.

2. On the Blackmagic installation DVD, navigate to the dongle/windows folder and run the Sentinel

Protection Installer.exe file. Alternatively, download and run the latest driver install from the Safenet

website (http://www.safenet-inc.com/support-downloads/sentinel-drivers/).

Run the Sentinel installer.

Select Upgrade and Next.

Follow the onscreen instructions to complete the upgrade.

Restart the computer when finished.

o1k Ww

Installing C++ Runtime Libraries

To run correctly, Blackmagic 5.4 requires the installation of Microsoft Visual C++ Redistributable libraries that may not
be present in your Windows operating system. If these were not installed for the existing Blackmagic version, they will
need to be installed now.

To install:

1. Navigate to the windows folder on the Blackmagic DVD.
a. For Windows 32-bit - Run the vcredist_x86.exe file
b. For Windows 64-bit — Run the vcredist x64.exe file
2. Follow the prompts to install Microsoft Visual C++ 2008 Redistributable.

Serendipity Blackmagic User Manual - Version 5.4 11



Installing the Blackmagic 5.4 Upgrade
Current Windows file/folder security and permissions makes it necessary to install Blackmagic v5.4 in the root
directory of the hard drive, e.g., C:\Serendipity\ rather than Program Files, where earlier versions of Blackmagic were

installed.

To upgrade:

1.
2.
3.

4,
5.
6.

Insert the Blackmagic installation DVD and navigate to the windows folder.

Run the blackmagic32.msi (32-bit) or the blackmagic64.msi (64-bit) file.

If necessary, change the installation directory to the root directory of the hard drive, e.g. C:\Serendipity\
and click Next.

Follow the onscreen instructions to complete the upgrade.

Plug the Blackmagic dongle into an available USB port.

Start the Blackmagic v5.4 Server and the Serendipity Client.

If the installation location did not require changing, the existing database should appear once the Server and Client
have restarted, reformatted and intact in the Workbench. The Client should open with the previous versions
configuration.

If the installation location was (or needed to be) changed, or in the event the existing database is not complete, the
database backup needs to be imported using the Archives application.

To import an existing database backup:

N

6.

Open the Archives application from the Serendipity Client Application menu.

In Archives, select File menu > Open Archive.

Navigate to and select the saved backup archive .sdb file. Click Open. The archive will open in the Archives
window and display all database items from the previously backed-up configuration.

Once the archive has loaded, select Edit menu > Add to Database > Whole Archive. This will import the
entire database.

Alternatively, choose individual items to import from the list and select Edit > Add to Database > Selected
Nodes.

The database items will be imported and appear in the Workbench for use.

For further information on Archives and backing-up databases, see the “Archives” section of this manual.
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Mac OS X - Upgrading to Version 5.4

Archiving Current Installations
To Archive a Database:

1.
2.

Run the existing Blackmagic Server and Serendipity Client.
Go to the Serendipity Client Application menu > Archives
(This application is called Archiver in earlier versions).
Select File menu > Perform Full Backup.

Alternatively, select Edit menu > Add to Archive (all) and
add all database items to the archive file, or right-click in
the Archives window and select Add to Archive (all) >
Everything from the contextual menu.

Once all database items have appeared in the Archives
window, select File menu > Save Archive to save the .sdb
archive file to a chosen location.

Close the Archives application when finished.

Installing the Dongle Driver
The first step is to install the dongle driver.

To install:

ik e

Remove all SuperPro USB dongles.

On the DVD, navigate to the dongle/macosx folder.

Double click the Sentinel System Driver.pkg file to launch the installer.
Follow the onscreen instructions to complete the installation.

Restart the computer when finished.

Installing the Blackmagic Version 5.4 Upgrade

To upgrade:

1.
2.
3.

4,
5.
6.

Insert the Blackmagic installation DVD and navigate to the macosx folder.

Run the Serendipity Blackmagic.pkg file.

Select the drive and location to install the software. The installer will choose the current installation
location by default, which in most cases is /Applications/Serendipity.

Follow the onscreen instructions to complete the upgrade.

Plug the Blackmagic dongle into an available USB port.

Start the Blackmagic v5.4 Server and the Serendipity Client.

If the installation location was not changed, the existing database should appear once the Server and Client have
restarted, reformatted and intact in the Workbench. The Client should open with the previous versions configuration.

If the installation location was changed, or in the event the existing database is not complete, the database backup
needs to be imported using the Archives application.

To import an existing database backup:

1.
2.
3.

6.

Open the Archives application from the Serendipity Client Application menu.

In Archives, select File menu > Open Archive.

Navigate to and select the saved backup archive .sdb file. Click Open. The archive will open in the Archives
window and display all database items from the previously backed-up configuration.

Once the archive has loaded, select Edit menu > Add to Database > Whole Archive. This will import the
entire database.

Alternatively, choose individual items to import from the list and select Edit > Add to Database > Selected
Nodes.

The database items will be imported and appear in the Workbench for use.

For further information on Archives and backing-up databases, see the “Archives” section of this manual.

Serendipity Blackmagic User Manual - Version 5.4 13



Linux - Upgrading to Version 5.4

Archiving Current Installations
To Archive a Database:

1. Run the existing Blackmagic Server and Serendipity Client.
2. Go to the Serendipity Client Application menu > Archives
(This application is called Archiver in earlier versions).

3. Select File menu > Perform Full Backup.

4. Alternatively, select Edit menu > Add to Archive (all) and
add all database items to the archive file, or right-click in
the Archives window and select Add to Archive (all) >
Everything from the contextual menu.

5. Once all database items have appeared in the Archives
window, select File menu > Save Archive to save the .sdb
archive file to a chosen location.

6. Close the Archives application when finished.

Installing the Dongle Driver
The first step is to install the dongle driver.

1. Remove all SuperPro USB dongles.
2. Navigate to the dongle/linux folder on the installation DVD.
3. Double-click the sntl-sud-7.5.1-0.i386.rpm file to install the driver.

Installing the Blackmagic Version 5.4 Upgrade

To upgrade:
1. Navigate to the linux folder on the installation DVD.
2. Double-click the install.sh file and select “Run in Terminal”.
3. Aterminal window will pop-up and the installer will display the default installation directory.
4. Press Enter to install or type an alternative path then press Enter.

Note: If using an alternative install path, ensure the folder exists and that the current user has read/write/execute
permissions for the folder.

5. The terminal window will close when the installation is complete.
6. Plug the Blackmagic dongle into an available USB port.
7. Start the Blackmagic v5.4 Server and the Serendipity Client.

If the installation location was not changed, the existing database should appear once the Server and Client have
restarted, reformatted and intact in the Workbench. The Client should open with the previous versions configuration.

If the installation location was changed, or in the event the existing database is not complete, the database backup
needs to be imported using the Archives application.

To import an existing database backup:

1. Open the Archives application from the Serendipity Client Application menu.

2. In Archives, select File menu > Open Archive.

3. Navigate to and select the saved backup archive .sdb file. Click Open. The archive will open in the Archives
window and display all database items from the previously backed-up configuration.

4. Once the archive has loaded, select Edit menu > Add to Database > Whole Archive. This will import the
entire database.

5. Alternatively, choose individual items to import from the list and select Edit > Add to Database > Selected
Nodes.

6. The database items will be imported and appear in the Workbench for use.

For further information on Archives and backing-up databases, see the “Archives” section of this manual.
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Saving/Restoring the Blackmagic Database and ICC Profiles using the File System
An alternate method for backing up the existing database and ICC profiles is to copy the relevant file folders from
Blackmagic to another location before upgrading to version 5.4.

The database items are held in a folder called defaultss.dbd in the following locations:

Mac 0S X /Applications/Serendipity Blackmagic/lib/defaultss.dbd/

Windows C:\Program Files\Serendipity Blackmagic\lib\defaultss.dbd\ (For versions 3.5.09 and below)
C:\Serendipity\Serendipity Blackmagic\lib\defaultss.dbd\ (For versions 4.0 and above)

Linux/Sun/SGI ~bmagic\lib\defaultss.dbd\

The ICC Profiles are stored a folder called ICC in the following locations:

Mac 0S X /Applications/Serendipity Blackmagic/lib/ICC/

Windows C:\Program Files\Serendipity Blackmagic\lib\icc\ (For versions 3.5.09 and below)
C:\Serendipity\Serendipity Blackmagic\lib\icc\ (For versions 4.0 and above)

Linux/Sun/SGI ~bmagic\lib\ICC\

To restore the database and ICC profiles to an upgraded Blackmagic
1. First, ensure the Blackmagic Server and Serendipity Client are shutdown.
2. Copy and replace the backed-up defaultss.dbd and ICC folders into the relevant locations (see above) for
your install.
3. Start the Server and Client. All previous database items should now appear in the Workbench.

Important Note: Pagesetups imported from Version 3 archives will be automatically split into Media and Pagesetup
data types, but remain functionally linked. Version 5.4 archives cannot be opened or imported into previous versions of
Blackmagic.
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Running the Software

Once the software has been installed, launch the Server and Client to begin the configuration. The Server should be
started first and allowed to complete its initialisation process before the Client is launched. If the Client is started first,
it will attempt to connect to an active Server. If none are present, a Connect to Server window will open, waiting for an
active Server to appear on the network.

Important Note for Mac OS X Users

The Blackmagic Server and Serendipity Client (for Mac OS X) are able to run in either 32-bit or 64-bit modes. Running
both in 64-bit mode is optimal for normal usage however, not all Spectrophotometer and printer manufacturers have
converted their drivers to support 64-bit and will be unavailable for use in 64-bit mode.

New installations of the Server and Client are always in 32-bit mode by default.

Before starting the Server and Client
To switch the Server and Client from 32-bit to 64-bit mode:

1. Open a Finder window.

2. Navigate to the Applications/Serendipity/Serendipity Blackmagic folder.

3. Highlight the Serendipity Client application and select CMD+I or right-click and select Get Info from the
menu.

4. Untick the checkbox to disable Open in 32-bit mode.

5. Repeat the above steps for the Serendipity Blackmagic and the C5 application if necessary.

If the Open in 32-bit mode checkbox does not appear in the Get Info window it will be

Version: 5.3
necessary to reset the Mac 0S X Finder: Conyrgh: Copyigh Serndity Sofvae . s,
Label: x w o
1. Open a Terminal window.  Open in 32-bit mode
2. Type or copy the following command into the screen and press Enter (with s

no line breaks):

/System/Library/Frameworks/CoreServices.framework/Versions/A/Frameworks/LaunchServices.framework/Versio
ns/A/Support/Isregister -domain local -domain user -domain system -kill -r

3. The above command will make the Open in 32-bit mode option appear in the Get Info window.
4. Go to the Finder window, right-click, Get Info and disable this option for the Client, Blackmagic and C5
applications.

Starting the Server

1. Plug the dongle into an available USB port.
2. Launch the Server by double-clicking the Serendipity Blackmagic file in the a
installation directory, or the shortcut desktop/dock icon.

The Server window will appear, showing information about the Server software and the Serendipity Blackmagic
initialisation process will begin.

Note: The Server will not initialise if a recognised dongle is not present on the computer from which it is run. If the
dongle is removed at any point while the Server is running, all job processing will cease and the Server will stop shortly
afterwards. Once the dongle is reconnected, close and restart the Server.
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Starting the Client
Once the Server has completed initialisation the Client can be opened.

1. Launch the Client by double-clicking the Serendipity Client file in the installation "' .»
directory or the shortcut desktop/dock icon.

Serendipity Client

The Client will connect to the active Server and display the default monitoring system - Jobs - on screen. From this
point, configuration of the system or loading a pre-configured setup can be done.

Select Server menu > Server Settings (Preferences)

Select the Colour Management tab.

Click on Change System Specials and select Reference-Lab (or your own specials) and click OK.
Click OK to dismiss the System Settings window and apply any changes.

Vi N

Manual Client Configuration

This section will explain how to setup a basic configuration in order to print a file to a printer and monitor the job
throughout the process. For detailed information on specific modules mentioned, see the relevant sections of the user
manual.

The default monitoring application - Jobs - opens with a factory standard layout, including the QueueManager,
Thumbnail and QueueStatus modules. System queues (Image, Render, Asset, Spool and AutoDetect) will be displayed in
the QueueManager. Specific queues will need to be configured for the abovementioned process.

There are four (4) sections within the Client that require configuration in order to begin processing jobs from the RIP to
the printer. These are (in no particular order):

* ARIP where the jobs are polled;
* APagesetup and Media where jobs are processed; and
* An Output where the print job will be sent.

Note: Before a Pagesetup can be created, first create a Media and an Output, as each Pagesetup must be linked to a valid
one of each type.

To begin configuration:
1. Select Application menu > Workbench.

Output Configuration

2. Select Output from the Data Types list on the left and create a —
new Output by selecting File menu > New. o

3. The Output name “Untitled” will appear in the items list, po—
highlighted for renaming. This is the name of the Output that will
appear in the Pagesetup. Select the item.

4. In the Queue panel of the gray configuration area, select the ey Tl
appropriate driver for your printer from the dropdown list of - G|
licensed drivers. -

5. In the Destination panel, select a destination driver (i.e. the ——
connection method) for your printer and enter the appropriate B
information, for example, the IP address of the printer. If USB or ==
Bonjour/Zeroconf is selected, click the Edit button to select the o
correct device/service from the Custom Settings popup window. =

6. Configure any Collating or Nesting requirements as needed. See —
the Workbench > Output section of this manual for further details on this option.

7. OPTIONAL - After a Media is created, it can be assigned to the Output via the Change Media button.
Assigning a Media to the Output will only allow jobs submitted to that Media to print. See the Media section
of this manual for further information.

8. Save the Output configuration when completed by selecting File menu > Save.
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Media Configuration
Select Media from the Data Types list on the left and create a new Media by selecting File menu > New.
The name “Untitled” will appear in the item list, highlighted for renaming. This is the name of the Media

1.
2.

7.

that will appear in the Output and Pagesetup. Rename and select
the item.

In the Output panel of the gray configuration area, select the
appropriate driver for your printer from the dropdown list of
licensed drivers. This should be the same driver as was used for
the Output configuration.

Configure the print resolution to be used (if available) and the
print colourspace, e.g., CMYK, from the dropdown menus.

Select any custom settings for your printer. Click the Edit button to
select any options from the popup settings window. These options
may include paper type, print mode, cutting options, light ink
usage. Click Accept to close the window.

Set your Output ICC profile via the Choose ICC Profile button. In
most cases, for a new install this will be the Standard SWOP
(CMYK) profile. Optionally, load your own profile by choosing the

Upload File button and navigate to your profile. Click OK to assign the profile.
Save the Media configuration when complete by selecting File menu > Save.

Note: This Media configuration is the minimal setup required to get your proof/print workflow functioning. For
proofing work, the Media will need to be correctly calibrated. For a complete HowTo guide for configuring a calibrated
Pagesetup/Media/Output, refer to the Support section of the Serendipity Software website.

Pagesetup Configuration
Select Pagesetup from the Data Types list and create a new Pagesetup by selecting File menu > New.
The name “Untitled” will appear in the item list highlighted for renamlng

1.

2.
3.
4

Rename and press Enter. Select the item.

Assign the Output created previously to the Pagesetup via the
Change Output button in the Output panel. A popup window will
appear to select the Output. Click OK when done.

Assign the Media created earlier to the Pagesetup via the Change
Media button. Select the Media in the popup window that appears
and click OK. Jobs will be printed using this Media unless another is
selected when submitting a job to print.

Apply any Colour Correction curves if required by selecting the
appropriate curve button in the Colour Correction panel. See the
Workbench > Pagesetup section of this manual for further details.
Select the input ICC profiles for RGB and Press

{
ey

(CMYK/Multicolour) respectively by clicking the RGB ICC Profile and Choose ICC Profile buttons in the ICC

Profiles panel.

Use the dropdown menus below each ICC profile to select the Rendering Intent to be used for each

assigned ICC profile.

Note: Blackmagic’s colour management system will match the proofer output to these assigned profiles once the Media
has been correctly calibrated, press (correction) curves have been assigned and the Always Use ICC option in the ICC
Profiles panel has been ticked. At this stage however, the assigned ICC profiles serve to inform the colour management
system which colourspace to use when processing jobs.

9.

Configure any other sheet, effects, margins, etc as required in the other panels of the Pagesetup. See the
Workbench > Pagesetup section of this manual for further details on the options available.
10. Save the Pagesetup configuration when complete by selecting File menu > Save.
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RIP Configuration

If your Blackmagic install requires proofing a RIP output, a RIP setup will need to be c

processing.

1.

6.

Select RIP from the Data Types list in the Workbench and create a
new RIP by selecting File menu > New.

A warning message will appear. Dismiss the message.

The RIP name “Untitled” will appear in the item list, highlighted for
renaming. Rename and select the item.

In the Driver panel of the gray configuration area, select the
appropriate RIP driver for the CTP RIP input from the dropdown list
of licensed drivers.

Configure the RIP driver options by enabling checkbox options and/or
choosing Custom Settings by clicking the Edit button.

Tick the Enable Polling checkbox in the Polling panel. Set a poll interval time, for example, 2 minutes.

onfigured to poll the RIP jobs for

Note: Some RIP drivers and polling methods require the use of a Job Genie in order for the Blackmagic RIP setup to
recognise incoming RIPped files. See the Workbench > Job Genie section of this manual for further details. Also, refer to

the Support section of the Serendipity Software website for tutorials on creating your own customised Job Genies.

7.

8.

Choose the method the RIP setup will use to connect to the RIP output folder from the dropdown menu in
the Polling panel, for example, Localhost. Enter any Hostname/IP details if required.
Enter the file path to the RIP folder in the Paths panel. To enter a path, click the New button below the
panel. Click Browse on the popup window and navigate to the RIP folder to be polled. Click OK to save the

path.
If required, setup Stripe Paths.

. Click the Test button at the bottom of the Testing panel to Save and Test the RIP setup. The Testing panel

will show a Polling OK result to confirm the RIP path is valid. Alternate messages will notify you if the RIP
path is invalid or if no RIPped files currently exist in the selected folder.

This completes the basic configuration of Blackmagic. For information on how to see polled RIP jobs and submit them
for proofing, see the Modules > RIP Monitor and Serendipity Client Menu Items > Submit Menu sections of this manual.

Monitoring Jobs - Configuration
Once the base configuration is complete for the Media, Output, Pagesetup and RIP, a monitoring application needs to be
configured so jobs can be managed throughout the system.

There are two (2) types available - the Jobs (default) or the Monitor application.

Jobs

This is the default application, launched when the Client is started for the first

time.

The Jobs application has a pre-configured set of tabs available for monitoring
various processes throughout the entire workflow. The default tab layout
includes the QueueManager, Thumbnail and QueueStatus modules. See the
“Jobs” application section within this manual for further information.

Any Outputs created in the earlier configuration will automatically appear in the
QueueManager module.

B, S

L gl
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The RIP Monitor will need to be added as a tab in order to poll jobs:

Vi W=

6.

In the Jobs application, select the Tabs menu > Add Tabs option.

A window will appear with various factory default layouts available for use in the Jobs application.

Select the RIP Monitor tab layout from the list. An example screen will appear to the right.

Click Add. The RIP Monitor tab will appear in the Jobs window.

Available RIP queues can be polled by selecting them from the dropdown list and clicking the Poll button
three (3) times consecutively.

Jobs appearing may now be submitted for processing.

Additional pre-configured Tabs may be added to the Jobs application as required. See the “Jobs” application section of
this manual for further information.

Monitor

The Monitor performs the same workflow monitoring functions as the Jobs application and was the default application
for this purpose in previous versions of Blackmagic, before the Jobs application was introduced. Monitor allows the
user to customise the size and layout of tabs and job management modules.

1.

If you would prefer to have any new output queues automatically added to
the QueueManager for future use, enable the Auto Queue Order checkbox
via the Toolbar (spanner icon).

GYaYe) Moritor - NFR 9100

Select Application menu > Monitor to open a Monitor window. =

The default view will include a Queues tab and a Logs tab.

a. The Queues tab contains the QueueManager,
Thumbnail and QueueStatus modules.

b. The Logs tab contains the ClientLog and ServerLog |.. . e v won N

modules.

A RIPMonitor tab will need to be added to the Monitor in order to poll jobs:

6.

7.

Select Tab menu > New Tab to create a new tab for the RIP Monitor. :
Rename the tab to RIP Queues or similar to differentiate it from the |-~ =
other tabs.

Select Layout > Add RIPMonitor. A module window will appear for the
RIPMonitor.

The window may be resized and positioned by selecting Layout > Edit.
Select the window corner and resize it by dragging the mouse. Select
Layout > Use when done.

Click the spanner icon to expand the Toolbar.

If no jobs appear in the RIP Queue, click the Poll button three (3) times
consecutively.

Jobs appearing may now be submitted for processing.

Additional Tabs and Modules may be added to the Monitor as required. See the Monitor section of this manual for
further information.
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The Serendipity Blackmagic Server

The Blackmagic Server runs on the machine where the dongle is installed. The Server handles the processing of all jobs
through the system and must be started before the Client is launched.

As the Server starts, it checks to ensure a valid dongle is installed on the machine and which modules are enabled
(licensed). The Server calculates the speed of the machine it is running on and checks the integrity of the database
before loading it.

Once the Server is up and running, a clock keeps track of the
duration the Server is operational.

rorver Optlons Serengipity Blackmagic

The window displays the Server information and various options
once it is running.

Serendipity Blackmagic Menu Options Dongle serial no: 4d7461a0 Ocee
About - Shows information about the Server. Clicking

AN O Serendipity Blackmagic

Serendipity Blackmagic version 5.3 (Build 25351) 32 bit
Copyright Serendipity Software Pty Ltd 1994 - 2011 All rights
reserved
Built: Oct 20 2011 13:28:19
Demo (time limited) dongle detected 34 days left

K R K . Listening for client connections on port 9100
More/Less info shows or hides valid dongle options,

including the versions of the current drivers.

. . . . Uptime: 00:00:01 ( Stop server ) Speed: 670.79
Quit - Quit the Server application.

~—————

File Menu

Stop Server - Stops the Server from running without quitting Serendipity Blackmagic.

Start Server - Starts the Server if it is in a stopped state.

Restart Server - Restarts the Server.

Update Dongle - Allows users/administrators to update the dongle with activation codes to enable various
input and output licenses. See the Dongle Updater section for further information.

Close - Closes the window. If the Server is running you are warned and asked to confirm Server shutdown.

Startup Options

Start Server on Launch - The Server will start once the application is launched.

Restart Server On Crash - Restarts the Server automatically after a crash.

Start as Cluster Node - Starts the Server as a Cluster Node to be used by another Blackmagic Server for imaging
and rendering tasks.

Important: Do not use this option before reading further information in the Applications > Clustering section
of this manual.

Start in Safe Mode - This option starts the Server but ceases all job processing and RIP polling tasks. Safe Mode
is used for maintenance in the event a RIP queue, Pagesetup or other database item is corrupted, or is
functioning incorrectly. Once maintenance is complete, the Server will need to be restarted in normal mode.

Help Menu

Update Options - Configure a time for Blackmagic to periodically check for software updates.

Check for Updates - Choose this to immediately check for any software updates.

Install Local Updates - Allows users to manually update the Serendipity software package by downloading
(.pax) package files. See the Installing Manual Updates section following for further information.

For further information on the automatic software update functions, see the Serendipity Updater section of this

manual.
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The Serendipity Updater

The Serendipity Updater provides a simple and convenient way of updating Serendipity Blackmagic and standalone
Serendipity Clients.

a.NO Software Update
The Updater tracks your current software installation status and
. . . There are software updates available for Serendipity
automatically checks for available software updates, bug fixes, A Blackmagic version 5.2.
maintenance patches and new drivers. ‘A) Configured to update product installed in
= /Applications /Serendipity/bmagic

Select the items you want, then click install.

New updates are listed along with release notes, previously installed
updates are logged in the Updater, and notes can be viewed at any time. SRR = <) = Updates

Install Name A | Version Date Posted Size

. N N Calcheck update 1.0 25/01/11 8.15MB
Note: The Serendipity Updater requires access to the internet to

function. Updates are not downloaded or installed until initiated by the
user, as the Server and/or Client are shutdown as part of the update
process.

The following update functions are available in the Help menu of the Fixes a problem that can occur with CMYK calcheck charts caused by CMYK

chart patch values not being converted and saved with corresponding Lab

Blackmagic Server application and/or the Help menu of the standalone | i i et v e e e e e a0 o

Calcheck chart due to L*a*b reference values registering as 0,0,0 in the

Sel‘endlplty Cllent' Calcheck application.
IMPORTANT INSTALLATION NOTE
e Update Options - Configure a time for Blackmagic to periodically | 7o2p! e fixto existing CMYK Caicheck Charts:-
- select the chart(s) in the Workbench 3
Check for SOftWare updates = click the Press ICC Profile button and choose a ICC orofile different to
o Never - The software will not check for updates. (NotNow ) (Cinstall)

o When (Time/Day) - Configure a time and day to
automatically check for any software updates.
= Notify when updates are available - A message will appear onscreen when updates are
available to install.
*  Check for Updates - Choose this to immediately check for any software updates.

When configuring a time/day for checking for updates via the standalone Client Help menu, a restart of the Server is
required for any changes to take effect.

Note: The Serendipity Client installed on the Blackmagic Server machine is updated as part of Server updates and does
not gain access to the “Check for Updates” Help menu option. If Secure Mode is active, users can be configured to
receive an email when software updates are available. See the Accounts Admin section of this manual for further
information on email configuration.

AN Software Update f.NO Software Update
Check for Updates Check for Updates
When: [ Every 1 7 Day ) When: [ Never 1o
at 1200aM [ at 12:00 AM
# Notify when updates are available # Notify when updates are available
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The Blackmagic Dongle Updater

The Blackmagic dongle licenses the level (version) of software and enables the use of any input filters (RIPs) and
output drivers that have been purchased. If any additional licenses are activated, the relevant dongle will require
updating in order to access them.

The Dongle Updater is a built-in feature, accessed via the Server File menu >
Update Dongle option. Key Code 1

To avoid any abuse of the software, the dongle activation codes can only be
used once and may only be entered against the assigned dongle serial
number. Any updating should be completed by your relevant Server
administrator.

Dongle Updater

Key Code 2

Important Note: Before updating any dongles, please ensure your Server is
in Stop mode.

(" Close

Updating the Dongle
Before updating the dongle, an email must have been received with the new codes. This will either be sent from
Serendipity Software directly, or via a Dealer of the product.

Two (2) codes are required for entry in order to update the dongle, referred to as Key Code 1 and Key Code 2.

The codes are located in the “Dongle reprogram string” field in the email and are separated by a space.

The first, long string is Key Code 1. The second, shorter string is Key Code 2.

To update the dongle:

1.
2.

Plug the current USB dongle into the computer and run the Server application.

Select the Server File menu > Update Dongle. The Server will stop. If there are any Clients open, a Connect
to Server window and/or disconnection message may appear.

A window will open for the Dongle Updater.

Enter Key Codes 1 and 2 into the relevant fields. It is best practice to copy and paste the codes to avoid any
keying errors. DO NOT copy the space between the codes.

Once the codes have been entered correctly, the Update Dongle button will enable. Click it.

A confirmation message will appear after the dongle has been successfully updated and a Server restart is
required.

Quit the Server application and restart. The dongle is now updated and any new filters or drivers will
appear in the Client for use.

When Updating from Version 3 or Prior - Before Restarting the Server:

Go to the installation directory for Blackmagic on the computer.

(for example: Applications/Serendipity/Serendipity Blackmagic)

Open the lib folder.

Open the printers folder.

Sort the files by date.

Delete all old files ending in *v.so

Once the files have been deleted the Blackmagic Server can be restarted.

1.

ok W

Failure to remove the old files from the printers folder will noticeably slow down the Server when it is restarting.
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The Serendipity Client

The Serendipity Client is a graphic user interface (GUI) used for configuration, maintenance and monitoring of the
Blackmagic Server.

The Client can be installed and run locally on the same machine, or from any supported computer on the network using
TCP/IP protocol. There is no limit to the number of Clients that can be connected to the Server, and each Client will
have its own settings, specific to the user.

Once installed, the Client connects to a Blackmagic Server and loads the settings from the Server into the Client
interface. Any Client can access the job management information and view the current status. The configuration can be
open to all users or protected via Secure Mode, which allocates specific access for created users and user groups. For
more information on how to setup access, see the Secure Mode section of the manual.

Look and Feel

There is a common theme and functionality to the Client. There are many ways to complete the same task, such as
configuring a Pagesetup from the QueueManager. Various options are available using the right mouse click to bring up
other contextual menus. This will vary depending upon the section of the Client interface being used.

Anywhere there is a chooser to select an item from the database, a search field will be indicated by a magnifying glass.
Entering text in the search fields filters the list, showing only the matching items. 2 2
The search can be inverted with CMD+SHIFT+I (Mac) or CTRL+SHIFT+I (Win) to 7 -
hide the matching items. The search box will turn black to indicate inverse X
searching. Pressing ESC will dismiss the search.

Search

There are two (2) main sections to the Client - The Workbench and the Jobs application.

* The Workbench is used to configure the various parts of the Server. This is used to create queues, setup input
paths and various calibration functions.
* Jobs (an application) is used for managing and viewing jobs as they pass through the system.

The Applications and Modules add functionality and provide tools for managing the Server and the jobs passing
through it. There are also various menu options containing system utilities and preferences.

Workbench

The Workbench is where the main software configuration takes place. RIPs, Medias, Pagesetups, Output paths, Colour
Sets and Colour Correction Curves can all be setup here.

When items are created or changed in the Workbench they are saved to a database read by the Server each time at
startup. The database can be backed-up and copied to other
(Version 5.4) Blackmagic Servers.

The Workbench is a split window. The Data Types list the database
item categories that can be selected for creation or editing. The
items list show the available database items within each Data Type.
The gray area shows the settings and options for each item.

The Data Types section has two (2) views - Browse & Search.

rrerent

Browse allows the user to view and select any of the database items - i
for display. The tab containing the magnifying glass flips to a Search
window, which acts like a filter, showing any items containing the search text.

000 Workbench - adn|
! Browse O Iltems A | Type Modified
* serendipity specials Special Colour Set  5/03/09 11:29 AM
Find items containing serendipity tiff output RIP 5/03/09 11:29 AM
— % serendipity tiff separated Job Genie 23/10/08 5:04 PM
seren
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Menu Options

Application

Submit

File

Edit

Access all available Applications via this menu. Each application will open in its own separate window.

System Settings (Windows OS) - Access the System Settings (Preferences) for the Serendipity Client. This
option is available under the Serendipity Client menu for Mac OS X users.

Quit (Windows 0S) - Quits the Serendipity Client application. This option is available under the Serendipity
Client menu for Mac OS X users.

Files — Select files to send to a Media and Pagesetup for processing.

Files for Deimposition - Submit files directly for de-imposition, assigning the files to one or more imposition
signatures.

Files As Imposition - Submit files directly as an imposition, assigning the files to one or more imposition
signatures. This option is only available for Veripress/Blackmagic Softproofing Add-On and allows jobs to be
de-imposed on the fly (see Touch Console for details).

Files As Asset - Select files to send to the Studio Application Asset queue. Assets will appear in the
QueueManager queue as thumbnails but are not processed until submitted for printing from the Studio
application.

ICC Target - Submit an ICC Target to a selected Media and Pagesetup.

ICC Target without Colour correction - Submit an ICC Target to a selected Media and Pagesetup. All ICC options
and colour correction curves are disabled.

Test Prints - Select one or more Media and Pagesetups to send internal test prints for processing.

New - Create a new item in the database.

Save - Save changes to the database.

Duplicate - Make a copy of the currently selected item.

Revert - Reload the last saved version of the currently selected item.

Delete - Delete the currently selected item.

Print - Print the details of the currently selected item.

Get Info - Displays a popup window with two panels - General & Ownership. General displays the type, created
and modified dates for the selected item. Ownership displays the User and User Group permissions for the
item.

Show Orphans - Shows any item currently in the database not being used by a Pagesetup or RIP.

Add to Archive - Add the selected items into a new Archive window. See the Archives section for further
information.

Export as C5 Pack - Allows users to export Media files from the Workbench to a specified location for use with
the C5 application.

Export / Import Folders - Allows users to export or import the folder structure used within the Workbench. It
will not import or export the contents.

Undo - Undo the last change. There are multiple undo options and this is configured via the Client Settings
section.

Redo - Redo the last undone change. There are multiple redo options, depending on the undo status and
configuration in the Client Settings.

Find - Opens a text box at the bottom of the Workbench panel to locate the search text on the screen.

Split Vertical/Horizontal — Changes the view to either Vertical or Horizontal split on the screen.

Show Type Column - Used in conjunction with Show Usage to display the type of data listed.

Show Modified Time Column - Displays the last modified time for the items listed.

Show Usage - Displays the items within the database the currently selected item uses, e.g., a selected Pagesetup
would show the Media and Output it currently uses.

Reverse Usage - Reverses the usage shown above. (was called Show Referrers in previous versions).

Organise Data Types — When enabled, this option will organise the Data Types in the Workbench list into
related categories. This is the default view.

Modules

Access all available Modules via this menu. A floating window will appear for each separate module opened.
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Server

Server Settings - Access the System Settings or Preferences for the Blackmagic Server.

Connect to Server - Select a Blackmagic Server to connect to on the available network.

Resume/Pause Processing - Allows users to pause or resume all job processing and print queues. Queues
pause after completion of the current task.

Accounts Admin - Allows an authorised administrator to create, modify and manage user accounts and groups.
Chatterbox - Chat to other users connected to the same Server with this option. The Chatterbox window will
display the Clients connected to the Server. A nickname may be entered in the Client Settings, otherwise the
machine name is used. If the users name cannot be selected, the user has selected the Away option and is not
available.

Broadcast Message - This allows messages to be sent to all users connected with a Client to the same Server.
Selecting the Broadcast option displays a message window to type into and send. The message is displayed on
the users window for a short time and will automatically dismiss if it is not acknowledged by clicking OK.
Download PPD - Download the Megarip PPD from the Server to the desired location. This saves having to get
the PPD from the disk. Use the PPD when installing a local printer. When installed, the Megarip PPD (Postscript
Printer Description) is selected as the printer driver when setting up a Blackmagic Published Pagesetup as a
print destination for third party applications.

Window

Help

Bring All to Front - Shows any open window of the Client and can be selected to bring it to the front.
Cycle Through Windows (CMD+" or CTRL+") - Cycles through the open windows within the Client.

Server Info - Provides information about the Server, including version, platform, speed, processors, hostname,
IP, product and vendor.
What's This - Select this and click on any part of the interface to display a short help description.

Contextual Menu (Right Click)
In addition to selected File menu options listed above, the following options are available via the contextual (right-
click) menu:

New Folder - Folders are a great way to organise the data types list items. Folders are Client based, meaning
each user can have their own folders if desired.

New Folder with Selection - Places any selected items into a new folder.

Remove Folder - Removes the selected folder, placing items within the folder back in to the general item list.
Open/Close Selected Folders — Expand or collapse the selected folders to show or hide the items within.

Note: Folders in the items list are internal to the Serendipity Client, used to organise database items. They are not
operating system file folders.
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Workbench Data Types

There are eighteen (18) data types (databases) within the Workbench that can be used and configured to accurately
process jobs. Each will be explained in detail. The data types are:

Bookfilter — Allows for the polling and mapping of planning files for softproofing large multi-section or multi-
edition jobs. This is a standard feature for Veripress and available as a Softproofing Add-on for Blackmagic.
Calcheck Chart - Used to provide a validation check for a hardcopy proof or a monitor.

Camera - Setup a camera ICC profile for use with the SoftProof application when viewing RGB images.

DotGain Curve - Used to compensate for or represent dot gain on the final output.

Gradation Curve - Used to adjust colour in a job by applying a curve to the individual process colours.

[CC Tweak Set — Build up a library of colours that need “tweaking” for accurate output.

Job Genie - A programmable file search filter used by some RIP input filters for polling and stitching together
jobs and publications.

Media - Used to control configuration settings for Output, Colour Correction, ICC profiles, Screen Printing &
Output Screening.

Output - Determines where processed jobs are to be output, as files, to a printer, or a remote location.
Pagesetup - Controls the input screening, resampling, ICC matching, rendering intents, rendering effects, fitting
or scaling to be applied to incoming jobs.

Pagesetup Pool - Print to one or more Pagesetups.

Paper Profile - Used to define the paper and ink characteristics of the Media being used by the output
driver/device.

Press - Contains the colour and dotgain attributes of a press. Used by the SoftProof application to show the
effects of printing a job on a particular press.

Regular Expression - Used in conjunction with the RIPs for autoproofing jobs based on matching particular
rule sets.

Replace Colour Set - Used to match and replace certain colours as they pass through the system.

RIP - Configure a polling path and auto proof settings for RIP data proofing.

Signature Group - Create or import signatures for de-imposition.

Special Colour Set - Used to identify and match colours when jobs are polled and processed.

Data Types - User Interface and Context Menu

The Bookfilter, Media, Output, Pagesetup, Pagesetup Pools, Press, RIP and Signature Data Types have multiple
configuration panels or sections governing the different functions they control. These data types have a row of buttons
or tiles across the top of their configuration panels allowing the user to instantly jump to the section named. If any of
the panels are not required, they can be hidden by using the “X” in the top right corner of each. To show any hidden
panels, click on the panel name in the row and it will appear. Shift+click will hide them again.

Publish Colour Correction ICC Profiles ColourKeys Input Screening

A contextual (right-click) menu is accessible in any of these individual sections, allowing the user to access the Find
function, Jump to another section, or change the background colour of the panel for easy identification.
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Bookfilter
The Bookfilter (Available for Veripress/Blackmagic Softproofing Add-On) is used to setup an appropriate

driver to read planning files in order to put finished publications together, greatly improving the speed, efficiency and
automation of softproofing in publishing press environments.

Bookfilter works similarly to a Job Genie based RIP queue in Blackmagic, but rather than polling for RIP jobs, it polls for

publication planning files. Publications in the planning files are then displayed

in the

displayed in the BookMonitor can be expanded to show a list of pages and
filenames associated with each page as defined by the planning file. The
Bookfilter maps the page filenames to processed jobs in the QueueManager.
When the publication is selected for softproofing, the Bookfilter searches the
QueueManager for matching jobnames and collects them into a single s
publication. Any missing pages will appear as red in the page navigator. e

Driver

Polling

Paths

BookMonitor and may be selected for softproofing. Publications

Book Driver - Select the appropriate driver for the planning file format
used.

Testing

Enable polling - Enable or disable the polling of planning files.
Language Encoding - Set the encoding to match your system to display
filenames correctly.
Poll Interval - Configure how frequently to poll for planning files. The
Poll Interval should be set according to your specific requirements. Setting the Poll Interval too short can flood
the network with polling requests (packets) causing it to slow down. Setting it too long can take a long time to
show stable files ready for submission.
Fast Polling - This will automatically poll two (2) more times as soon as one (1) automatic poll has completed.
It will not wait for the next scheduled Poll Interval before it polls again.
Log Statistics - Log the polling statistics in the Server log. The log message reports “Started automatic poll on
<date>" when polling starts and “Completed automatic poll on <date>" when finished.
Show Books Newer Than - When activated, this option sets the Bookfilter to display only polled publication
planning files with time signatures newer than the specified (days/hours/min) time in the BookMonitor.
Note: Older planning files are hidden from view, not deleted.
Job Genie - Select a Job Genie to apply if required. A Job Genie may be used optionally to remap the Publication
and/or Jobnames in the polled planning file.
Connection - Specify the method used for polling. The options are:
o Agent - The Serendipity Agent is installed on the RIP where the files are located. This is used for
polling and submission of the files into Blackmagic.
o Hostname/IP - Enter the hostname or IP address of the computer where the files are located and
where the Agent is running.
o Localhost - This is used to poll a hard drive local to the Blackmagic install or mapped network drive on
the same machine.
o FTP - Uses File Transfer Protocol (FTP) to poll and transfer the files to Blackmagic
o Secure FTP (SFTP) - Uses Secure File Transfer Protocol to poll and transfer the files to Blackmagic.
File Transfer Priority — Specify the priority to be used for transferring files to Blackmagic. Adjust from Lowest
to Highest or anywhere in between.

Specify one or more paths to the location of the publication planning files. The options available are:

Testing

New - Adds a new path to the Paths field. Selecting this displays another window to type the path or browse to
locate the folder containing the jobs. Browse will only work if the connection method has been specified and is
valid.

Delete - Deletes the selected paths.

Delete All - Deletes all paths from the list.

Once the configuration is complete, test the parameters are correct. The configuration must be saved before a test can
be done. If it is not saved, a prompt will appear to “save and test”. A test poll checks the connection, path validity and
job presence. Messages appear in the window to alert you to any problems or give confirmation of a valid configuration.
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Calcheck Chart

The Calcheck Chart data type is where charts are configured and stored for use in colour validation checks.

The charts are comprised of user-created or imported colour patches, along with target standards and tolerances.
These items are saved to the database and can be used and/or adjusted at any time. The Calcheck Chart is then used in
conjunction with the Calcheck application to provide a

validation check for a hardcopy proof or a monitor. TS e

Once the chart is setup, it normally never needs to be
changed; the standards to be used are saved with the chart.
When reading the chart with the Calcheck application, simply
load it and measure. If you wanted to use a different standard,
this is done in the chart and not the Calcheck.

The chart can be attached to the job as it passes through the ~—
Pagesetup or printed from the Calcheck. o

The window shows a list of the patches on the right and
colour information on the left. For each patch selected its Lab
values, delta tolerance and patch type can be adjusted. The

overall target preferences are specified in the lower half of the left panel.

Toolbar Options

New Colour - Create a new colour in the list with default* values. Values and colour names can be adjusted as
desired.

Delete Colours - Deletes the selected colours from the list.

Duplicate Colours — Makes copies of the selected colours. Use shift or control keys for multi-selection.

Rename Colours - Pops up a renaming window, allowing for name changes on one or more colours
simultaneously.

Import Patches from Files* - Import a patch set from a colour data file, such as those of colour standards or ICC
profile makers.

Reorder Patches - Reorder the patches. Selecting this will display another window to select one or more
colours and drag them into a new order. Use the up and down arrow keys and shift or control to multi-select.
Generate Patches from ICC - Select an ICC profile from which to create a set of patches. Selecting this option
displays a file chooser to select an ICC profile. A prompt will appear for the number of patches to generate. The
minimum number is 16 and maximum is 512.

Add Colours From Library - Add colours to the currently selected Calcheck Chart from a Special Colour Set.

*Note: When creating or importing new colours, they are stored with the default tolerance settings. This is user
configurable and should be set before the patch set is created.

Patch Definition

On the left are a series of controls used to define each patch. Selecting a patch from the list
will load the colour into the colour match box at the top and load the Lab/CMYK values into
the respective fields. To change the value, simply type the new number into the relevant

field.

L 78.88

a -2.63

b 33.13

Lab (or CMYK) - The Lab (or CMYK) value for the selected colour. aeTolerance |50
. AH Tolerance 2.50
Ae tolerance - Set the maximum Ae value for the selected colour. IRy
AH tolerance - Set the maximum AH value for the selected colour. patch Type G o

AC tolerance - Set the maximum AC value for the selected colour.
Patch Type - Identify important patch types from the set. The options are:
o Paper - Select the patch that represents the paper being checked.
o Cyan/Magenta/Yellow/Black - Identify a patch for each colour from your set.
o Gray - Used to identify gray patches in the chart.
o Generic — Most patches are generic and are classified as generic if they don’t fall into one of the above

types.

Note: When generating patches from an ICC profile, the patches are automatically assigned the correct type.
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Target Standards 'Ae AH AC'
There are three (3) standards that can be used to compare against a proof.

These are Ae, AH and AC.

The first standard Ae is always enabled. The other two standards must be enabled for the results to appear on the
Calcheck. To enable, select the tab and tick the Target checkbox.

For each standard, specify the limits used for a pass and fail status. For Ae, also choose which of the Ae standards are to
be used - deltaE, CIE94 or CIE2000.

Important Note: The correct standard to be tested must be selected and saved with the chart. Only that standard will
be tested for a pass or fail. If you want to check another standard, change it here and save it again. For example, if you
are checking deltaE and you want CIE2000, you will need to change it, save and re-measure.

The limits are:

* Average - For all the patches in the chart that will be measured by Calcheck, the average must be below this
value for a pass.

* Maximum - This is the default value used when creating or importing patches. This value is only used for
assigning maximum tolerance for the import. When the target is measured, the tolerance set per patch is the
one used to determine a pass or fail status.

¢ Standard (Std) Deviation - The standard deviation across all the patches must not exceed this value.

The Calcheck will only report a pass for a proof or monitor if all patches in the target chart are within tolerance.

¢ Patches Per Strip - Specify how many patches are printed per line, allowing the use of existing target standards
such as the Fogra Media Wedge.

Spectrophotometer
Use one of the supported online instruments to measure colours directly into the Calcheck Chart.

To measure colours:

1. Select an instrument from the dropdown menu and click on Activate. The device must be connected and turned
on.

2. Follow the on-screen instructions, as some devices require calibration before measuring.

When complete, click the Turn Off button.

4. If the Lab text option is chosen, you will be prompted to choose a file to import. The format must be Lab values,
space or tab delimited and no header information.

w

Note: If importing characterisation data from one of the ICC profile packages or colour standards, use the Import
Patches From Files option.

Patches
This section of the Calcheck Chart window displays the patches in the

set. Each patch shows its respective colour, name and Lab values.
There is also a patch type and the tolerances for each standard. The
tolerances are assigned when the patches are created or imported and
are based on the settings on the left.

A tolerance setting can be altered by selecting the colour and entering
a new value in the relevant box.

_ — The Chart type can be altered via the dropdown menu above the patches and
Chart type | Lab v CC Pro a Press ICC Profile will appear if allocated. The Press ICC Profile button only
becomes available for CMYK chart types.

Search

Above the patches list is a search box. Enter a string to filter out any patches not required and locate those that are. All
fields within the panel are searched. The search can be inverted using CMD+SHIFT+I (Mac) or CTRL+SHIFT+I (Win).
The box will appear black when the inverted search is enabled.
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Camera

The Camera data type is used to define an RGB (or Camera) ICC profile colourspace for use when viewing RGB
images in the SoftProof application. Users can configure whether the default Camera profile or image embedded ICC
profile is automatically selected and applied to an RGB image when opened in SoftProof. See Applications > SoftProof >

SoftProof Settings for further details.

Colour Management P —
* (Camera ICC Profile - Select the ICC profile to assign. ’W::, e 3
* Rendering Intent - Select the rendering intent to be used. Wk Pkt Cormpriion
¢ Black Point Compensation - Enable/Disable Black Point e S
Compensation.

¢ Calcheck Chart - Assign a Calcheck Chart for Camera colour verification checks using the Displays application.

DotGain Curve

A DotGain Curve can be used to compensate for or represent dot gain on the final output. In this section,

curves can be created for application to a Pagesetup in order to change the output.
The curve may be applied for two (2) reasons:

e After the initial calibration you may find that the resultant output is either slightly
too dark or slightly too light. A DotGain Curve can be applied to the process or
specials (or both) to make the print lighter or darker; or

* Torepresenta press or printing process dot gain on the proof.

Toolbar Options
* Trace Saved Curve - A green line appears, showing where the curve was last saved
and where the curve has been edited.

* Invert Curve - Invert the selected curve. An inverted curve can be used to compensate for the colour
characterisation or platesetter dotgain curves output by a platesetter RIP, returning jobs to a linear state for

proofing.
* Dotgain Table - Enter values manually to adjust or create a curve.

¢ Import from CSV - Import values from a CSV file. The file must contain exactly 23 values for each colour as

defined in the Dotgain table editor.

Note: The Process and Special DotGain curves only apply to CMYK input jobs. RGB jobs will not be affected.

A Gradation Curve

A Gradation Curve is used to adjust colour in a job by applying a curve to the individual process colours. The

Gradation Curve can be applied to a Media either as a Linearisation Curve or

as a Correction Curve. A Linearisation Curve is normally applied as part of the
early calibration stage and this is recommended. A Correction Curve is applied
if a small amount of fine-tuning is required after normal calibration
procedures.

Toolbar Options
* Trace Saved Curve - A green line appears, showing where the curve
was last saved and where the curve has been edited.
* Invert Curve - Inverts the selected curve.
* (Gradation Table - Enter values manually to adjust or create a curve.
* Preview Curves - Displays a window with all curves in their

AND.. Cotusmesen

“a e e e A

respective colours so they can be assessed in relation to each other. This is updated dynamically as changes are

made.
* Lineariser - Loads a Linearisation Curve directly into the Lineariser application.
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A ICC Tweak Set

Build up a library of colours that need “tweaking” (adjusting) for accurate output with the ICC Tweak Set
data type. A tweak set alters colours during the ICC mapping stage from input to output profile and is selected on a per
Media basis.

The ICC profiles are not edited in any way and the tweak set can be selected as desired. Each colour requiring alteration
is selected and adjusted by adding to or subtracting process colours from it, or making it lighter or darker. An accurate
visual representation is shown on the screen and the point in the colourspace can also be viewed. Colours can be
created manually or by entering the CMYK or Lab values, or input automatically using an online Spectrophotometer.

The interface is split into two parts - the left side shows the input values and the right side shows where any
adjustments (tweaks) have been made.

Options

* Colourspace - Choose between Input Profile or Lab input. If the profile selected is RGB, the sliders will change
to RGB. If CMYK, the sliders will change accordingly.

* Influence - Choose the area around the specified colours to be affected. This is determined as a scale of 1 to 5,
with 1 being the least influence and 5 the greatest.

* Tweak Value - Use the CMY sliders to add or subtract from the colour being adjusted.

* Rendering Intent — Choose the rendering intent that the colour is to be altered in from either Perceptual,
Colourimetric or Saturation. This must match the rendering intent of the Pagesetup for the mapping to work.

* New Tweak - Create a new tweak in the rendering intent selected.

* Copy - Available via the right click menu. Used to copy the selected tweaks.

¢ Paste - Available via the right click menu once an item has been copied. Used to paste the copied tweak from
the clipboard to the rendering intent selected.

* (Change White Point - Change the white point of the paper. Select the button and enter the X,Y,Z points. If a
Spectrophotometer is connected, the white point can be measured directly into the system.

* Zoom - Zoom in and out of the Lab colourspace to see the point being tweaked in relation to the whole space.

¢ L-value - Move up and down the L-value to see the point being tweaked in relation to the lightness. Reset the
value by clicking the ReCentre button.

* ICC Profiles - Choose the input and output profiles being used to tweak. These must match the ones selected in
the Media, as they are stored with the tweak set and are used during the mapping process.

* Spectrophotometer - Choose an online Spectrophotometer to read values directly into the tweak set. Once
selected, press the Activate button to connect and take measurements. If the device is being used by another
application (including a Serendipity application), it will fail to connect. Quit or disconnect all others first.

Original Tweaked

Tweak Point Adjustments

Colourspace | Input Profile Al

Influence ©1-5 s

c B 100 [ Cyan LS Red 0

M & 0 8 Magenta “r Green 29

¥ B 100 [ Yellow

< Bue 0

Darker H Lighter -30 (5

1 Lab Siice View
{Perceptual = Colorimetric  Saturation

200m )
New Tweak

L-value > “ReCentre
Change White Point.

KC Prothes
# Choose input Profile... ) match/NewSample_Press_K2.icc

# Choose Output Profile printers/PX9500_0714.icc

Spectrophosos
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Job Genie

Plate separated, single-bit screen TIFFs have become predominant in print industry workflows. The TIFF

Based (Generic) input filter is designed to poll jobs from RIPs that produce 1-bit TIFF files; one file for each
process or spot colour plate of a particular job.

While the TIFF Based (Generic) input filter has a limited intelligence and can recognise standard filenames, such as
Jjobname_plate.tif, it will not understand or be able to correctly poll a filename like /371P1S1CCyan.tif.

The Job Genie utility allows for the configuration of a TIFF Based RIP input filter to poll and recognise any filename
convention, no matter how unique or complex, and stitch the 1-bit files into single jobs. Job Genie can also be used to
rename files to have more user-friendly onscreen names, or group files together into a single publication. The
configuration window is split into two (2) sections. The column on the left is used to enter a Task (see Tasks below).
The main panel displays the five (5) tabbed sections requiring consideration when setting up each Task. After it is
created, the Job Genie is selected in a RIP queue using an input filter such as TIFF Based RIP (User Configurable) to poll
the chosen directories for the defined filenames.

Tasks

A Job Genie is made up of one or more user-defined tasks. Each task specifies how the job filenames are collected; how
they are defined and grouped; how the job names will be displayed in the RIPMonitor; and if the jobs will be proofed as
a publication when submitted for processing.

Important Note: More than one task may be required to collect all the files in a given path if the naming varies. Jobs are
constructed in the order of the tasks. Once a Jobname is matched by a given task, it is removed from subsequent
searches, so the order of the tasks is very important. To change the order of a task, select it with the mouse and drag it
to the desired position in the list.

Interface Options
* Log - Enable or disable to display the matching process in the ServerLog for the task selected. This can be
useful to debug problems where configurations are not matching files properly. It is best to turn logging off for
aJob Genie that is functioning correctly to avoid the ServerLog becoming too large or cluttered.
¢ Add - Add another task to the list.
* Duplicate - Copy the selected task to a new one.
* Delete - Delete the currently selected task.

Tabs - (1) Collect Files
This tab specifies how the files are sorted and collected by the input filter. One or more search parameters can be
entered, with each one comprising of an Action type, a Match criteria and a search

String. ——

It is not necessary to enter anything in this first tab if all the files in the RIP input
filter path are valid for collection and proofing.

As with tasks, each collection action is performed in order. Once a file has been
excluded by a task, it is not looked at again so the order of the actions is very
important.

Action Options

¢ Ignore Files - Do not include any files matching the definition specified
when the input filter collects the ready for sorting.

* Ignore Directories - Do not look in directories matching the definition specified when collecting files ready for
sorting.

* Descend Directories - Only look in directories specified by the definition when collecting files ready for sorting.

* Include Files in Directories - Include all files in the definition specified directories when collecting files ready
for sorting.

* Include Files - Only collect files as specified by the definition.

Note: Of the above actions, Include Files in Directories has precedence over all other actions. If this is matched, files and
directories at the same level are ignored. Files and directories within the directory matched are then subjected to a
search, governed by any other specified action.
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Definition Options
* Ending With - Any file or directory as specified in the action with a name ending with <this text>.
* Beginning With - Any file or directory as specified in the action with a name beginning with <this text>.
* Containing Text - Any file or directory as specified in the action where a name contains <this text>.
* Named - Any file or directory as specified in the action explicitly named <this text>.
* Add - Add the action and definition specified to the list of files to collect.
¢ Apply - Apply any changes to the currently selected action and definition in the list.
* Delete - Delete the currently selected action and definition from the list.
* Filename Length - Specify a minimum and maximum filename length when searching for any files for sorting.

Note: The Add, Apply and Delete buttons are only available if there is a change to an existing entry. If actions are not
added or applied to the list before a save, the list is not updated.

Tabs - (2) Filename Break Down
Most job filenaming conventions contain common elements defining the job’s name, section, page or publication; and
specific file markers or unique elements identifying things such as plate colour.

This tab allows you to specify the construction of a filename. This is done by e —
breaking it down into parts and giving each part a user-defined name. Once all
parts of the filename are identified, they can be grouped together to make a
complete job.

Options

* Case Sensitive Matches - Used to match case when the criteria for
matching contains user specified input. For example, Part contains
specific words, Match to separator and the Truncate option. If any of
these are used and Case Sensitive Matches is selected, only those
characters matching the specific case entered are matched.

* Read Direction - The direction in which the filename is read. Click the
arrow to change read directions.

* Parts - This is a block diagram showing the breakdown of the job. Each part is given a name and identifies a
section of the filename. Clicking the Read Direction arrow changes the order of the parts to show which part is
going to be read first. If creating a new Job Genie, parts will not appear in the diagram until they are created.

* Add - Add parts to the list.

* Apply - Update the selected part with changes.

* Delete - Delete the selected part from the list.

* Part Name - Specify a name for the part you are about to describe. Meaningful names are useful when choosing
the groups later.

* Part Contains - Specify from the list what the part will contain. Choose from:

o Any Character - The part can contain any valid character.

o Numbers Only - The part may only contain numbers.

o Hexadecimals Only - The part must only contain hexadecimal characters (0-9, A-F).

o Specific Words - Specify a word or characters in the text box that the part must contain.

* Match - Choose what point in the filename you are going to match to. This may be a specific separator or end of
string, for example, read along the filename until this point, looking for valid part matching specified above.
Choose from:

o To Separator - Enter a character in the text box to specify as a separator, i.e., continue reading the part
until you reach this separator.
o To End of String - Match everything from this point to the end of the filename (string).
To Numeric Separator - Match everything from this point until you find a number.
To Non-Numeric Separator - Match everything from this point until you find anything that is not a
number.
To “.” (full stop) Separator - Match everything from this point until you find a full stop.
To “-“ (hyphen) Separator — Match everything from this point until you find a hyphen.
To “_” (underscore) Separator - Match everything from this point until you find an underscore.
To “$” (dollar) Separator - Match everything from this point until you find a dollar sign symbol.
To “” (space) Separator - Match everything from this point until you find a space.
Number of Characters — Match the number of characters specified in the text box. A further option is
available if this is selected:

= Truncate from Character - Choose a character to identify in the filename and remove all
characters from the point onwards. For example, if you have a large number of 0’s in a group,
you can choose to remove those 0’s from the group so they are not displayed.

o O

O O O O O O
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Note: The To Separator and Truncate from Character options allow multiple entries separated by commas, where each
entry searches for a match, i.e., you can specify “To Separator a, b, ¢’ where if any of the separators a, b or c are matched
it is valid.

Separator Options

Separators are the characters that determine the end and beginning of a part. For example, with cyan.tif the full stop
between cyan and tif is the separator. As this is part of the filename, you still need to decide what to do with this
separator. There are three (3) options:

* Discard Separator - Ignores the separator.
* Include Separator with this Part - Includes the separator with the part being described.
* Include Separator with the next Part - Includes the separator with the next part described.

Example: With a filename such as job.cyan.tif where we parse the name in the forward direction, we describe the first
part as name to separator full stop (.) and the next part as plate to full stop (.)

Discard Separator creates the two parts as job and cyan.

Include Separator with this part (for name) would produce a part as job.

Include Separator with next part (plate) produces a part as cyan. This is only used if the separator is a character you
want to display in the RIPMonitor, such as a page marker.

The most commonly used option is Discard Separator. In the above example, if the option Include Separator with Next
Part was used, we could not identify the colours, as it will be called .cyan

Tabs - (3) Jobname + Plate
This tab allows you to configure which parts should be grouped together to complete a job and which part identifies the
plates of the job. You can specify how the plates are described and control specific mapping.

Job Grouping
*  Only group files in the same directory as job - Check this box to group filenames together in a directory. Files in
different directories will not be grouped.

This is used when job directories are created containing all the plates. e
Sometimes the filenames vary for the name of the job, but because e
they are all placed in one directory per job, they can be grouped
together. s E e

* Group files with parts - This displays the parts created in Tab (2) -
Filename Break Down. Select the part or parts that make up the job
name by clicking the tiles onscreen.

In most cases, the file part defined as the plate should not be chosen,
as this would group files with the same plate together, rather than
combining the different plate files into one job.

Plate Identification
This tab is where you define which part created in Tab (2) - Filename Break Down is the plate part and how it is
written in the filename.

* Plate Part - Select the part of the filename that describes the plate colour from the dropdown list. The list
contains the part created in Tab (2).

Plates are:

* Defined by words - The plate names are complete names, for example, cyan, pantone 252.
* Defined by numbers - The plates are defined by numbers, for example, 0 is cyan, 1 is Magenta etc. If this is
selected, two other options are available:
o Starting Plate Number - Enter the number the plates start at. This is usually 0 or 1.
o Plate Order - Choose the plate order between KCMY+specials or CMYK+specials.
¢ Map Letters C, M, Y, K to Process Names - If the plates are named with just letters, for example, cyan is
represented as ¢, selected Defined by words and choose this option.
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¢ Strip leading zeros from colour names - Sometimes colour names have multiple zeros before the plate number.
This option can be used to remove these.

Plate Mapping

You can map plate names so they appear correctly in the RIPMonitor and are able to be matched to colours in the
System Specials colour set (see Server Settings - Colour Management). A list of plates requiring mapping can be
created.

¢ Case Sensitive Mapping - Select this if the mapping should check for case.

* Add - Add the mapping to the list.

* Apply - Apply changes to the currently selected mapping.

¢ Delete - Delete the currently selected mapping from the list.

* Prefix number literals with user text - Add a prefix to numbers you are polling. For example, if the colour is
called 254, you can prefix the word pantone in front of the number, making the special plate become pantone
254.

Tabs - (4) Publication + Pages

This tab is where parts can be identified from the Filename Break Down as a Publication and a Page. This can help with
autoproofing, as a job can be automatically filtered and gain all the attributes available to publications, such as grouping
in the QueueManager and the Pages pane in SoftProof.

* Page numbers are:

o Defined by words - Attempts to assign page numbers from
words/letters in the selected page number part.

o Defined by numbers - Assign page numbers from the selected
numerical page number part.

o Defined by sequence 14, 1B, 24, 2B - Use the standard press
imposition numbering system to assign page numbers from the
select page number part. E.g. 1A=1, 1B=2, 2A=3, 2B=4 and so on.

o Defined by sequence 14, 1B, 1C, 1D..2A, 2B - Use this multi-web
press imposition numbering system to assign both section and
page numbers from the selected page number part. The numerical
component is assigned as the section and the letter is assigned as
the page where A=1, B=2, C=3 and so on. Alternatively, this page sequence definition will recognise a
page number part comprised of a single letter, assigning pages A=1, B=2, C=3, D=4 and so on.

* Page number part - Select the part that identifies the Page number from Jobname, Colour, Extensions or None.

* (Case Sensitive Mapping - Select this if the mapping should check for case.

¢ Publication Part - Select the part that identifies the Publication part from the previously defined filename
parts.
When files are submitted for processing via the RIPMonitor, all jobs with a common Publication Part will be
submitted to the QueueManager as one publication and will be viewable (and softproofed) as such. None
means no Publication Part is being used.

o IN / OUT - Map Publication abbreviations to full names (if required). For example, smh IN becomes
Sydney Morning Herald OUT.

* Section Part - Select the filename part defined as the Section Part from the dropdown menu. The default is
None, meaning the Section Part is not being used.
Many publications, such as newspapers, are made up of a composite of separate sections. The pages of these
sections often use a filename convention where the page numbers represent the number within the section -
not the page number within the whole publication. The Section Part makes it possible to proof a publication
made up of multiple sections and to offset the pages of each section appropriately to allow viewing of the
complete publication in the correct page order.

o IN / OUT - Unlike the Publication Part where remapping is optional, if used, the Section Part requires
you to input the section names (although IN and OUT can be the same) and a Page Offset value for each
section.

Note: Using Publication and Section Parts with Bookfilter

In the case of a Job Genie being created for a Bookfilter poll, the Publication and Section Parts can be used to re-map
publication and section (or edition) filename parts into more coherent or user-friendly names for display in the
BookMonitor. The Page Offset function of the Section Part is not used - it is simply for renaming.
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Tabs - (5) Display

The Display tab allows you to configure how the Jobnames are displayed in the
RIPMonitor. Click the Parts tiles to add the filename parts to the Jobname, Publication
Name and (optional) Section Name strings. Parts can be entered in any order. e — .

Any other text to be shown in the RIPMonitor can be entered as part of the string.

For example, clicking a part named Page will show <Page> in the string. This will
display the page number only in the RIPMonitor. It may be useful to add “Page:” i
before the <Page> part so the RIPMonitor will display as “Page:1”.

Display Specification - Shows the parts created in Tab (2).

Jobname String - Shows the string that will be displayed in the Name column
of the RIPMonitor and QueueManager. You can enter any valid character or
use filename parts.

Job Directory - (Buttons) Allows you to enter the job directory into Jobname, Publication and/or Section String
fields.

Publication Name String - Shows the string that will be displayed in the Publication column of the RIPMonitor
and QueueManager (in Publication view). You can enter any valid character or use filename parts.

Section String - Shows the string that will be displayed in the Section column of the RIPMonitor. You can enter
any valid character or use filename parts.

Check the Serendipity Software KnowledgeBase for HowTo’s on creating a Job Genie:

http://skb.serendipity-software.com.au
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Media

The Media data type contains all of the settings controlling the output of jobs as they pass through the
Blackmagic colour management system (CMS) for proofing. Settings configured here are those directly
related to the Output device, Colour Correction, ICC Profiles, Screen Printing and Output Screening.

A Media can be one of several assigned to a Pagesetup, which controls the input screening, resampling, rendering
effects and intents of incoming jobs. All jobs are submitted to a combination of Pagesetup and Media destinations.
When submitting, the user selects the Pagesetup to be used, at which point a list of compatible (user-created) output
Media types in the database become available for selection. A default Media is assigned to a Pagesetup, so if a job is
submitted without a specific chosen Media, the job will output to the default Media settings. An Output data type can
optionally have a Media type assigned to it, in which case only jobs submitted to the Output using the assigned Media
will be printed. All other jobs are held in the QueueManager until the assigned Media is removed from the Output, or
the held jobs’ Media type is assigned to the Output.

Important Note: Version 3 Pagesetups, when opened in version 5, are automatically split into Pagesetup and Media
types. Version 5 archives cannot be exported back into version 3.

Output

¢ Output Driver - Select the desired output driver from the available list. Those available will depend upon the
options enabled on the dongle. The selected driver affects the options made available for Resolution and
Colourspace.

* Resolution - Select or enter the desired resolution (DPI). If the
output is a printer, only the supported resolutions are i
available. If it is a file format, your own value can be entered.

* Colourspace - Select the output colourspace as desired. The ol O
selections will change depending upon the chosen output o (s
driver. h

* Media Width/Length - Sets the width and length of the Media. gies
Only jobs submitted with a width and length equal to or less Pl
than the assigned values will be printed. Jobs of greater width S
and length will be held in the QueueManager until an
appropriate Media, or new width and length values are assigned.
Note: Media Width/Length values override the width/length settings in the Nesting section of the Output,
meaning jobs will not nest or print until within the width/length settings of the Media to which they were
submitted.

* Cut Sheet - Enable this if the Media being printed to is Cut Sheet. The media to be used is selected from the
dropdown menu.

o Total Sheets — Enter the number of cut sheets loaded in the printer. Jobs will stop printing to the Media
and be held in the QueueManager when MediaStatus has tracked that the assigned number of sheets
have been used. A Total Sheets value of zero (0) assumes an unlimited sheet availability for tracking.
Sheet count is reset using the Reset Counter button in the Usage panel.

* Printer Margins - Optionally set the Top/Left/Bottom/Right margins for the selected printer. These values
should be the hardware margins of the printer, defining the maximum limit of printable area. The margins are
utilised by Blackmagic when functions such as image placement and centring are used.

* Custom Settings - These options will vary, depending on which output driver has been selected. For example, if
JPEG is chosen, the quality may be specified in the customise section. If an Epson device is selected, items such
as paper types, ink types and cut methods become available.

tput Driver: | £pson Stylus Pro 7900/ 7910/9900/9310. PX-HB000/H10000 with HTM module 15
Cuntom Sattngs

Note: Borderless Printing - If available to the printer model, users can choose Borderless Printing in the custom
settings. If selected, Media width (and the image Fit setting) needs to be set to 6mm wider than the actual paper width.
When using Borderless Printing, up to 3mm of the image will be lost from the left and right sides of the image and 1mm
lost from the top and bottom of the image.
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Spotcolour Mapping Spotcolour mapping

Some printers feature non-standard inks such as metallic and white intended Map colour [PANTONE 877 C toband (White )
for use with signage and display, transparent media or to replicate a press Colour Band Dotgain Curve

. . PANTONE 877 C Metallic boost
process. These device spot inks are handled separately from the normal colour PANTONE Cool Gray 1€ White

management process.

The Spotcolour Mapping panel is used to remap incoming job spot/special
colours to a printer device white or metallic ink, e.g. remapping could be
configured to print any incoming job areas covered by the spot colour (Add ) (Apply ) (Delete )
“PANTONE Cool Gray 1 C” using the printer’s white ink.

* Map Colour - Enter the name of the spot/special colour to be remapped.

* To band (dropdown) - Select the white or metallic ink (printer dependent) to which the colour will be
remapped.

* Add - Add a mapped colout to white/metallic to the remap colour list.

¢ Apply - Apply a name or colour remap change to the colour selected in the colour list.

* Delete - Delete the selected colour/remap from the colour list.

Colour List
The colour list has the following sort columns:

¢ Colour - The name of the spot colour to be remapped.
¢ Toband - The printer device spot ink to which the colour is being remapped.
* DotGain Curve - The dotgain curve applied (if any) to the listed printer device ink.

Adding DotGain Curves

To assign an output dotgain curve to a listed printer device ink remap double-click or right-click on the colour in the
colour list and select a dotgain curve from the popup window (see Workbench > DotGain Curves for more information
on curves).

Calcheck Info
A Media can have its calibration status checked using the Check Media [cicheckinro
option within the Calcheck application (see Applications - Calcheck for more PRI e | o | o &0
information) . FpeonT000-Semiglows 170-720x 1440 27/08/00 25 M
. . . o PR v
This panel displays the current Calcheck calibration status of the Media, with vesow oe 123
the following information displayed: . e e e
Poper 221351 o feln2
*  Chart - The Calcheck Chart used for verification. ISkt v 6c#39 seore: 7257

¢ Date - The date and time of the Calcheck.
* Score - An internal calcheck rating from 1 to 100.

AE, AH and AC tabs show the following data for each of the standards (if measured):

* ACyan, AMagenta, AYellow, ABlack, AGray, APaper
* Passor Fail - As designated by a green tick or red cross.
*  AAverage, AMaximum, AStandard Deviation

Usage
The Usage panel shows the amount of media used based on the values entered for Media Length (above).

Usage

* Usage Meter - Bar showing the amount of media used. Text
under the bar shows the exact amount as “Used X Units of
Total Units” (percentage %).

* Logged Period - Time period (date and time, from and to) the
Media has been tracked since the last reset.

* Printed - Number of jobs and total printed area of jobs tracked since the last reset.

* Reset Counter - Reset the usage count for the Media.
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Colour Correction
There are three (3) options for use to manipulate or fine-tune the colour to
achieve the desired results: Colour Correction

ST IS T S—
@ Paper Profile ... Epson7900-EpsonProofing

*  Correction LUT - Select a Correction LUT to be applied in the form

of a Gradation Curve. Preview the curves, edit them or create new
A Correction LUT ... None

curves. S

* Linearisation LUT - Select a Linearisation LUT to be applied in the
form of a Gradation Curve. This is normally done as part of the
standard calibration process with the use of the Lineariser. Preview the curves, edit them or create new curves.

* Paper Profile - Select a Paper Profile to be applied. If the output is to a printer, this is also part of the standard
calibration process.

A Linearisation LUT ... Epson7900-EpsonProofing

ICC Profiles
ICC Profiles are used to match colours from one device to another, for example, a Press to an Inkjet. It does this by
mapping an input to an output colour.

ICC Profiles

*  Output ICC Profile - Select an output profile. This is the printer RS P spacn- 00 -cnk REaE
or other output profile and is used to convert Lab data to the e ——
output colourspace. This output could be RGB, CMYK, CMYKOG,
or N-Colour, depending on the output device chosen and the
detected colourspace.

*  Output ICC Tweak Set - Select a Tweak Set from the available list. Lists can be previewed, edited or new ones
created.

* Device Link Profile — Select a device link profile. If the job passing through does not match the colourspace of
the Device Link Profile, the standard input and output profiles selected will be applied.

Oevica Link

+ Device Link Profie ... ) None

Upload ICC - This option is available on all of the ICC choosers and is used to upload an ICC profile from a local or
network folder location to the internal Blackmagic ICC folder.

To Upload an ICC Profile:

1. Click the Upload File button. e -— ....... s
2. Browse to the location of the ICC file. jg" ob
3. Open the file. = = i
4. Select the location to save the file (lib/icc is =
default) £ 5
5. Click OK
6. Save the setup (Media/Pagesetup etc) once the file
has been uploaded.

Screen Printing
The Screen Printing mode separates a job into single plates and prints them as black. This is designed to print with a
halftone dot onto a clear film media. To increase the density of the output,
choose a combination of inks. This option can be used to produce films for use | seeen Printing

in the Screen Printing industry. LLEnble Sereenbrint Mode
I Cyan "I Magenta IYellow [ Black
¢ Enable Screen Print Mode - Turns the Screen Print mode on or off. T Light Cyan [ Light Magenta [ Light Black

* Ink Combination - Select the inks to be combined for a single Ltk Stk

separation output.

In Screen Printing mode, all jobs are separated and there must be a Paper Profile where only one dot for each colour is
turned on.
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Output Screening
Apply screening to the output file if desired. This is only available if the output driver selected supports screening.

There are two (2) methods available - FM Screening or Halftone.

FM Screening Variations

Stochastic - Standard Stochastic Screening.

Stochastic-2 and 3 - Stochastic Screening with progressively increasing amounts of
noise mixed in. This is done to overcome some artifacts caused by Inkjet printers. O Stochastic-2
Stochastic Fast — A fast version of the Stochastic Screening mode. Slightly lower

quality than Stochastic.

Error Diffusion - Error Diffusion Screening. May enhance edges within images.
Ordered Dither - Ordered Dithering Screening. Applies a threshold map on the pixels

displayed, causing some of the pixels to be rendered at a different colour.

Halftone Options (Traditional Rosette Dot)

Dotshape - Choose the dot shape to suit your requirements from Round,
Inverted Round, Elliptical, Inverted Elliptical, Diamond, Euclidean or Line.
SuperCell - Select this to choose SuperCell screening instead of standard
halftone. Produces a much better quality output than standard halftone.
This is the default option for Halftone Screening when enabled.
Angle,Degrees - Enter the desired angle for each plate.

Screen,LPI - Enter the desired screen ruling for each plate.

Defaults - Use this to select the default values based on the output
resolution.

Output Screening Override
Screen one or more colour plates for any incoming jobs using different methods or with different characteristics than

the defaults configured in the Output Screening panel.

Plates List

Output Screening

Method: [ FM Screening 64

® Stochastic

() Stochastic-3

() Stochastic Fast
(O Error Diffusion
() Ordered Dither

Outpet screaning

Ostihase | Diamons 1l ¥ SugmrC

Output Screening Override

Plates Plate
Cyan Cyan
Magenta Magenta

The list on the left of the panel displays the process colour plates e
and special plates (S1-S8) available for screening override. B

Blue
Override List ;;ge :

e
Override
Bl

Plates Column - Lists the plates that have been selected

Type
SuperCell (105°, 133LPI, Inverted Elliptical)
Stochastic-3

Remove ) ( Edit... )

for screening override.
Type - Lists the selected screening type for the listed plate along with
details such as screening angle, LPI and dot shape.

Remove Button - Removes the selected plates from the override list
reverting them back to the default output screening option.

Edit Button - Edit screening options for the selected plate. Options are
detailed in the Output Screening section above. Double-clicking on the
plate in the Override List will also open the edit options window.

ano Output Screening Override
Method: | Halftone T]
Dotshape: | Inverted Elliptical 3] # SuperCell

Angle, degrees Screen, LPI

105.00 133.00

( Cancel ) OK .
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Output

The Output data type determines the output format of processed jobs and where they are sent to for printing
(or file output). The Queue panel sets the output driver used and allows auto-cleaning of job Output queues. The printer
connection or file destination is configured in the Destination panel. The Collating section has options for Nesting and
Duplexing. Maintenance allows for automatic printer maintenance functions to be configured.

Queue

*  Output Driver - Select the desired output driver from the [
dropdown list. Those available will depend upon the options e .
enabled on the dongle. The selected driver affects the options J—
in a Pagesetup and Media pointing to it. e

* Change Media - Select this to optionally assign a Media to the ‘
Output. A chooser window will appear with Media displayed
matching the Output driver type. The options as set in the selected Media are displayed for view, can be edited
or a new Media can be created.

¢ Status - Choose whether an Output Queue is Active (able to print/output) or Inactive (Print/Output is paused).
This can also be controlled from a QueueStatus module.

* AutoClean - Configures Blackmagic to automatically delete printed jobs from the Output queue based on times
and/or number of completed jobs in the queue. Auto-cleaning is performed the next time a job is submitted
after an auto-cleaning condition has been met. Options include:

o Job History - Keep Most Recent - When enabled, set a number of jobs. Blackmagic will keep that
number of most recent printed jobs in the Output queue, automatically deleting any excess jobs.

Note: If this option is enabled and the number of jobs is set to 0, jobs will be deleted from the queue immediately after
printing.

o Job History - Keep Jobs Newer Than - When enabled, Blackmagic looks at the time signature of
printed jobs and deletes any jobs in the queue older than the specified (days/hours/min) time.
* AutoPause - Select a time duration the queue should pause after processing a job. Used for double-sided
plotters so there is a pause in sending the next job, giving the plotter time to turn a sheet ready for the back
side to be printed, or time to load another sheet.

Note: The Change Media option is used as both a safeguard against paper wastage and a workflow control method. If a
Media type is assigned to the Output, only jobs submitted to the Output using the same Media will be printed. All other
jobs are held in the QueueManager until the Media they were submitted to is assigned to the Output. If no Media is
assigned, all jobs sent to the Output are printed.

Destination
The Destination determines the method of delivery of the output job to the final destination. Depending on the
destination driver selected, there may be some additional options available.

Destination Drivers

* Bonjour/Zeroconf - Select this to output to a Bonjour/Zeroconf network destination. The local network is
polled for Bonjour/Zeroconf devices. Choose Edit and select the appropriate destination from the dropdown
list.

* Command/Script - Select a script or command to be run once a job has completed.

* Epson FireWire - Only available on the Mac OSX version. Windows users should use the Local Print Queue
option and print to an installed printer, configured to use FireWire.

* Epson XIO - Print to an Epson connected via FireWire using Epson XIO interface on the Mac OSX. This requires
the Epson driver to be installed on the Mac first. Use XIO if the FireWire driver does not work.

* FTP - Send a completed job to remote machine using FTP.

* Local Device - If a printer is connected as a serial or parallel printer, send a file directly to the device with this
option.

* Local Folder - Choose a local folder to send the output file to. Enter the path or select Choose to browse and
select a folder. The folder must exist and have write permissions.

* Local Print Queue - Print to a local print queue. Use this to print to a Windows printer on another machine. In
the path location enter \\machine\printer where <machine> is the name of the Windows machine with the
printer attached and <printer> is the exact name of the printer. The printer must be shared.

* LPR Port - Use LPR to print jobs to printers accepting it. Enter the Hostname/IP address of the printer and the
path. Not all devices require a path to be entered. This is a good option for Epson printers with a network card.
This method is faster than TCP/IP printing for these devices.
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Collating .
Collating is a method of gathering various outputs and grouping them together.
There are two (2) methods of collating available, depending on the output driver s ke
selected. If an output driver that supports Duplexing is selected, the additional ©0d Otwn  on  [liom [0
Duplexing collation method becomes available. Otherwise, the only option is
Nesting.

Duplexing

Duplex

Nowhere - This is used for internal testing purposes or for softproofing workflows. Files created by the print
driver are not sent anywhere; they are left in the default raster location. A print time for simulation can be
entered.

PAP (AppleTalk) - Select a networked AppleTalk device to print to. The Change button displays any valid
AppleTalk devices.

Secure FTP (sftp) - Send the job to a secure server using FTP.

TCP/IP Port - Print to a networked device over TCP/IP.

USB Printer - Print to a printer connected via USB.

Collating

oltation Method: | Duplexing W84

Add Separator Page

jobs with multiple pages to form double-sided printing. This is only

available for printers supporting duplexing modes.

Nesting

Nest multiple jobs together for a single output to save media and time.

Add Separator Page - Adds a blank page between duplexed sets. This is useful when de-imposing and
duplexing perfect bound jobs. A blank page is inserted after the Maximum Jobs is reached for duplexing to
begin.

Top Page - Determine if the top page is an odd or even number.

Maximum Wait Time - Set the time to wait before duplexing begins. If the MWT is reached and the back side of
the pages has not yet been processed, the queue will begin to duplex any available pages. This will result in
single pages where the back are not yet completed.

Maximum Jobs - Set the maximum number of jobs for duplexing. If this value is reached, duplexing will begin.

Catating

Enable Automatic Nesting - Set the queue to nest jobs automatically when
the configured conditions (such as Maximum Wait Time) are met.

Auto Rotate When Nesting - Enable auto rotation when nesting occurs. If
this is enabled, make sure the option in the Pagesetup is set to None. There
is no need to spend processing time rotating a job if it is rotated at nesting i
time.
Copies - Specify the number of copies for nesting. For example, if there are 7 jobs making up a nest and enter 5
in the copies field, 5 copies of the same 7 jobs will be nested and printed.

Maximum Wait Time - Specify how long to wait before nesting begins. Once reached, nesting will begin and
any job waiting to nest will be nested into a single job. The start time is determined by the first job that appears
waiting to nest.

Minimum Paper Coverage - Specify the minimum paper coverage to be reached by jobs waiting to nest before
nesting will begin. Once reached, any waiting jobs will be nested into a single job.

Maximum Jobs - Specify the maximum number of jobs in a nest. If there are more jobs in the queue than the
number specified, that number of jobs will nest and the remaining jobs will stay waiting to nest until the
criteria is met again.

Media Width - Specify the media width. This is required for nesting to work.

Gap Between Jobs - Enter the size of the gap between jobs in the nest.

Minimum Total Height — Specify the minimum total height of a nest, i.e., if the combined height of the jobs
waiting to nest reaches this value, nesting will begin.

Maximum Total Height - Specify the maximum total height of a nest, i.e, if the combined height of the jobs
waiting to nest reaches this value, nesting will begin.

Note: If a Maximum Height is set, the Nesting algorithm will look at all the jobs waiting to nest and fit the most jobs
between the minimum and maximum heights.

If the available jobs can not cover the defined Paper Coverage (if set) of paper without exceeding the maximum height,
jobs will not nest. If no Paper Coverage minimum is set, any job that would make the nest exceed the maximum height
will be left in the queue - the other jobs will be nested. Any single job exceeding the Maximum Height will also not
print. If a job is too large, the nesting parameters and/or the printer media must be changed. This makes it possible to
effectively and efficiently nest using Cut Sheet media.
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Maintenance
The Maintenance panel allows Blackmagic to be configured to automatically perform printer maintenance functions.
This is not available for all printer drivers.

Maintenance functions can be performed at regular time intervals; after a set number of print jobs; or after printing
linearisation charts and ICC targets.

Options include:

*  When - Select Every from the dropdown menu to activate time-based maintenance, with configurable time and
day fields.

o Perform Actions:

=  (Calcheck - When enabled, the printer will print a Calcheck Chart as specified by the user.
= (lean Print Head — When enabled, the printer will clean the print head.
=  Print Nozzle Pattern - When enabled, the printer will print a nozzle check pattern to verify all
print nozzles are clean and functioning.
= Nozzle Check - When enabled, the printer will perform a nozzle check.
¢ Every - Enter a number in the field or use the arrows to set the selected maintenance to be performed after the
defined amount of print jobs.
o Perform Actions:
=  (Calcheck - When enabled, the printer will print a Calcheck Chart as specified by the user.
=  (lean Print Head — When enabled, the printer will clean the print head.
=  Print Nozzle Pattern - When enabled, the printer will print a nozzle check pattern to verify all
print nozzles are clean and functioning.
= Nozzle Check - When enabled, the printer will perform a nozzle check.
¢ After printing:

o Linearisation Chart - When enabled, the printer will print a nozzle check pattern immediately after
printing a linearisation chart. If the pattern is incomplete, the print head will need to be cleaned and
the chart reprinted.

o ICC Chart - When enabled, the printer will print a nozzle check pattern immediately after printing an
ICC Target Chart. If the pattern is incomplete, the print head will need to be cleaned and the chart
reprinted.

* (Calcheck Settings - Specify the Calcheck Chart to be printed when the above Calcheck option is enabled.
Note: The Calcheck Chart will only print if there is a valid Media attached to the Output via the Change Media
button. If the Calcheck fails, the output will be made inactive automatically.

* Pagesetup - Select the Pagesetup to use when processing the Calcheck Chart maintenance option.

Printer Maintenance
This panel is used to manually execute a printer maintenance function or test print on enabled output devices.

Select the desired maintenance function from the dropdown menu.

* Execute - Initiate the selected printer maintenance function or print.

Printer Maintenance

| Print Nozzle Check Pattern and F/W version | | Execute |

Printer Maintenance

v Print Nozzle Check Pattern and F/W version i\ \7 Execute D
Auto Nozzle Check without Metallic Ink
Auto Nozzle Check with Metallic Ink

Bidirectional Adjustment
Unidirectional Adjustment
Paper Feed Adjustment
Head Alignment
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Output

Pagesetup
A Pagesetup consists of many configurable modules to manipulate a job for the desired output. This is where
the Input Screening and ICC Profiles, Render Effects, Colour Keys and other Colour Management options are setup.

Change Output - Selects the Output method and assigns its configured properties to the Pagesetup.
Change Media - Select the default Media settings and assign its properties to the Pagesetup. If a job is
submitted to the Pagesetup without a specific Media, the job will output using these default Media settings.

Output Settings:

(e]

Qutput

Antialiasing - Choose from 2x2, 3x3, 4x4 or None.
Antialiasing is designed to smooth jagged edges and is used
when the Output does not have sufficient resolution to
display edges smoothly. The values increase the amount of
pixels used for Antialiasing. The default setting is None.
Priority - Assign a priority to a Pagesetup. The lower the
number, the higher the priority. Numbers can be negative
for a higher priority. The default is 0. Jobs waiting to Image
or Render will be processed by higher priority Pagesetups over those submitted to lower priority
queues.

Auto Publication Name - Create unique publication names for each job passed through the Pagesetup.
Use this feature for duplexing from PDF or PS files. Submitting a multi-page document as one job will
allocate all pages with the same publication name.

16 Bit Processing — Enable or disable 16-bit processing for jobs submitted to the Pagesetup. This is the
default option for any new Pagesetups created.

Change Output Epson 7880

& Change Media Epson7880-Semimatte260-720-i1
Output Settings
Antialiasing: ' None 19

Priority. 0

Auto Publication Name
16 8it Processing

Note: Blackmagic V5 is able to accept files submitted in a 16-bit format. The files are normally processed and rendered
in standard 8-bit colour, which for many workflows is sufficient for proofing. 16-bit processing improves render quality
and can be useful for finding artifacts within a job. When enabled, files submitted to the Pagesetup in 8-bit are upscaled
to 16-bit for processing. 16-bit mode requires more system memory for imaging/rendering jobs and produces larger
output files.

Publish

Allows Pagesetups to be published on a network as a Drop Folder, or as a network print destination for printing from
another software application. To Publish a Pagesetup, it is necessary for the Serendipity Megarip PPD to be installed on
the same system on which the Blackmagic Server runs (Server menu > Download PPD).

Publish DropFolder - Allocate a folder where files can be dropped in for processing. Valid File Types include
Postscript, PDF, JPEG, TIFF Image, Serendipity Blackmagic Image, EPS, PNG, PSD.

Location - Select a folder as a DropFolder. The folder must exist and
have read/write permissions.

Default - Reset the DropFolder location to the default one e petat
(Serendipity Blackmagic installation directory/drop/<"Pagesetup
Name" >) Printer: || Mac [ Windows

Printers - Choose to publish the Pagesetup as a network print
destination, allowing third party applications to print directly to it.

(e]

(e]

Publish
[ Publish DropFolder

TCP Port: [ Activate port number

Flow Control: Hold After Imaging  [_| Hold After Rendering

Mac - Enable to publish the Pagesetup as a Bonjour/Zeroconf

network destination for Mac OS X and Linux. This option also publishes the Pagesetup as an AppleTalk
destination, where the Pagesetup name is used as the printer name.

Note: When adding a new printer through System Preferences on Mac OS X, select the Bonjour address
(pagesetup name@computer name) as the printer and Serendipity Megarip PPD as the driver.
Windows - Choose to publish the Pagesetup as a Windows local printer port destination. See the
Serendipity Software website for details on how to create the Windows printer.

TCP Port - Choose to publish the Pagesetup to a TCP Port, allowing it to be setup as an IP printer destination,
or as a destination for other Serendipity Blackmagic Servers.

(e]

Activate Port Number - Enter the TCP port number the Pagesetup will publish to. It is necessary for
the port number to be 10000 or over and for each Pagesetup to have a unique port.
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Note: When adding a new printer through System Preferences on Mac OS X, select IP printer, HP
Jetdirect - Socket for the protocol. The address should be in this form - computername:10063. Select
Serendipity Megarip as the driver.
When adding a new printer through Windows:

1. Select Create a New Port - Standard TCP/IP Port.
Enter the computer’s network name in the Host ID field.
When Windows requests additional info for the port, select Custom Settings.
Rename the Port Name if desired.
Set the Protocol to Raw and the Port Number to the one set in the Pagesetup to be
published.
Select Serendipity Megarip as the driver. If the driver is not already installed, choose
Have Disk and get the driver (megarip.inf) from the Serendipity Installation DVD,
found in the drivers/win/’OS Version’/ directory.

UA W

o

* Flow Control - Select whether to hold the submitted file after Imaging or Rendering in order to prioritise jobs
or make rendering attribute changes before releasing. Options include:

(e]

Hold After Imaging - Hold jobs submitted to the Published Pagesetup after imaging has completed.
Held jobs can be released to continue processing via the QueueManager toolbar or contextual (right-
click) menu.

Hold After Rendering - Hold jobs submitted to the Published Pagesetup after rendering has completed.
Held jobs can be released to continue processing via the QueueManager toolbar or contextual (right-
click) menu.

Nest — When enabled, this option will nest jobs submitted to the Published Pagesetup according to the
criteria defined in the Output used by the Pagesetup/Media.

Note: The Nest function only requires that the Output used has nesting parameters defined. The
Output itself can have nesting disabled for normal use. This makes it possible to create multiple
nesting or non-nesting Published Pagesetup’s to print via the same Output.

Asset Queue as a Published Pagesetup
The Asset Queue automatically publishes itself on the network in multiple ways:

* Drop Folder - Files placed in the Asset Drop Folder are automatically placed in the Asset Queue. The drop
folder location is /Serendipity Blackmagic/drop/asset drop

* Printer - The Asset Queue is published as a Bonjour/Zeroconf network destination address (asset
drop@computer name). Jobs printed to this Bonjour destination (see above) are placed in the Asset Queue.

* TCP Port - The Asset Queue publishes itself to TCP port number 9104. Jobs printed to this TCP port (see above)
are placed in the Asset Queue.

Colour Correction

* Replace Colour Set - Select a Replace Colour Set from the list of available sets. [ colour correction

Preview the set, edit it, or create a new one. (" ® Replace ColourSet .. ) None
* (Cyan/Magenta/Yellow/Black DotGain Curves - Select a C, M,Y or K DotGain ( ® CyanDotGainCunve .. ) None
Curve to be applied. Preview the curves, edit them or create new ones. ("® Magenta DotCain Curve .. ) None
* Specials DotGain Curve - Select a DotGain Curve to be applied to the Special (__8 Yellow DotGain Curve . ) None

Spot Plates only. One curve affects all Special Colours the same way. Preview K_9 Sack Dordain Cunee ~__JiR000E
the curve, edit it or create a new one.

* Device Linearisation Curve - Select a Device (platesetter) Linearisation Curve
to be applied. Preview the curve, edit it or create a new one.

ICC Profiles

¢ Always Use ICC - Enable this to always use the assigned ICC profiles for
jobs submitted to the Pagesetup (and Media). If this is not enabled, the ICC
profiles selected are only used in colourspace conversion. This is the
default option for any new Pagesetups created.

* Honour Embedded ICC Profiles - Enable this to use an ICC profile
embedded in a submitted TIFF, JPEG or EPS file as the input match profile. o o
When enabled, embedded file profiles will always take precedence over any e
Match ICC assigned to the Pagesetup.

( @ Specials DotGain Curve ... )
® Specials DotGain Curve ... None

® Device Linearisation Curve ... None
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Note: The TIFF Image output driver has an option to embed an ICC profile into TIFF files that are output by Blackmagic.

* Black Point Compensation - This setting is designed for use when processing input from large gamut sources
such as photographs and RGB images. Black Point Compensation enhances shadow details in these images;
assists when viewing shadowed areas in non-ideal or everyday lighting conditions; and prevents flooding in
CMY gray areas.

This setting only functions when using colourimetric intents, and when Always Use ICC is checked.
Black Point Compensation should not be used for normal CMYK proofing jobs, which are generally well within
the gamut of an output device (Inkjet printer).

* Intent - Select the rendering intent to use. Options include:

o Perceptual - All colours are moved proportionally to each other so the eye perceives the colours to be
correct (i.e., colours out of gamut move into gamut, and those in gamut move proportionally to those
out of gamut).

o Relative Colourimetric - Those colours out of gamut are moved into gamut, and those in gamut are left
untouched.

o Absolute Colourimetric - The colours are left alone so those out of gamut cannot be reproduced.
Adjusts the white point of the media to match that in the input ICC profile.

o Saturation - Those colours out of gamut move into gamut, but all colours increase in saturation as a
result.

* Retain Pure Black - When ICC profiles are used, all colours, even solids, are made up of a mix of different
colours. Selecting Retain Pure Black uses only black for areas containing just black. When enabled, the
following options become available:

o All - Uses black ink only in all areas defined as Black.

o Text - Uses black ink only in elements defined as Black text. This can improve the clarity and
sharpness of the text.

Note: This option is not always suitable for use with printers using light black inks, as many of these inks tend to have a
non-black hue.

* RGB ICC Profile - Select an RGB Input profile. This is used to convert data input from an RGB source to Lab for
colour management.

* Press ICC Profile - Select a Press profile. This is a Match profile and is used to convert input data from CMYK to
Lab. This can be a multicolour profile or CMYK. If a multicolour profile is selected, an additional option will
become available - Press Inks.

o Press Inks - This setting is used to define a press ink set for a multicolour press ICC profile if the
selected profile does not contain process ink names. Selecting this option displays a Special Colour Set
chooser to select a pre-defined press ink set or to create a new set.

Important Note: For multicolour profiles to work, you must create the same colour names used in the ICC and have
them in the same order. The order for the ICC is specified during ICC creation. This is independent of the actual press
order. Change the order by dragging the colours around the set. The order is specified as the Colour (left column), order
descending.

* Upload ICC - This is available on all of the ICC choosers. If the ICC profile is located somewhere other than the
default ICC folders, use this function to upload it to the Server ICC folders in order for it to be used. As this is a
Client-side option, use this function for moving ICC profiles from the machine they were created on to the
Server. This can be either on the LAN or WAN as a remote machine.

* Print Calcheck - Select this to attach a calibration strip to every job passing through this Pagesetup. The
Calcheck results (green pass or red fail) will change the colour of the job information shown in the
QueueManager when the job is processed (see image below).

o Device - Choose the device used to measure the strip with. This creates the chart for the correct
device.
o Chart - Choose the chart for use from the popup window of Calcheck Charts.

Note: The Calcheck Chart is a Data Type in the Workbench. This is where the chart is created. Use the Calcheck
application to measure it and produce a report.
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ColourKeys |
This module allows for the merging of some plates and separation of others
from a single job submission. For example, merge the CMYK plates together and
print the 3 specials as separate jobs, or create progressive proofs with C, CM,
CMY, CMYK, CMYKS1, etc.

* Enable ColourKeys - Select this to turn the module on.

* Plates - Shows a list of available plates.

* Add - Adds the selected plates to the Plate Combinations list.

* Progressive - Used to make progressive proofs. After adding the first plate to be used in the proof, click the
Progressive button one or more times to cumulatively add plates to the Plate Combinations list. The
progression will start with the first plate on the Plates list by default if a first plate is not selected.

* Deselect - Deselects any plates currently selected in the Plates list.

* Remove - Removes the selected Plate Combination from the list.

* Remove All - Clears the Plate Combination List.

Input Screening T
Input Screening determines how the screening on the input data is handled. =
There are two (2) choices - Preserve and Descreen.

* Preserve - Preserves the dots from the incoming data so the same dots
on the final job are shown on the proof. Further choices are:
o Real Dot Technology - Used to preserve the dot structure.
o Fast-2 - Similar to RDT but a faster method.
o RDT Smooth 1, 2 and 3 - This is RDT with progressive levels of smoothing.

Note: Fast-2 should be used where the dot structure is not very important. It will preserve the dot but is a quick, low
quality method. The sharpest dot structure will be achieved using RDT, however you will sometimes get introduced
moire, caused by the head weaving of the printer, the resolution and the screen ruling of the original file.

* Descreen - Descreens the incoming data with either:
o D-Dot - Removes the dots; or
o Fast - Quick descreening algorithm

Note: D-Dot is used where the output job is being sent to a photocopier or similar device, with a front-end RIP that
applies a screen of its own. If you did not remove the dot, the job would be double screened, producing poor output. Use
Fast for all other methods when the incoming screening is not to be preserved.

* Plates and Plate/Type - Override the descreening mode selected with other modes for the plates. This is
needed so that, for example, if RDT is used for all plates except Black (which uses RDT Smooth-2) you will
avoid getting moire.

Postscript / PDF Options
The following options are only used when the incoming data is Postscript:

* Use Bounding Box for Page Size - Some Postscript jobs do not place a page size in the job information.
Checking this will use the bounding box as the page size.

* Simple RGB to CMYK Conversion - This is a compatibility mode
from older versions of the product. Images are converted from RGB Postscript / PDF Options

to CMYK quickly using a basic method. The colour is not very () Use Bounding Box For Page Size

accurate and is not recommended for contract proofs. - i'a"’l“:: :g: :;:g“::“ conversion
* Fail on RGB Images - Causes a job to fail if it contains RGB images. If () Antialiased Subsampling

this is not checked, the jobs will process but RGB images will be ‘;:l‘r::fi:":;;“’“"*""’“°"

ignored and not printed. @Use CMYK simulation from PDF for unknown colours
* Antialiased Subsampling - Used to assist in the rendering of some

fonts.

¢ Disable PDF Autoseparation - Turns off autoseparation for PDF files.
* Render in RGB - Allows Postscript file data to be processed in an RGB rendering mode, with a wide gamut
suitable for digital photographic proofs/prints.
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¢ Use CMYK simulation from PDF for unknown colours - Allow the CMYK simulations from PDF files to be
substituted for unknown spot colours. This is the default option for any new Pagesetups created.

Note: An Unknown Specials colour set can now be assigned in the Server Settings. This allows unknown special/spot
colours included in PDF or Postscript jobs to be automatically added to the set.

Resampling
Configure the method for sampling incoming data and changing the resolution from the input to that of the output. The
options are:

* Nearest Neighbour - The fastest method but less accurate. Choices are made as the closest pixels from input to
output and can result in jagged edges or stepping effects.

* Bilinear - A medium quality sampling method and can take longer than Nearest Neighbour. Bilinear takes the
weighted average of 4 pixels from input to output. Best for use with screened data.

* Bicubic - High quality sampling method which takes longer to calculate than Bilinear. Bicubic uses the
weighted average of 16 pixels from input to output. This is the default option for any new Pagesetups created.

* Filtered - Serendipity’s own sampling method, giving the highest quality. It takes longer to process than
Bicubic and uses an averaged area from input to output. This setting provides better resampling for contone
data, such as Postscript and PDF.

Logo

Logo Enable Logo

Position a company logo, sign-off slugline or colour bar for checking consistency ]

anywhere around the job. The logo passes through the same colour management as the e
job and can therefore be verified. The file is not rotated during output (except if Auto B 0 o

Rotate When Nesting is enabled). If the logo file is positioned along the left or right
sides, the EPS file should be created in the appropriate orientation.

* Enable Logo - Turn the Logo effect on or off.
* Dimensions - Enter the print dimensions of the Logo.
* Logo File - Select this to choose a Logo file.

Effects
Various effects may be applied to jobs passing through the Pagesetup. Effects are applied in the order they appear here.
Some effects have separate attributes for customisation and can be edited once they are in the Applied Effects column.

The Effects are:

* Border - Place a border around the job. Line width and colour can be specified. Effects

* (Centering - Centre the job in the specified page area. (] Enable Effects

¢ Convolution Matrix - Design your own filter effect according to a pre-defined I
mathematical operation known as convolution. et

¢ Cropmarks - Place crop marks around a job. Line width, length and clearance can be Centering
specified Convolution matrix

p ! . Cropmarks

¢ Edge Detect - Remove all content and just leave the edges. Edge detect

¢ Fotoba Cut Marks - Prints user-configurable cut marks around jobs for subsequent ;Otol?a Cut Marks
cutting/trimming by Fotoba Digital Print Cutter devices. e e

* Margins - Specify margins around the job. Negative

e Mirror - Mirrors the job. £agenumoer

* Negative - Renders the job as a negative.

* Pagenumber - Place the page number in the middle of the page as a watermark. Scale factor and opacity can be
configured, and choose between page number of the job or the page number of the signature (when using De-
Imposition).

* Rectangle - Draw a rectangle around the job inset at the desired distance, line width and colour.

* Registration Marks - When enabled, this effect will add registration marks at each corner of the submitted job.
Line width, Inner and Outer Radius are all configurable. This is not available when using the Studio application.
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Media Effects

Signature Decorations - Place page lines (from the signature) and page numbers on the job. Further options
are available. Choosing lines for pages will print a line around the page. Lines for spreads will print a line
around paired pages (spreads).

Slugline - Place job information on the job. There are a number of options available via the Edit button. If using
a narrow format paper and the full slugline doesn’t fit, select Custom Slugline and turn all options on. This will
show an item per line. Within Custom, fields selected will only be printed if they are relevant to the job. The
Slugline may also be mirrored - a useful option when printing to film using a white ink printer.

Unsharp Mask - Apply an unsharp mask to the job. The Unsharp Mask affects the edges within an image and
can be controlled with the available parameters. The radius tells us how large an area to affect around the
edges. The larger the radius, the greater the effect and the longer it takes to process. If the preview resolution
is high, a given radius will have less effect than if the resolution is lower. If the detail is quite fine, a smaller
radius should be used. Higher radius values can also cause halos at the edges. The threshold gives a level that
should be affected where 0 affects more of the image and 255 very little. The amount states the size of the
change, where a higher value is a greater change at the edges.

Watermark - Place a watermark across the job. The scale of the watermark is proportional to the size of the
job. 100% represents the same size as the job in the smallest direction. If the stretch option is selected,
horizontal and vertical sides are stretched to the scale amount. The watermark will be scaled in an anamorphic
manner. EPS files only.

Fitting Method S OR O OOk
o None - Fitting method is turned off. =
o Fit Width/Fit Height/Fit Width & Height - Shrinks jobs to

fit within the set dimensions; proportions are maintained.

o Scale Factor - Scales jobs by the amount specified.

o Tiles - Tiles a job that is larger than the width & height
specified. If required, an overlap can also be entered. Useful e
for large posters or billboards.

o Best Fit Width/Best Fit Height/Best Fit Width & Height - As
Fit, but will shrink or enlarge jobs to fit/fill dimensions entered while maintaining proportions.

o De-Imposition - Can be used to take an imposed file like an 8UP, de-impose it into 2UPs or singles and
print it on a smaller printer; or produce a single page PDF file. If this option is selected, a further
Signature Group button becomes available for selection.

Note: If the Fit or Best Fit options are chosen and the width & height fields are left at 0, the Fit will default to the media
width and height as defined in the Media assigned to the Pagesetup when printing (see Media for details).

Rotation - Choose from None, 90, 180, or 270 degrees. Automatic rotation may also be selected to best fit the
job using the media width and height specified.

Note: Auto Rotation is very useful for saving media, but if a job is rotated, it takes longer to process - the larger the job,
the longer the process time. Rotation takes place at the beginning of the Rendering phase and will affect cropping,
margins and so on. If auto-rotating when nesting (See Nesting in the Output section), it is advisable to have Sheet Auto
Rotation turned off, otherwise the job rotation will be calculated twice, again increasing the process time. Increasing
system memory can also improve processing times.

Centring - Choose between Vertically or Horizontally.

Use this to centre a job at any time. In particular, use it when printing to a double-sided printer to help match
the front and back sides.

Accuracy Correction - Compensate for media stretch or paper feed errors by specifying a correction amount
for width and height.

Cropping - Crop the job in all directions. Take into account any rotation that has been applied, as cropping
takes place after rotation.

Auto Crop - Enables auto-cropping to remove blank area around an image. The crop stops at the first coloured
pixel encountered in the file image.

Margins - Specify a margin to shift a job over or compensate for a printer’s set margin. As with cropping, take
rotation into account.

Effects - Mirror or Negative a job by enabling either option.

Note: The Mirror and Negative effects in the Sheet panel differ to those in the Effects panel in that they apply the effect
at the Imaging stage of processing.
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Publish

Allows Pagesetup Pools to be published on a network as a Drop
Folder, or as a network print destination for printing from another
software application. To Publish a Pagesetup Poo], it is necessary for

the Serendipity Megarip PPD to be installed on the same system on Pl cimret el s i 0k A ey L
which the Blackmagic Server runs (Server menu > Download PPD). o s
*  Publish DropFolder - Allocate a folder where files can be ey T
dropped in for processing. Valid File Types include b it A i

Pagesetup Pools

The Pagesetup Pools data type is used for printing to one or more Pagesetups. Load balance between
multiple Pagesetups, or print to multiple Pagesetups simultaneously. These can be published in the same
way as an individual Pagesetup, or the Pool can be set to auto-proof from a RIP configuration.

Postscript, PDF, JPEG, TIFF Image, Serendipity Blackmagic
Image, EPS, PNG, PSD.

Location - Select a folder as a DropFolder. The folder must
exist and have read/write permissions.

Default - Reset the DropFolder location to the default one
(Serendipity Blackmagic installation

Publish
Publish DropFolder

Defalt

Prirter Mac Windows
TCP Port: _ Activate port number

) By Number of Jobs v POF
£2400790..n270-RCE
Prints To All Pagesetups o, None

al . olog) #¥8300s .. 85 Otigh)
yy  HPZ3100 . Screeming
WP 23100

MQIXIIIIEEZONNAAF

directory/drop/<"Pagesetup Pool Name”>)
Printers - Choose to publish the Pagesetup Pool as a network print destination, allowing third party
applications to print directly to it.

(e]

(e]

Mac - Enable to publish the Pagesetup Pool as a Bonjour/Zeroconf network destination for Mac OS X
and Linux. This option also publishes the Pagesetup Pool as an AppleTalk destination, where the
Pagesetup Pool name is used as the printer name.

Note: When adding a new printer through System Preferences on Mac OS X, select the Bonjour address
(pagesetup pool name@computer name) as the printer and Serendipity Megarip PPD as the driver.
Windows - Choose to publish the Pagesetup Pool as a Windows local printer port destination. See the
Serendipity Software website for details on how to create the Windows printer.

TCP Port - Choose to publish the Pagesetup Pool to a TCP Port, allowing it to be setup as an IP printer
destination, or as a destination for other Serendipity Blackmagic Servers.

(e]

Activate Port Number - Enter the TCP port number the Pagesetup Pool will publish to. It is necessary
for the port number to be 10000 or over and for each Pagesetup Pool to have a unique port.
Note: When adding a new printer through System Preferences on Mac OS X, select IP printer, HP
Jetdirect - Socket for the protocol. The address should be in this form - computername:10063. Select
Serendipity Megarip as the driver.
When adding a new printer through Windows:

1. Select Create a New Port - Standard TCP/IP Port.
Enter the computer’s network name in the Host ID field.
When Windows requests additional info for the port, select Custom Settings.
Rename the Port Name if desired.
Set the Protocol to Raw and the Port Number to the one set in the Pagesetup Pool to
be published.
Select Serendipity Megarip as the driver. If the driver is not already installed, choose
Have Disk and get the driver (megarip.inf) from the Serendipity Installation DVD,
found in the drivers/win/’OS Version’/ directory.

Vi W

o

Flow Control - Select whether to hold the submitted file after Imaging or Rendering in order to prioritise jobs
or make rendering attribute changes before releasing. Options include:

(e]

Hold After Imaging - Hold jobs submitted to the Published Pagesetup Pool after imaging has
completed. Held jobs can be released to continue processing via the QueueManager toolbar or
contextual (right-click) menu.

Hold After Rendering - Hold jobs submitted to the Published Pagesetup Pool after rendering has
completed. Held jobs can be released to continue processing via the QueueManager toolbar or
contextual (right-click) menu.

Nest - When enabled, this option will nest jobs submitted to the Published Pagesetup Pool according
to the criteria defined in the Output used by the Pagesetup/Media.

Note: The Nest function only requires that the Output used has nesting parameters defined. The
Output itself can have nesting disabled for normal use. This makes it possible to create multiple
nesting or non-nesting Published Pagesetup Pools to print via the same Output.
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Job Queuing
Job Queuing is used to configure how incoming jobs are managed by the Pagesetup Pool.

* Priority - Assign a priority to a Pagesetup Pool. The lower the number, the higher the priority. Numbers can be
negative for a higher priority. The default is 0. Jobs waiting to Image or Render will be processed by a higher
priority Pagesetup Pool over jobs submitted to lower priority pools.

* Pool type - Decide what sort of pool to use. There are two (2) options:
o Load Balancing - Spread the jobs across the Pagesetups selected in the pool.

= By Print Area - Calculate the area of each job and the queue with the least amount of print
area queued is sent the next job.
= By Number of Jobs - The queue with the least number of jobs is sent the next job.

Load Balancing is ideal for printing to multiple printers of equal quality, using the same media, with the priority being
to proof jobs to the next available printer. Each printer is calibrated separately to ensure quality. “By Print Area” is
more efficient, as the larger the print area the longer it will take to image, render and print. Queue loading is
determined at the time of imaging. If a print queue is paused, jobs will be sent to active queues.

o Prints to All Pagesetups - Choose to print to all Pagesetups selected in the pool.

The option Prints to All Pagesetups is ideal to print a job locally and remotely. One Pagesetup can be configured to drive
a local printer and another can create a JPEG image and transmit it to a remote Serendipity Blackmagic. Alternatively,
create a PDF file to send to a customer at the same time as printing a hardcopy.

Pagesetups
This displays all Pagesetups configured in the system. The sort columns show the Output, Input Screening and Media
used by each Pagesetup.

Tick boxes are available to select which Pagesetup will be included in the Pool. A context menu for each Pagesetup in
the list allows the user to edit any or all selections of the highlighted Pagesetup, it’s assigned Output or Media.

Serendipity Blackmagic User Manual - Version 5.4 52



Paper Profile
Configuring a Paper Profile is a fundamental part of calibrating a printer for optimum colour output. The
profile is assigned to a Media and matches paper and ink characteristics to the output driver, resolution,

colourspace and custom settings of the Media.

The user interface for Paper Profile comprises of a toolbar containing options and functions to assist in creating the

profile; and a tabbed panel where the printer’s dot sizes (Density
Patches), Ink Limits are configured.

Toolbar Options ‘ S EE

Measure Patches - Use this to measure a printed density ‘ -

chart using a supported Spectrophotometer. After selecting, T T !! isin
choose an online instrument to be used from the popup list. :.,, .
When the device is ready, the measuring window becomes !
available. If instructed, calibrate the instrument and begin o |

patch measurement. 2 e e
Change Media - Change the Media currently assigned to the mmen e E !

Paper Profile. 105 x mx ] ot woacn Kipsel M| /s
Print Density Chart - Prints a density chart containing the
patches currently turned on. Where patches are turned off,
there will be a space on the output print.

Print Density Chart (All patches) - Prints a density chart containing all patches, irrespective of their on/off
state.

Prink Inklimit Chart - Prints an ink density chart containing all enabled limits as one job to the selected Media
and Pagesetup.

Print Inklimit Chart (Separate Jobs) - Prints an ink density chart for each enabled ink limit colour combination
as a separate job, using the Media and Pagesetup selected.

Configure Inklimit Chart - Configures the combinations of inks to be tested for ink limits. Select which colours
will be printed, the start and end ink percentage points and step increments.

Note: If you have a combination selected but insufficient patches to fill the row, an empty chart will be printed.
For example, if you select to print 3 ink limit and have 2 colours selected, only the chart border will be printed.
Preview Graph - Show a graph of the patches currently turned on. See the Graph section for more information.
Sift and Sort - Enable or disable this option to Sift and Sort the patches in legacy Paper Profiles (from previous
versions).

Reorder Inks - Change the order of the inks in the paper profile to match the order used in the ICC profile.
Often used for N-Colour profiles. Highlight the ink channel in the list and move using the up and down arrows,
or drag and drop inks to the required position.

Upgrade - Upgrades a legacy (pre-version 5) paper profile to the latest version.

Density Patches
This area shows the patches making up the Paper profile. Each patch represents a dot size or combination of dots
available to the printer being profiled.

The number of ink channels shown and the number of patches shown for
each channel will vary, depending on whether the printer has variable dot
capability; if it has light inks; and if the light inks are configured to be treated | * 2 2
as separate or combined channels. These options are selected in the Output ||uos17| L7094 [L70.29| w6133
and Custom Settings of the Media chosen when creating the Paper Profile. 1 t pumberss

Before densities have been measured, all patches will be turned on and will ; = - i
have default (L value) densities. These densities are updated by data input >(
from the Measure Patches option. Lios.19 | EREN MEGREN wess

"

.1 ><\ z 7]
L:95.13 | |k 61.1! L: 44.87 QIELSI

=
Vs

N

Light Magenta Lab: 70.288, 53.162, -22.144
Ink amount: 67%

5 5 Dot percentage: 54%
L: 95.17 | |k765.26 ERIR nots: medium Light Magenta

Patches can be turned on or off by clicking the upper half of the patch.

Click the lower half of the patch to manually enter (L value) densities for that patch number. Pressing Enter or
TAB stores the value and moves to the next patch for entry.

Hovering the mouse over the patch number displays a tooltip, providing information about the patch including
default or measure Lab values.
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Sift and Sort Options

When enabled, the Sift and Sort options for each ink channel allow users to set the maximum ink coverage for the
channel and display the channels name. For legacy paper profiles created in previous versions of Blackmagic using
patches with Density values rather than Lab values, this option also allows users to set the patch order and sift for the

optimal combination of dots for the ink channel.

* Sift - This is a legacy option, available to older paper profiles create in previous versions of Blackmagic. Sift
uses one of several intelligent algorithms to select a suitable dot combination based on the density readings
taken and the output device selected. When used, the popup DotSieve Algorithm Selector presents the available
device/ink Sift options. The Sift selected patches can be switched off or changed if alternate patches are more

appropriate.

* Maximum Ink - This field sets an ink coverage limit for the ink channel by introducing white space into areas of
coverage higher than the set limit. The default setting is 100%, i.e., no limiting. Maximum Ink is a “low level”

setting applied during screening.

* Sort Order - This is a legacy option available to older paper profiles created in previous versions of

Blackmagic:
o Patch Number - Sort the patches in patch numbered order.

o Colour Density - This is the density of the colour, sometimes called Real Density. It is the colour

content of the patch.

o Visual Density - This describes how dark the colour is, i.e,, how much light the colour is absorbing,
measured as Black. This sort option is not available for Black, where colour and visual density are the

same.

Note: Turning off an Ink Channel

When Treat Light Inks as Separate Channels or N-Colour options are enabled, the user has the option to turn off one or

more of the printer ink channels.
Some inks - often Cyan and Magenta - produce patches with a high colour | cvandensity
density while not being very dense visually. During the process of calibrating | "
a printer, if you find that even the small dot (patch 2) of an ink has a colour | cyen density
density too high to enable that colour to pass a particular calibration |ar

1 2 3 (2 /
L:94.94 | 126035 |L:57.54 ,%\5‘3\

T

L: 95.15
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standard, you can turn off that ink channel by de-selecting all the Density

patches for that ink. This should only be done where multiple inks of a particular colour are available. For example, if

patch 2 of the Cyan is still colour dense, you can switch Cyan off and use only Light Cyan.

Switching off an ink channel will have effects through the calibration process, in particular, when configuring Ink
Limits. When configuring the ink limit chart, the number of available inks will need to be reduced and the disabled ink

channel should not be used in any of the combinations on the Ink Limit Chart.

Paper Profile Graph

The graph shows the dots selected for each colour. The position on the graph gives a
proportional representation showing where the dot starts to turn on or off, and their
relative proximity to other dots. Turn the individual colour graph plots on or off by
checking the tick boxes under the graph. Hovering the mouse over a point on the graph
displays a tool tip, giving information about the dot.

If a colour is not shown on the graph but the check box is ticked, the dots selected are
most likely a poor choice and may not be valid; or that the ink channel has been turned off
by not choosing any of its dots (Separate Ink Channels only).

Separation Control

M ¥a ¥a

Pager Profie Graph

Me ¥u s VMa ¥ ¥e e

Separation Control displays where a light ink mixes with standard (or heavier) inks within a process ink channel. For

example, the coverage level where Cyan is printed and where light Cyan finishes.

Separation Control is available when the Paper Profile is linked to a Media for a printer that has
light inks enabled and the Treat Light Inks as Separate Channels option is enabled. These

settings are in the output Custom Settings of the Media.

The graph displays the portion of each ink used at ink coverage levels and where the inks start
and cross over. To view individual inks on the graph, click the ink colour checkbox at the
bottom of the screen. Click an ink twice to toggle all graphs on or off. Shift+click to display

selective graphs. Optimal Separation Control settings are determined automatically
(Blackmagic v5.2+). Older Paper Profiles that have not yet been upgraded (via the Upgrade button) have controls

available to adjust the ink mixes.

Serendipity Blackmagic User Manual - Version 5.4

54



Ink Limits

The Ink Limits tab has controls for limiting the ink mix of the channels applied in the Paper Profile. The number of ink
channels varies depending on whether the printer has light inks and whether they are being treated as separate or
combined channels. The window to the right displays a summary of the driver configuration from the selected Media.

Options Consy Poches BRI Separsin Comre
*  Yule Nielsen Number - Set the YN number for the . _
paper being profiled (if known). The default is 2. e e
* Ink Limits - Set the ink limits for the Paper Profile. Powe o = o L
These are determined after printing a chart and BTSN
observing the percentage of coverage at which the ot k=@ 32 [

mixture of inks causes problems. Enter the value for
each ink combination.

¢ Algorithm - Choose the type of ink limiting. There
are three (3) options:

(e]

(e]

s>

uto Custing On
rona

234
H

yoeo
1

Standard - Simple ink limiting based on ink
percentages.

Enhanced - Like Standard, but optimised for variable dot printers. It uses intelligence to calculate the
ink limits based on dots used.

Linear 3.0 - This setting adds the ink coverage for any area then proportionally limits, according to the
ink limit range it falls within. For example, with 3-ink set to 300% and 4-ink set to 400%, if a 6-ink
area of an image has a coverage of 320%, it will limit the area according to the 3-4 ink range.

Linear 4.0 - (Default) This method limits inks based on the number of inks being used for an area. For
example, if 5-ink is set to 390%, any time 5 inks are laid down their coverage will be limited to 390%.
Linear, favour Black - As more ink is laid down and a colour area approaches Black, this method limits
CMY proportionally more than Black, preventing wetness and inversion in shadowed areas.

Lowpass - No limiting is imposed until the coverage for combined number of inks reaches the set limit,
at which point any higher ink coverage is clipped to the ink limit.

Lowpass, favour Black - The same as Lowpass, but favouring Black, limiting it proportionally less than
CMY as colours approach Black.

* Media Information - This side of the screen displays information about the driver and Media configuration
important to the Paper Profile.
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Press
The Press data type is used to emulate the properties of a press for softproofing. Each Press configuration can

be assigned a press ICC profile, dotgain curves, press sheet dimensions, the number of ink keys, ink and paper
characteristics; all combining to produce accurate onscreen softproofs.

The Press can be switched on-the-fly while softproofing to instantly show how a job will look if printed on a different
press or on different stock.

Dimensions

Enter the size of the printable sheet area of the press and its number of
Ink Keys. The Key Width is calculated from these values.

Colour Management
This panel is where the Press ICC profile is assigned, along with any process CMYK, spot colour or device (platesetter)
dotgain curves required to reproduce the colour performance of the press.

Replace Colour Set - Select a Replace Colour Set to be applied.
Press ICC Profile - Select a press ICC. This can be one created on
the press or a printing standard ICC which is used as the target or
match profile.

CMYK DotGain Curves - Select individual C, M, Y, or K DotGain
Curves to be applied.

Specials DotGain Curve - Select a DotGain Curve to be applied to
any special or spot colours.

Device Linearisation Curve - Select a device (platesetter) DotGain

Curve to be applied.
Calcheck Chart - Select a chart to verify the SoftProof’s calibration
status.

Paper Colour - Three (3) options are available:
o None - Do not change the paper colour;
o ICC Profile - Use the white point from the press ICC profile and apply as the paper colour; or
o Custom - Enter your own value for the paper colour. Use a Spectrophotometer to measure the paper
white directly into the configuration.

Ink and Paper
Configure the ink and paper properties of the press to simulate their effects on the screen in the SoftProof application.

Maximum Ink Weight - Enter a value for the maximum ink weight. This value is used by the InkKeyViewer to
show excess ink.

Stretch Factor - Enter a compensation factor to allow for stretch. It can be used for distortion simulation or
anamorphic scaling, where one direction will distort more than the other.

Note: The easiest way to calculate stretch is to draw a rectangle 1m x 1m and print it. Measure the rectangle and enter
the value. If the size is 98cm, enter 0.98. If the size is 102cm, enter 1.02.

Back Page Opacity - Enter a value between 0 and 100%. This controls the amount of show through of the back
page through the front page when reverse page viewing in SoftProof.

Back Page DotGain Curve - Select a DotGain Curve to apply to the back page when using the Show Back Page
option in SoftProof.

Back Page Rotation - Select the relative orientation of back page when using Show Back Page in SoftProof.

Top Page - Choose Even or Odd. This is used to determine which page backs onto which, so the correct back
page is shown when requested.
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Regular Expression
The Regular Expression data type is assigned as a filter to an auto-proofing RIP queue. Here, the user
constructs a set of rules whereby only files with a particular naming structure will be submitted for auto-proofing.

Expressions EtxnveSSgensl ['lgnore items 14 using | all of the following 4]
Similar to the Job Genie, the Expressions (search tasks) are entered IR vach S

. . . . . begins with total
and displayed in the left list. Each expression is made up of one or does not contain brick

more strings used to match or ignore files.

The Expressions are handled in the order they appear in the list. If
the first expression matches a job name and that expression rule is
to ignore items, the job is not passed to the next expression for
further consideration. Expressions can be reordered by selecting
the item and dragging up or down the list as required.

(" Add

( Duplicate )

- \ n y
Delete does not contain ]

List Options
* Add - Adds a new expression to the list.
* Duplicate - Makes a copy of the currently selected expression.
* Delete - Removes the currently selected expression.

Match
Specify what to match and the rules to apply. Enter one or more strings to match and apply different rules to each.

Match options:

* Match Items - Matches the strings entered. If no other expressions exist, the job is submitted for auto-proofing.

¢ Ignore Items - Ignores anything that matches the strings entered. If a job name matches, it is ignored and not
submitted for proofing or passed to other expressions for further matching.

¢ Any of the Following - The match is true if any string match conditions are met. If there are two or more match
strings in the one expression and either of them match a job name, the Match Items or Ignore Items rule is
applied.

¢ All of the Following — The match is only true if all string match conditions are met.

String
Enter the string to match in the text field at the bottom of the screen. This is a job name or part of a job name. The
match depends on one of the following conditions, selected with the string:

* Contains - The job name contains the entered string.

* Begins With - The job name begins with the entered string.

¢ Ends With - The job name ends with the entered string.

* Is-The job name matches the entered string exactly.

¢ Does Not Contain - The job name does not contain the entered string.

* Does Not Begin With — The job name does not begin with the entered string,.
* Does Not End With - The job name does not end with the entered string.

¢ Is Not - The job name is not the entered string exactly.

Match String Options
¢ Add - Adds the match string to the list.
* Apply - Apply changes to the selected match string in the list.
* Delete - Removes the currently selected match string from the list.
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Replace Colour Set

The Replace Colour Set is used to match and replace certain colours as they pass through the system. Match

and replace process or spot colours and choose to match by name or position. Colours can be created directly
or imported from popular desktop applications, or a Special Colour Set.

There are a few uses for the Replace Colour Set. It is used to create a digital = —
blue line, which replaces all colours with varying hues of blue allowing traps ﬁ —_——
to be easily seen. It can also be used for replacing special colours where the ——

name varies, such as Pantone 101C and Pantone 101CVC. ety T = Z

Toolbar Options e

* New Colour - Creates a new untitled colour in the list. Click on , e 3
either the Match Plate or Original name to change it. _ ool

* Delete Colours - Deletes the selected colour/s. e

¢ Duplicate Colours - Makes a copy of the selected colour/s.

* Rename Match - Rename one or more Match Plates using a popup
Find and Replace tool.

* Rename Original - Rename one or more Original replacement |- =2 5 =

colour names using a popup Find and Replace tool.
* Add Colours From Library - Select one or more colours from a Special Colour Set within Blackmagic to be
added to the Replace Colour Set.

Alternatively, this window may be opened by double-clicking on an empty area of the list panel; or double-click
on a selected colour in the list to open the Add Colours window and replace it with the chosen colour.

¢ Import Colours From Files - Import colours from compatible third party applications, CGATS/ISO 12642 files
or previously exported colour sets. N-Colour swatches will not import unless an N-colour ICC profile with
matching process colour channels is first assigned to the Special Colour Set. If CMYK swatches are imported to
an N-Colour set, extra colour channels with 0% values will be added to match the colour space.

* Export Colours To File - Export the colour swatches to a CGATS/ISO 12642 file. If the set contains a mix of
CMYK/N-colour and Lab colours, you will be prompted to export either CMYK/N-colour or Lab colours. The file
standard limits exported colours to one colourspace.

* Export Colour Set To File - Export the entire Replace Colour Set to a file. If the set contains a mix of CMYK and
Lab colours, you will be asked whether to export CMYK or Lab.

* Preview Set - Opens a popup window listing all the Replace Colours in the set with colour properties and
replacement method.

* N-Colour Profile - Assign a multi-colour ICC profile to the Replace Colour Set.

Note: If an N-Colour multicolour ICC profile is assigned to the set, users will have the option to adjust colours in an Lab
or N-Colour colourspace, as defined by the ICC profile (e.g., Lab or CMYKOG). Colours for each Replace Colour Set can
only be defined in Lab and/or a single other colourspace. If no N-Colour profile is assigned, colours are adjusted using
either Lab or CMYK values.

All the Toolbar options can be accessed via the contextual (right-click) menu available in the colour list panel.

Replacement Method Tabs
There are five (5) tabbed panels where colours are created or imported when making a Replace Set. Each tab performs
a specific replacement function.

Tab 1 - Process
Specify any of the Process CMYK colours to be replaced. Each of the process colours listed in the panel has:

* A swatchbox showing the replacement for the process colour (left). Double-click this box to import a
replacement colour;

* An editable naming field for the process colour; and

* A Reset button for the colour of the process plate (lower right) and a Cancel button to switch off replacement
for that process colour (upper right).

Process colour replacement is set to Off for all 4 colours by default.

Tab 2 - Exact
When using the Exact replacement method, only incoming colours precisely matching the Match Plate name will be
replaced with the new colour. Matching is not case sensitive.
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Tab 3 - Partial
When using the Partial replacement method, any incoming colours are replaced with the new colour if any part of the
name matches the Match Plate name. Matching is not case sensitive.

Tab 4 - Position
The Position method replaces any incoming Special colour in a particular plate position with the new colour.

The Exact, Partial and Position panels have a Search box at the top right used for locating colours in the replacement
list. The list itself has a series of sort columns detailing properties of each replacement colour.

Colours can be selected and dragged to another position within the list. This is useful in Position replacement where the
plate position is important.

The order of the columns can be changed by dragging them to the desired location and the headers are configurable via
a context menu. The available columns are:

¢ Match Plate - Shows the replacement colour swatch. The Exact or Partial name in this field is the one to be
matched to the incoming colour being replaced. In the case of Position replacement, the name shows the plate
position. Click on the name to change it.

* Values - Shows the colourspace values of the replacement colour.

¢ Original Name - The original name of the replacement colour in the Match Plate swatch. Click on the name to
change it.

* Space - The colourspace of the replacement colour plate.

* Mode - The Paint Mode of the colour: Overprint, Knockout, Primer, Opaque or Transparent.

* Tint - The tint or intensity of the colour.

¢ DotGain Curve - The name of the DotGain Curve applied to the plate (if any).

*  Weight (g/m?) - The Press Ink Weight of the colour in g/m? (if assigned).

Tab 5 - Remaining
Allocate one colour to replace Special Plates that are not matched by anything else. This only replaces special colours
and not CMYK process colours. This panel has a similar interface to the Process panel.

Colour Adjustment Panel

View and adjust the colourspace values and plate properties of a selected colour. The name of the colour selected is
shown at the top. A window displays the Original colour and Modified colour as adjustments are being made. A
correctly calibrated monitor with an assigned Match ICC profile will display an accurate representation of the colour/s.

Available adjustment options are:

* Colourspace - Choose between Lab or CMYK (or multicolour if an N-Colour ICC profile has been assigned to the
Replace Colour Set). The sliders change accordingly for making adjustments to the Lab or CMYK/N-Colour
values. These can be entered directly or fine-tuned using the up/down arrows.

* Paint Mode - Choose the Paint Mode for the colour. The diagram shows the Paint Mode, Opacity and Tint of the
selected colour. Choices are:

o Overprint

Knockout

Primer

Opaque (adds an opacity % slider)

Transparent

* Tint - Adjust the intensity of the colour by adjusting the slider, entering a tint value or using the up/down
arrows.

* DotGain Curve - Choose a DotGain Curve to apply to the colour.

O O O O

Note: A DotGain Curve applied to a replacement colour takes precedence over global Process or Specials DotGain
Curves assigned to a Pagesetup. The Pagesetup curves are ignored for the colour.

* Weight - Optionally assign an Ink Weight (in g/mZ?) to the selected colour. This weight is used in the
InkKeyViewer (SoftProof) and in Calculate Ink Weights (QueueManager).

* Spectrophotometer - Choose a supported Spectrophotometer to read colour values directly into the Special
Colour Set.

Serendipity Blackmagic User Manual - Version 5.4 59



Driver

This panel is where the driver used to poll and interpret the incoming file format is
selected. The driver must match the type of RIPped file to be polled. Options available in
other sections of the RIP configuration may change depending on the RIP input filter
selected.

RIP

Different RIPs store their files in different formats and in different locations. The RIP data type is used to
configure how and where Blackmagic polls for these RIPped jobs.

Driver

RIP Driver: | TIFF Based RIP (Generic) =)

# Right Reading ¥ Positive

RIP Driver - Choose the RIP driver (input filter) from the list of supported RIPs.
The list of available drivers will depend upon the licenses enabled on the
dongle.

Custom Settings - Depending on the driver selected, there may be specific parameters requiring setup for a valid
configuration. Use the Edit button to set up these parameters.

Polling

Polling is the method used to look for files. The configuration for polling the RIPped files is set up in this section. When
polling, Blackmagic looks in the specified location (defined under Paths) for files matching the RIP driver selected. A list

is compiled and sent back to Blackmagic for display in the RIPMonitor. It takes
three (3) successful polls before a file is shown in the RIPMonitor and the files
must be stable (not changed since the last poll).

The available options are:

_

Highest

Enable Polling - Turn polling on or off.
Poll Interval - Configure how frequently to poll for files. The Poll Interval should be set according to any
specific requirements. Setting the Poll Interval too short can flood the network with polling requests (packets)
causing it to slow down. Setting it too long can take a long time to show stable files ready for submission.

Fast Polling - This will automatically poll two (2) more times as soon as one (1) automatic poll has completed.
It will not wait for the next scheduled Poll Interval before it polls again. Files may appear incomplete in the
RIPMonitor if there has not been sufficient time between polls for a job’s complete set of plates to finish the RIP
process.

Log Statistics - Log the polling statistics in the Server log. The log message reports “Started automatic poll on
<date>" when polling starts and “Completed automatic poll on <date>" when finished.

Ignore Mod Time - Ignore the modification time on the file. Useful for Harlequin RIPs that update the
modification time on the file when moving the job between the Held and Active queues.

Job Genie - Assign a selected Job Genie to the RIP. This options becomes available when using a TIFF Based RIP
(User Configurable), PDF or Postscript input filter. If used, only files defined as valid by the Job Genie will
appear for submission in the RIPMonitor (see the Job Genie section for further details).

Connection
The connection specifies the method used for polling. The options are:

Agent - The most efficient connection method. This option connects to a Serendipity Polling Agent installed on
the system where the RIP files are located.

Localhost - Polls a directory path on the computer where the Blackmagic Server is installed.

FTP - Uses File Transfer Protocol (FTP) to poll and transfer the files from the RIP to Blackmagic.

Secure FTP (SFTP) - Uses Secure File Transfer Protocol to poll and transfer the files from the RIP to
Blackmagic.

File Transfer Priority
This specifies the priority to be used for transferring files from the RIP to Blackmagic. Adjust from Lowest to Highest or
anywhere in between.

Sometimes a high priority can affect the RIP performance, especially on older RIPs. This can cause problems, such as
RIPs pausing. If this happens, reduce the priority level.
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Paths
Specify the paths to the RIPped files residing on the RIP. This may be a single path or multiple paths and can be made
up of striped paths. The path structure is dependent upon the RIP driver selected. The options available are detailed
below.

* New - Adds a new path or stripe path to the Paths field. Selecting this displays another window to type the
path or browse to locate the folder containing the jobs. Browse will only work if the connection method has
been specified and is valid.

* Delete - Deletes the selected paths.

* Delete All - Deletes all paths from the list.

Most RIP drivers use recursive polling, i.e., they will poll down the directory structure into sub directories from the top-
level directory specified in the path. The more sub directories to be searched, the longer it takes. Specify the path as
close as possible to the files for quicker results.

Stripe Paths

Some RIPs place jobs on different drives, but in the same location. They can add more drives to a RIP, giving it a new
mount point, for e.g., E:/RIPJobs, F:/RIPJobs and G:/RIP]Jobs. These all have a common path of RIP]Jobs, but are “striped”
across 3 drives, therefore specify the drives (E:, F: and G:) in the Stripe Paths and the path (/RIP]Jobs) in Paths.

Note: This is important for RIPs sharing plates from single jobs across multiple drives, for e.g., Cyan & Magenta on E
drive and Yellow & Black of the same job on F drive. If this is not setup as a stripe, the plates will not be stitched
together.

AutoProofing

Jobs can be submitted manually from the RIPMonitor as desired. Alternatively, configure the RIP to have jobs submitted
automatically via the AutoProof facility. This way any new job that appears, if stable and meets the specified criteria,
will be submitted for processing. The options available are listed below.

¢ Enable AutoProofing - Turns AutoProofing on or off.
* Printing - Specifies how the jobs are to be printed. Options are:
o Copies - Specify the number of copies to be printed. Default is 0.
o Use Pagesetup - Print to the selected Pagesetup.
o Use Pagesetup Pool - Print to the selected Pagesetup Pool.
o Choose - Select an existing Pagesetup or Pagesetup Pool. The chooser allows you to create a new one if
necessary.

Criteria
Select certain conditions that must exist before a job is automatically submitted. The options are:

* Delay (seconds) - The length of time to wait to see if a job changes prior to submitting. A job may change as
other plates are RIPped and added to the job. A suitable amount of time needs to be specified in order to
ensure a complete job is submitted.

* Minimum Plate Count - Specify a certain number of plates that must exist before a job is submitted for
AutoProofing.

¢  Must Have - Select which process plates must exist in the job before AutoProofing.

* Filter - Select a filter to use for AutoProofing. See the Regular Expression section for further information on
Filters.

* Delete Jobs From RIP After AutoProofing - Delete jobs after a successful AutoProof. This is only available when
jobs are locally hosted (Localhost polling). This may be used when a temporary file is created, for example,
when adding halftone dots to unscreened data.

* Hold After Imaging - Places the job on hold in the Rendering queue after imaging has successfully completed.

* Hold After Rendering - Places the job in a held state in the Output queue after rendering has successfully
completed.

Job Filtering
This is only available when the RIP driver is set to poll imposition RIPs. Specify if AutoProofing should be carried out on
All Jobs or just Imposed Jobs.

Testing

Once the configuration is complete, it must be saved before a test can be done. If it is not saved, a prompt will appear to
“save and test”. A test poll checks RIP connection, Path validity and job presence. Messages appear in the window to
alert you to any problems or give confirmation of a valid configuration.
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Signature Group D
Import or create groups of Signatures, defining the page,

files can then be submitted for de-imposition from the RIPMonitor and
separated during processing into smaller groups or individual pages to
fit the printer, or to view a publication in its intended form.

panels used to configure the Signatures. A display panel shows the

The interface has a toolbar with various options and a series of five (5) — I
layout of the selected signature(s) to the right. |

Toolbar Options

sheet and size parameters of press impositions. The imposed

Group - Groups two or more pages together. Pages must be the -

same size and alignment. The Group button is only available
when valid pages are selected.

Ungroup - Ungroup a group of pages. Only available when a group is selected.

Suppress Pages - Suppress the selected page or pages (marks it as not for print).

Auto Paginate - Automatically allocates page numbers to the signature. This will include any page currently
suppressed.

Offset Page Numbers - Offsets the selected page numbers by the desired amount. Enter the offset value to be
added to or subtracted from the page numbers.

Edit Page Numbers - Edits the page number of those selected. Tab moves to the next selected page. The page
numbers can also be edited by clicking on the page.

Pair Pages - Automatically pairs the pages along the long sides. The pages must match, the headers must be in
the same position and they must be joined (no gaps). If there is a gap, the manual pair option must be used.
After pairing use the Close Page Number Gaps option if needed. See below for further information.

Pair Pages Horizontally - Pairs pages in the horizontal direction.

Pair Pages Vertically - Pairs pages in the vertical direction.

Rotate Selected Signatures - Rotates the selected signatures by the amount chosen. The options are:

o 90 Degrees Clockwise

o 90 Degrees Counter Clockwise

o 180 Degrees
Rename Signatures - Selecting this displays a rename box to search for and replace names. Options are:

o Find - Enter the characters to find in the list.

o Replace With - Enter the text to insert in place of the characters found. Use any valid characters,
including spaces. If nothing is entered, the characters found are deleted if one of the rename options is
selected.

Ignore Case — Choose whether the match is case sensitive.

Wrap Around - Continue from the top of the list when the bottom is reached.

Rename All - Rename all items that are found.

Rename Selected - Rename the selected signatures if the characters are found.

Rename Current - Rename the currently selected signature if the characters are found. If more than
one signature is selected, the first one in the list is checked for a match and renamed if true.

o Find Previous - Searches backwards.

o Find Next - Searches forwards.

o Prefix With/Append - Two options to add characters before or after the names.

Import Signatures - Import a signature made by another application. The available types are:

o DynaStrip - Files are usually named with a sheet number and a .dsf extension.

o Preps - Files are Prep Templates.

o Krause - Files usually end in a number, such as jobname.001.

o ]DF - Files usually have a .jdf extension.

o Facilis - Files are usually named with a .dai extension.

Selective Import - Enable this to choose or alter any/all Signatures from the source file prior to import. The
following options are available:

o Group Pages - Group the pages together as they are imported. The pages must be the same size and
align for grouping. The diagram shows a pink line around individual pages when they are not grouped
or around all pages when they are grouped. Pages must group for pairing to work.

o Inclusive - This option attempts to group pages with parameters/alignments differing by very small
amounts.

o Rotation - Choose to rotate the signatures during import.

o Offset Page Numbers - Offset the page numbers of those signatures imported by a number.

O O O O O
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Imported ]DF files generally need to have the Offset Page Numbers set to 1, otherwise the first page
will begin at 0. This can be changed after import if necessary.
Top Align / Left Align - Optional ways of viewing the interface, depending on the display and preferred layout.
Close Page Number Gaps - Use this to close the page numbers after pairing. When pairing a large publication,
the lowest page number of the pair is used as the resultant paired page number. This usually produces gaps in
the page numbers. Close Page Number Gaps closes the gaps so pages are sequential.
Import Language Encoding - Select the appropriate language encoding for the signatures so the names can be
displayed correctly in the native language. This is set from the contextual menu (right click).

Signatures Signatures
This panel lists all of the Signatures in the group. The Plate, Sheet, Grid and Page options for = [
the selected Signature are shown in the configuration panels on the screen. 2282
4-61

Signature Options: b:

* New - Creates a new untitled signature.

* Delete - Removes the selected signatures from the list. o oo

* Duplicate - Makes a copy of the selected signatures. Dupiicate

Signatures can be multi-selected or dragged and dropped to another position in the list (for de-imposition purposes).
When multiple Signatures are selected, all will be shown in the display panel. The Plate (if in use), Sheet and Pages
settings can be edited to make mass changes to all selected Signatures.

Display Panel
Signatures selected from the list are displayed in this panel, with all Plate, Sheet and layout properties as defined in the

configuration panels visually represented. If multiple signatures (or pages) are selected, differing parameter values will
be shown by bold, underlined field titles in the configuration panels.

The display panel is interactive and is used to:

* Select one or more individual “pages” within a signature for editing | e inporiion) iogéritont
in the Pages panel; e E4 E4
* Select pages for grouping or ungrouping, pairing, or page offset; -}:xb- E’“ﬂ i’*,.a

* Show where pages of multi-selected signatures fit within a
publication in a bottom Page Navigator panel. Pages belonging to | = = eensd s

the signatures are shown in green; pages from non-selected e e
signatures are shown in red; doubled-up pages are shown in purple. et e

Selecting all signatures makes it simple to check the integrity of the
Signature Group. Y ) ) ) T B
+  Select a page from the Page Navigator to highlight which signature it [ 2 2 © @ @ o « & « o « o o
belongs to.

When viewing multiple signatures, the thumbnail sizes can be increased or decreased with the cmd+/- keys (Mac) or
ctrl+/- (Win).

Plate
Turn the Plate options on or off by selecting the Use Plate tick box.

The Plate settings are:

*  Width

* Height

Centre Offset - The value to offset the centre by. This is dependent upon the gripper position.
¢  Gripper Size

¢ Gripper Position

The plate width and height will alter the press Sheet size if the plate size is larger. If the plate size is smaller, the press

Sheet size is not affected. A plate size larger than the sheet size will appear with a red line outline within the signature
preview panel.
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Sheet
Enter the dimensions of the press sheet in this panel. The options are:

*  Width
* Height
¢ AutoFit - Changes the press sheet size so the pages fit.

Grid
This panel is where the grid of pages that make up the imposition signature is defined or edited. The options are:

* Xand Y Position - This sets the top left position of the selected group or page in respect to the top left of the
press sheet.

* Page Size - Select the size of the single page selected from one of the pre-set page sizes or choose Custom.

* Page Width - Enter the width of the single page selected. The pre-set page sizes automatically complete this

field.

* Page Height - Enter the height of the single page selected. The pre-set page sizes automatically complete this
field.

¢ Orientation - Select the orientation of the selected page between [ea
Portrait or Landscape. x 00 mr ¥ foomm

¢ Columns - Enter the number of columns for the signature. v

* Rows - Enter the number of rows for the signature. p,:,‘,;m

* Gutter X and Y - Enter the size of the gutter for the signature. If a gap is R
selected first, the value is applied to the selected gutter only. To apply a e . :
value to All, Even or Odd, select it from the pull down menu first and s o o |
then enter the value. Press Enter to apply the value. Cuter ¥ 00 mm Now )

* Delete - Deletes the selected pages or groups. Deee Dughese e

* Duplicate - Duplicates the selected page or group. This is positioned at
top left (X=0, Y=0).

* New/Place - Creates a new page or group. Selecting this changes the button to Place. Enter the page attributes
as desired and click Place to position the page or group. Press Esc to cancel.

* Number - Enter the page number of the selected pages.
* Top Bleed - Enter the amount of top bleed to apply to the selected pages.
* Bottom Bleed - Enter the amount of bottom bleed to apply to the selected pages.
* Left Bleed - Enter the amount of left bleed to apply to the selected pages.
* Right Bleed - Enter the amount of right bleed to apply to the selected pages.
* Page Head - Select the position for the head of the currently selected pages. The diagram shows the change.
The page head is indicated by a line and folded corner. Choose between:
o PageHead Up
Page Head Down
Page Head Left
Page Head Right

O O O
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Special Colour Set

Blackmagic uses special colour sets to identify and match colour plates when jobs are polled and processed.

Special colours can be created manually, or imported from one of several popular applications. A library of
sets can be built up for use in different proofing situations.

Colours can be created in Lab and a CMYK or N-Colour colourspace, read directly into the system using an online
Spectrophotometer, or imported from a CGATS file. Each colour can have its ink Paint Mode or Press Ink Weight set and
have an individual DotGain Curve assigned to it.

The interface includes a Toolbar with general creation and import
options; a panel showing the list of colours in the Special Set; and
another to adjust the properties of a selected colour.

Toolbar Options

¢ New Colour - Creates a new untitled colour in the list.
Click on the name to change it.

¢ Delete Colours - Deletes the selected colours.

* Duplicate Colours - Makes a copy of the selected colours.

* Rename Colours - Rename one or more colours using a
popup Find and Replace tool.

* Add Colours From Library - Select one or more colours
from any other Special Colour Set created within
Blackmagic.

¢ Import Colours From Files - Import colours from
compatible third party applications, CGATS/ISO 12642
files or previously exported colour sets. N-Colour
swatches will not import unless an N-colour ICC profile
with matching process colour channels is first assigned Bhanaia 8 (oo
to the Special Colour Set. If CMYK swatches are imported
to an N-Colour set, extra colour channels with 0% values will be added to match the colour space.

¢ Export Colours To File - Export the colour swatches to a CGATS/ISO 12642 file. If the set contains a mix of
CMYK/N-colour and Lab colours, you will be prompted to export either CMYK/N-colour or Lab colours. The file
standard limits exported colours to one colourspace.

* Reorder swatches - Change the order of the colour swatches as they appear in the list.

Note: Swatch order can be important as a Pantone plate being matched from a number will be assigned the
first colour when matching the number in the set list.

* N-Colour Profile - Assign a multicolour ICC profile to the Special Colour Set.

'9999900999999999999999909999999992F

Note: If an N-Colour multicolour ICC profile is assigned to the set, users will have the option to adjust colours in an Lab
or N-Colour colourspace as defined by the ICC profile (e.g., Lab or CMYKOG). Colours for each Special Colour Set can
only be defined in Lab and/or a single other colourspace. If no N-Colour profile is assigned, colours are adjusted using
either Lab or CMYK values.

All Toolbar options can be accessed via the contextual (right-click) menu available in the colour list panel, as well as:

ano Present Colour

* Print - Prints the colour list of the Special Colour Set, with colour swatches and details for
each colour (see below).

* Print and Match Colour - Make adjustments to a selected special colour using printed
swatch charts with variations of the colour.

* Present Colour - Opens a resizable pop-up window displaying the selected colour along
with its set and colour names. This option is useful for visually matching softproof special erendpty secls
colours on screen.

*  Print Swatch - Print user configurable colour swatch charts of Special Colour Sets. See below section for futher
information.

Colour List Panel
This panel has a Search box at the top right for locating colours in the set list. The list has a series of sort columns,
detailing properties of each special colour.

The order of the columns can be changed by dragging them to the desired location and the headers are configurable via
a context (right click) menu. The available columns are:
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Colour - Gives a visual representation of the colour.

Name - The colour plate name (used to match the colours). Click on the colour name to change it.
Space - The colourspace of the plate.

Values - Shows the colourspace values of the colour.

Mode - The Paint Mode of the colour (Overprint, Knockout, Primer, Opaque or Transparent).
Tint - The tint or intensity of the colour.

DotGain Curve - The name of the DotGain Curve applied to the plate (if any).

Weight (g/m?) - The press Ink Weight of the colour in g/m? (if assigned).

Double-clicking on an empty area of the list panel will open an Add Colours To Library window, allowing for colours to
be added to the set. Double-clicking on a selected colour in the list will open an Add Colours From Library window to
replace it with a chosen colour.

Colour Adjustment
View and adjust the colourspace values and plate properties of a selected colour.

The name of the colour selected is shown at the top. A window displays the Original colour and the Modified colour as
adjustments are made. A correctly calibrated monitor with an assigned Match ICC profile will display an accurate
representation of the colours.

Available adjustment options are:

ColourSpace - Choose between Lab or CMYK (or multicolour if an N-Colour ICC profile has been assigned to the
Special Colour Set). The sliders change accordingly for making any adjustments to the Lab or CMYK/N-Colour
values. These can be entered directly or fine-tuned using the up/down arrows.
Paint Mode - Choose the Paint mode for the colour. The choices are:

o Overprint
Knockout
Primer
Opaque (Adds an Opacity % slider)
Transparent
Tint - Adjust the intensity of the colour by adjusting the slider, entering a tint value, or using the up/down
arrows.
DotGain Curve - Choose a DotGain Curve to apply to the colour.
Note: A DotGain Curve applied to a special colour has precedence over global Process or Special DotGain
Curves assigned to a Pagesetup. The Pagesetup curves are ignored for the colour.
Weight - Optionally assign an Ink Weight (in g/m?) to the selected colour. This weight is used in the
InkKeyViewer (SoftProof) and in Calculate Ink Weights (QueueManager).
Spectrophotometer - Choose a supported Spectrophotometer or file fomat to read or import measured values
directly into the Special Colour Set.

O O O O

Print and Match Colour

Match Chart Panel ——

Print and Match Colour is a tool used for visually matching special TS pr———————T e
colours used in proofing to original print material, accessed via a
button in the Special Colour Set toolbar.

The window has two (2) main panels - an upper Match Chart panel
and a lower Colour List panel.

The upper panel displays three (3) swatch charts comprised of
variations of the colour selected in the Special Colour Set. The
selected (target) colour is the centre colour of the middle chart (chart
2).

Any of the 27 patches can be selected to save as a new special colour,

to save over and replace the originally selected colour, or set as the I:'
target (centre) colour for printing a new swatch chart set.

Variation - Controls the level of variance the swatch chart colours have from the
original colour. Variation value steps in 0.5 increments from 0.5 to 10. The units
represent L*, a* and b* variations from the Lab value of the original colour. Use the slider, up/down arrows, or
type in the text field to change the current variation.
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* Set Target - Sets the currently selected colour patch as the Target (centre of chart 2). Swatch chart colours will
change to variant colours of the new Target colour.

* Print Match Chart - Prints the three (3) swatch charts displayed in the Match Chart panel for visual matching
with original print/press material.
Note: The 3 swatch charts are printed as individual jobs and can be nested to save paper (see Output -
Nesting). Charts should be oriented with the bars and text to the top for patch selection. Charts may not be
nested in order so take note of the (1, 2, or 3) bars when selecting a patch in the interface.

Colour List Panel

The lower panel has two (2) tabs - Variations and Colour.

Variations Tab

This tab list includes a Colour Patch and Lab values for the original (Target) colour and the 26 variant colour patches.

A colour selected in the Variations list will be highlighted by a box in the Match Chart panel. A colour selected in the
Match Chart panel will be highlighted in the Variations list.

Colour Tab

This tab fills the panel with the currently selected colour variant. This option is useful for visually matching softproof
special colours on screen.

* Save - Saves the currently selected Target colour (centre of Chart 2) over the original special colour, replacing it.

¢ Cancel - Cancels the Print and Match process without saving, closing the window.

* Save As - Saves the currently selected Target colour (centre of Chart 2) to the set as a new special colour. Enter a
name for the colour and click OK. Default name is that of the original colour followed by an asterisk (*).

Print Swatch

Print user configurable colour swatch charts of Special Colour Sets. All swatches are processed as individual spot plates
as they would be when included with a normal job allowing users to see how a spot colour will print to a particular
Media.

Colour Swatches print at a size and spacing determined by the user, the name of the colour (and optional Lab or device
values) are printed below each patch. The following fields are available to configure the swatch chart:

* Patch Width - Enter the printed width for the colour patch.

¢ Patch Height - Enter the printed height for the colour patch.

* Include Colour Values - Enable to print colour Lab or device values below each colour patch. A larger vertical
spacing value may be required to accommodate the additional text.

* Horizontal Spacing - Enter the horizontal spacing to apply between each patch.

* Vertical Spacing - Enter the vertical spacing to apply between each patch.

* Margin - Enter a value for the margin to be left around the printed swatch charts.

* Patches Per Row - Enter the number of patches to be printed on each row of the chart.

* Patches Per Page - Enter the total number of patches to be printed per chart “page”. A multiple of the patches
per row is recommended. Each page is submitted as a separate job and is able to be nested. Multi-page charts
are grouped into publications in the QueueManager.

* (Cancel - Cancel the print swatch operation saving any settings entered.

* OK - Send the swatch chart to the Submit Pagesetup/Media popup window for printing based on the settings
entered.

Note: As all colour patches are processed as individual spot plates, for large charts users can speed up imaging and
rendering times by submitting charts as multiple pages (jobs) rather than a single, large job.
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Screen Printing

The Screen Printing functionality within the Media data type is designed for printing film separations on an Inkjet
printer.

Files submitted for processing are separated into individual plates. Each plate is printed as a black separation with a
halftone dot applied at the colours respective screen angle.

Printing to film generally requires the output density to be higher than that for normal proofing. Higher densities are
achieved by increasing the print resolution, or by assigning one or more inks to be laid over the black dots.

Configuration

The configuration is very similar to a standard setup to print to a device. The Output configuration is the same and the
appropriate Media and Pagesetups are created to control the page parameters. A very basic Paper Profile and
Linearisation are also created to complete the setup.

Output Configuration
The Output for the printer is set up normally.

An Output Driver is assigned; Destination Driver selected; and Collating options are enabled (if required). Once the
Output is created, the Media configured for screenprinting (see below) should be assigned so only screen print
separations will print to the film.

Media Configuration
*  Output Driver - Select the driver as set up in the Output created for the screen printing configuration.
* Resolution - Choose an appropriate resolution.
A higher density can be achieved with a higher resolution, however, it is slower to process and print. A lower
density may produce sufficient density, depending on the printer and media used.
* (Colourspace - Select CMYK
If using the Black Ink Combination only, choose Gray as the Colourspace, as this may result in slightly faster
processing. However, in this mode inks cannot be mixed to produce a denser output. Selecting CMYK and
configuring a Paper Profile will allow the choice to use Black only of a mix of colours at a later stage, without
having to recreate a Paper Profile.
* Custom Settings - Select the appropriate media, choose Uni-directional or Bi-directional and turn the Use Light
Inks option off.
Bi-directional is faster but may produce slight banding or may not be as dense as printing Uni-directionally.
Using Light Inks will affect the patches in the Paper Profile. In Screen Printing mode, only one patch can be on
per colour.
* Screen Printing - Enable Screen Print Mode and select Black for the Ink Combination (and any others
required).
Once this option is selected, jobs submitted to this Media will always be separated and printed using the
selected colours. One or more inks must be selected from the available choices. If Gray is selected as the
Colourspace, only Black will be shown as a choice.
*  Output Screening - Select Halftone and tick the SuperCell option. Choose the preferred dot shape and enter the
screen angles and rulings.
SuperCell gives a better-shaped dot and the round dot tends to be more commonly used. The default angles of
15, 45, 75 and 90 are shown by clicking the Defaults button, however, these can sometimes produce
undesirable effects, mostly caused by the Yellow plate. To counteract this, offset all angles by 7.5 degrees to
make them the following:
o Cyan-22.5 degrees
Magenta - 82.5 degrees
Yellow - 97.5 degrees
Black - 52.5 degrees
Special - 52.5 degrees

O O O O
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Paper Profile Configuration
In Screen Printing mode only one patch can be turned on per colour. Therefore, the value for the patch does not matter
- which one chosen does.

For a variable dot printer, when the Use Light Inks option is turned off, there will be || e
four (4) patches for each colour. The first patch represents the media and the other L: 100.0 x/n\ozx JELTRIN] L 16.00
three the dot sizes (small, medium and large). A dot size for each colour must be 1 2

chosen. If the Colourspace is Gray, Black will be the only available ink.

/

7 | N
; 70}6\ £55.0
7

The image here shows an example using the patch 4 of Black and patch 2 of each Cyan, 2 2 W7 7]

Magenta and Yellow. There is no need to measure the value for the patches, the default L 100.04 IPEPRTA |1 65.33| |1 48.0

values are sufficient. Comparative densities are not relevant when only using one dot 7 2 / P
L: 100.00 L:96.34 >92§\

L: 100.00

(patch).

89.02,

In testing it was found that a combination of large Black (patch 4) and small Magenta

(patch 2) produced good results. If too much is used, for example - large Black, large Cyan and large Magenta - the
result is wet output and the dots tend to “fill in” the shadow area. Large dots of a colour like Cyan will produce film
looking blue instead of black. Black should always be the dominant colour.

Ink Limiting
There is no need to enter any Ink Limiting as the plates are separated, so there is no mixing of 2, 3 and 4 inks.

Linearisation
As Screen Printing mode prints only Black separations, the creation of a simple Linearisation (Gradation) Curve to be
applied to the Media is all that is required.

The Linearisation Curve can be created in one of two ways:
Method 1. Using the Lineariser application and a supported Spectrophotometer:

1. Open the Lineariser application.

2. Select the Media used for screen printing and print a chart for the Spectrophotometer to read. Only the Black
channel patches will be printed and measured.

3. Measure the values using a connected instrument and save the chart.

4. The linearisation curve will be automatically assigned to the selected Media. Check this by viewing the Media in
the Workbench to make sure the curve is assigned to the configuration. See Applications > Lineariser for more
information.

Method 2. Manually Creating a Linearisation Curve:

1. Select the Gradation Curve data type in the Workbench.

Create a new Gradation Curve, selecting the screen printing Media to be used.

3. Edit the Gradation Curve by selecting the Black curve. Click on the curve and drag it to the desired shape,
adding more curve points if required.

4. Save the Gradation Curve.

5. Select the screen printing Media in the Workbench and assign the Gradation Curve using the Linearisation LUT
button in the Colour Correction panel.

N

Summary

The above is a guide to configure a setup to print film separations for use in the Screen Printing industry. Run some test
jobs to choose the most suitable patches, ink combination and resolution for the device and media being used. If a
different resolution or colourspace is selected or the light inks are used, a new Paper Profile will need to be created.
Trying different dot sizes will mean adjustment of the Paper Profile - changing which patch is turned on in each
channel.

During the testing period many combinations of ink (colours), dot sizes and resolution were tried. Different output
devices and media will produce varying results, so a combination of patches and ink mixing may work better. The
higher resolution (1440dpi) produced the most dense output at around 4.18D, but takes longer to RIP and print. By
running at a lower resolution (720dpi), the jobs processed quicker but the density drops to just under 3 at around 2.8D.
This is often acceptable for many applications, but will vary depending on the media and device used. Testing will prove
the most suitable setup. The most commonly used settings were CMYK colourspace, with an ink combination of Black
and Magenta. This used the large Black (dot 4) and the small Magenta (dot 2) in the Paper Profile and gave a slight
reddish tinge to the Black, which is desirable in the Screen Printing industry.
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Modules

Modules are informational windows used for managing jobs as they pass through the system and to monitor Server and
Client activity. Modules are arranged and utilised in a pre-configured format in the Jobs application; are able to be
added and configured to a tabbed window as part of a Monitor layout via the Layout menu; or started up individually as
standalone windows from the Module menu.

There are twelve (12) modules to choose from:

BookMonitor - Similar to the RIPMonitor, this module displays a list of Books compiled via the Bookfilter. This
module is only available in Veripress and the Blackmagic Softproofing Add-on.

ClientLog - Displays a log of Client messages that may be generated during normal Client operations.
ClusterStatus — Monitors the progress of Imaging and Rendering tasks on the Server and any active Cluster
Nodes.

DropZone - A place to drag and drop files for processing.

MediaStatus — A window showing the current calibration status of a Media data type and a progress bar
showing the amount of media (e.g. Paper) used.

QueueManager - View and manage jobs after they have been submitted for processing.

QueueStatus - A progress meter showing the current status of active jobs on the selected queue.

RIPMonitor - Displays the files polled using RIPs configured under the RIP data type within the Workbench.
ServerLog - Displays any system, error and polling messages from the Server.

Status - Shows the disk status (usage) of the Server processing areas.

Thumbnail - Displays a thumbnail of jobs as they image or render.

VirtualPress - Available within the RIPMonitor module. Allows for the assignment, alteration and management

of plates to polled RIP jobs.
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BookMonitor

The BookMonitor module (available for Veripress/Blackmagic Softproofing Add-on) displays the publications polled
from planning files using the BookFilter data type. The publications can be expanded to show a list of pages and
filenames associated with each page.

The module allows for quick viewing of large multi-section or multi-edition publications, such as newspapers. When
View Original, Rendered or FlipBook are selected for a publication in the BookMonitor, it searches the chosen queues in
the QueueManager for filenames matching those in the page list and assembles them on-the-fly for proofing in the
SoftProof or FlipBook applications. The Page Navigator in both applications (SoftProof & FlipBook) will show any pages
missing from the publication (those that have not yet arrived from the RIP).

Toolbar Options i o e P B s
* Expand/Collapse Books - Expand or Collapse the selected Books oot >
(publications) to list individual pages. Double-clicking a |
publication in the display panel will also expand/collapse the |« —

page list.

* Poll - Poll the selected BookFilter for any planning files. Once
polled, a list of the available planning file publications will be
displayed.

* Toggle Bookfilter Polling - Enable / Disable

¢  Show BookFilter Menu - Enable / Disable a dropdown menu.

* Show Bookfilter List - Enable / Disable

¢ View Original - Opens the Imaged Preview of the selected
publication in SoftProof.

¢ View Printed - Opens the Rendered Preview of the selected publication in SoftProof.

* View FlipBook - Opens the selected publication in FlipBook.

* Queue Order - Select this to choose the Output queue in the QueueManager the Bookfilter will search for
matching Imaged or Rendered job pages.

* (Calculate Ink Weight - Open the Ink Weights calculator window for the selected publication.

Note: Books (publications) can be opened in one of two ways. Selecting the Book title, then View Original/View
Rendered will open the Book at the first available page. Expanding a Book, selecting a specific page, then View
Original/View Rendered will open the Book at the chosen page.

View Options
The following sort columns can be selected using the contextual (right click) menu on the sort column header bar in the
Display panel:

¢ Name - The name of the Publication / Page sourced from the planning file.

* Section - Lists the section part of a page as defined in the Bookfilter JobGenie (optional)

* Page - The page number of the page file as defined in the planning file.

¢ Date - Date / Timestamp of the planning file

* Date of Issue - The publication date of the publication/page as defined in the planning file.

The order of the columns can be changed by clicking and dragging them to the desired position, or by using the
Configure Headers option under the contextual (right click) menu. The columns can be manually resized by dragging
the header divider bar to the desired width, or resized to fit content by double-clicking the divider bar.

The contextual menu also has options to Edit BookFilter, change the Colour Scheme of the BookMonitor window, pick
Font Options and choose the Language Encoding of the incoming poll data.
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ClientLog
The ClientLog displays any messages that pop up during normal Client [ — —
operation. There are different levels of message, from informative to e e et :
serious errors. All messages are held for a user-determined length of
time.

* Fetch back log - Displays the log for the time specified. For
example, it retrieves and displays the last 4 hours of messages.
Choose the time from the pull down list.

* Trim older lines - Trims the log based on the time selected in
Fetch back log. If this is set to 60 minutes, the log file is trimmed
back so only the last 60 minutes remain.

* Export - Allows you to export the log to a file.

Note: When you export the log file you can choose to export everything in view or select entries to export. Use the
filtering options and Fetch back log choice to limit the view before exporting. Selecting export displays a chooser,
allowing you to enter a name and select the location to save the file. You can choose to save the file as html or as a tab
delimited text file.

Filtering Options
You can choose which messages to display in the log and which to hide by ticking checkboxes for one or more of the
following filters. All messages are saved to the log, even if filtered.

* Question - Used for messages that ask questions, for e.g., “Job contains unassigned colours. Do you want to add
them to VirtualPress.”

* Information - Used for messages that tell you something, for e.g., “Job has a duplicate plate.”

*  Warning - Used where the message has a higher importance and (usually) the Client failed to do something,
but operation can continue, for e.g., “Failed to save new password. Old password will continue to be used.”

¢ (Critical - Used for serious errors that will most likely affect operation, for e.g., “Failed to load rendering .dll.”
You will normally be required to take action to rectify these errors before continuing.

* Search - You can search the log for jobs or messages. Enter the text of characters you want to search for and
the ClientLog only displays the lines that match the search.

Display Options
The following sort columns can be selected using the contextual (right click) menu on the sort column header bar in the
log:

* Type - The level of the message reported. For e.g., Question; Information; Warning or Critical.

* Date - The time the message was reported.

* Source - The module or application that reported the message.

* Summary - A summary of the message that was reported.

¢ Command - Internal command used to communicate messages to and from the Server by the Client.

* Error - An error code reported by the Server. This is useful for de-bugging problems.

* Action - The action taken by the user relating to the message. For e.g., the button pressed when the message

popped up.

The order of the columns can be changed by clicking and dragging them to the desired position, or by using the
Configure Headers option under the contextual (right click) menu. The columns can be manually resized by dragging
the header divider bar to the desired width, or resized to fit content by double-clicking the divider bar.
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ClusterStatus
The ClusterStatus is a monitor allowing you to see the current Imaging and Rendering status of jobs on any active
Master Servers or Cluster Nodes:

®O00 d — swdevel ipity-software.com.au:9100 - De...

¢ Clustering - Open the Clustering application to manage the
Cluster. TR e AR

*  Refresh - Update the status. i e e

* Increase Inset (+) - Increases the gap between the list items.

* Decrease Inset (-) - Decreases the gap between the list
items.

* Font Options - Allows you to change the size of the text.

DropZone

A DropZone is a place where you can drag and drop files for processing. The user selects Pagesetups, Pagesetup Pools
or the Studio application Asset queue to add to the DropZone as a DropSpot. These DropSpots accept the same file
formats as the DropFolder (Postscript, PDF, JPEG, TIFF Image, Serendipity Blackmagic Image, EPS, PNG, PSD).

The available contextual menu options are:

A NN Droplone - wdevel, pity-software. 9.

* Add DropSpot - Select one or more Pagesetups/Media to add to the
DropZone. Selecting this displays a chooser window, showing all available

Pagesetups/Media. o .o 4
* Add Asset DropSpot - Adds a DropSpot for the Asset queue. Assets are = e

then manually laid out, nested and printed using the Studio application o

(See Applications - Studio for more information). Aose

* Reorder DropSpots - Displays a reorder window. Select one or more
DropSpots in the list and drag them to a new location, or use the up and
down arrow keys to move the position. Click OK when finished.

* Increase DropSpot Inset (+) - Increases the size of the DropSpot.

* Decrease DropSpot Inset (-) - Decreases the size of the DropSpot.

* Font Options - Allows you to change the size of the text.

Additional contextual menu options are available for individual DropSpots:

* Remove DropSpot - Remove the selected DropSpot.

* Edit Pagesetup - Allows you to edit a section of the selected Pagesetup, all sections or create a new one.
* Edit Media - Allows you to edit a section of the selected Media, all sections or create a new one.

* Change DropSpot - Allows you to change an existing DropSpot.

* Set Copies - Set the number of copies for every job dropped on the zone.

¢ Set Colour - Selecta colour from the list for the currently selected DropSpot.
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MediaStatus
The MediaStatus module has two (2) functions:

1. To show the current calibration status of a selected Media data type.
For the calibration status to be shown or updated for a Media, it must have been Calchecked using the Calcheck
Media menu option (see below) or the Check Media option in the Calcheck application.
2. To show how much of the media (e.g. Paper) has been used.
A meter is displayed graphically, detailing the percentage used. For the Usage meter to function, values for the
Media Length or the number of sheets loaded must be entered ——— -
in the Output section of the Media data type.
& Epsonll880-FograProof-720dpi copy
Each Media displayed in the MediaStatus window has the following Used 9.47 m of 0.00 mm (%) T
lnformatlon. Logged Period: 9/12/09 3.33 PM - 12/05/10 4.46 PM
Printed: 22 Jobs (7.99 m?)
¢ Media Name BRI ae | an | ac =
* Calcheck Status - Toggled via the Calcheck Info option (see Epson11880-FograProof-720dpl copy 10/12/09 11:00 AM
below). Displayed as one or more Ticks/Crosses to the right of P
the Media name, showing a Calcheck Pass or Fail against the Moty 0% /
user-defined AE, AH, or AC. Hover the mouse over each to R i e
show a tooltip displaying the AMax and AAvg values. i o Maximurm e
e Usage Meter - Bar showing the amount of media used. Text L
under the bar states the exact amount used as a percentage of e S th

the total units.

Reset Counter - Resets the usage count for the Media.
Logged Period - Time period (date and time, from and to) the Media has been tracked since the last reset. This
information is shown/hidden using the Show Extended Info option.

Printed - Number of jobs and total printed area of jobs tracked since the last reset.

Calcheck Info - Displays the complete Calcheck summary information for the selected Media resulting from the
last Calcheck. Includes the Calcheck Chart used, internal Calcheck score, Date/Time of Calcheck and Avalues.

A contextual (right click) menu has the following options:

Change Media - Change the selected Media for display in the status window.

Edit Media - Edit all or part of the selected Media. Copy it, or create a new one.

Calcheck Media - Opens the Calcheck application. Once a chart has been printed and measured, the results are
saved to the Media and the Calcheck Info for the Media is updated in the MediaStatus window.

Media Order - Allows you to configure which queues are viewed by the MediaStatus window. Move Media
between the Available and Showing columns in the popup chooser.

Show Extended Info - Show/Hide the Logged Period and Printed information for the selected Media.

Show Calcheck Info - Show/Hide the full Calcheck Info summary for the selected Media.

Metric Units — Toggle between Metric or Imperial units for measurements shown in the MediaStatus window.
This is enabled by default.

Increase /Decrease Status Width - Increase or Decrease the width or all Media panels in the window.

Font Options - Allows you to change the size of the text in the window.
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QueueManager

The QueueManager displays information about submitted jobs and the jobs’ current status. Queues can be viewed
simultaneously, showing job progress through Imaging (where the incoming file is interpreted and its resolution
sampled for conversion to the print resolution); Rendering —

(where colour management, cropping, rotation and effects are > B s N
applied for printing); and Printing. — a—

The QueueManager also allows jobs to be manipulated in a
number of ways, such as holding, promoting, deleting and
reprinting.

(R

1“‘ ED

View Options
There is a lot of information available for viewing about each job as it passes through the system.

The following sort columns can be selected using the contextual (right click) menu on the column header bar in the
QueueManager display panel:

Name - Job name. * (Copies - When multiple copies of a job are sent
Process Time - Time taken to process the job. for printing, this column counts down the
Status - The jobs current status. number of jobs left to print.
Source - The source of the submitted job. * Screening - The screening applied to the job.
Date - The date and time the job was ¢ Thumbnail - Shows a thumbnail of the job.
processed. * Job ID - The internal Blackmagic ID number
Media - The Media used to process the job. for the job.
Pagesetup - The Pagesetup used to process the * Node - The Server or Cluster Node the job was
job. processed on.
Queue - The output queue the job was sent to * Signature Group - The signature group used to
for processing. de-impose the job.
Size - The size of the job (disk space used). * Signature - The signature within the group
Width - The width of the job used to de-impose the job.
Height - The height of the job. * Page - The page number of the job.
DPI - The imaged resolution of the job. * Publication - The publication name.
Output Colourspace - The colourspace of the * Notes - The number of notes saved with the
output file. job.

* Section - The section of the publication.

The columns can be manually resized by dragging the header divider bar to the desired width, or resized to fit content
by double-clicking the divider bar.

Toolbar Options

Queue Order - Allows you to configure which queues are viewed by the QueueManager - Available & Showing.
Render Queue Thumbnails - Enable or disable thumbnails for the Render Queue in the Thumbnails view of the
QueueManager.
Show Idle Queues - Show/Hide entries in the QueueManager for idle processing queues.
Group by Queue - Enable/Disable the grouping of jobs by Queue before other column sorting is applied.
Show - Show certain jobs in the QueueManager. Select any or all of the options to filter jobs. Choose from:
o Jobs - Display all jobs as text line entries.
o Thumbnails - Display all jobs as thumbnails. This is the same as the Print Gallery mode.
o Publications - Only display jobs belonging to a publication.
For any of the above display modes, further filtering is available:
= Active - Jobs currently processing.
=  Waiting - Jobs with a status of Waiting,.
= Done - Completed jobs.
Search - Find jobs that are in the queue. All jobs matching the search text will be displayed. All elements of the
jobs are searched against, not just the name, so this can be a useful filtering tool. The search can be inverted
with cmd+shift+] (Mac) or ctrl+shift+] (Win). The search box will turn black to indicate when the inverse
search is selected.
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There are a number of actions that can be performed on a job. Options become available when one or more jobs are
selected. Only actions valid for the job status are shown. For example, the action to Nest Now is only available if the job
has a status of Waiting to Nest.

The following are available in the Toolbar or by selecting job(s) and right clicking to access the context menu:

Job Info - Shows information about the currently selected job (or jobs). The Job Info contains all details of how
the job was processed and displays a thumbnail preview of the job and its configuration. A dropdown toolbar
at the top of the Job Info window has the following options: Print Portrait, Print Landscape, Print to PDF
Portrait, Print to PDF Landscape. Prev/Next buttons at the bottom of the Job Info window are used to display
the info for the previous or next job in the QueueManager.

Note: Job Info & thumbnail can also be displayed by double clicking on the job. If multiple jobs are selected, double
clicking will display info about all in the window. Holding the control key (Win) or command key (Mac) will allow the
font size to be adjusted via the mouse wheel for easier viewing.

Job Ownership - Displays two panels - General and Ownership - showing the type, created and modified dates
of the job plus the user and group permissions (See Accounts Admin/Secure Mode for more information).
Modify - Allows various attributes of the job to be modified. These include:
o Name - Change the name of the job.
Publication Name - Change or add a publication name.
Page Number - Change the page number of the job.
Copies - Change the number of copies of a job.
Change Media - Change or assign a Media associated with the job.
o De-Imposition - Change or assign a Signature and Signature Group to a job.
Reprint - Displays a window to reprint a job or jobs.
Cancel - Cancels the currently processing jobs.
Delete - Deletes the currently selected jobs.
Hold - Holds the currently selected job. Only available when the status is “Waiting”.
Release - Releases a currently selected Held job.
Retry - Retries a failed job.
View Errors - Views the errors of the selected job if the status is listed as Failed.
Rush Jobs - Moves the currently selected jobs to the top of the current queue for processing next. The status
must be listed as Waiting. Jobs currently being processed will be completed first.

O O O O

Note: Rush Jobs will move the job up the current queue only. If the job is in the imaging queue and Rush Jobs is
selected, the job moves to the top of the imaging queue. Once complete, it will move to the bottom of the rendering
queue. You will need to Rush Jobs again to move it to the top of the rendering queue.

View Original - Views the Original/Imaged file for selected jobs in the SoftProof application.

View Printed - Views the Printed/Rendered file for selected jobs in the SoftProof application.

Render Again - Submits the selected jobs to the rendering queue for processing. Only available when the status
is “Done”.

Move to Pagesetup - Moves the selected jobs to another Pagesetup. This will send the jobs to the rendering
queue again with the attributes of the selected Pagesetup. View the Pagesetup, edit it, or create a new one prior
to submitting the job.

Copy to Pagesetup - Copies the selected jobs to another Pagesetup. This will send the jobs to the rendering
queue again with the attributes of the selected Pagesetup. View the Pagesetup, edit it, or create a new one prior
to submitting the job.

Nest Jobs - Submits the selected jobs to be nested. This sends the job to the rendering queue to re-render for a
nest. The Collating section of the Output is used for the nesting parameters.

Nest Now - This is available when the selected job has a status of Waiting to Nest. Only one job needs to be
selected and all jobs with a Waiting to Nest status will be nested.

Duplex Now - Duplexes any job that has a status of Waiting to Duplex. Only one job needs to be selected and all
jobs with a Waiting to Duplex status will be duplexed.

View FlipBook - Opens the selected job or publication in FlipBook. If the selected job is part of a publication, all
pages will be shown.

Select Publication - Selects all the pages/jobs in the QueueManager belonging to the same Publication as the
selected job.

Refresh All Queues - Updates the queues.

Export - Allows you to export data from the selected job. The available formats are:
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o CIP3 - Exports job information to a file in CIP3 format at the selected resolution. You can also select
the orientation before exporting. Further options are:
= Version 2.1
=  Version 3.0
= Rotations
=  Surface - Choose front or back.
=  Compress Preview - Choose if the preview should be compressed. Some presses are unable to
handle files in compressed format.
o PDF - Exports the selected job in PDF at the resolution entered. Further options are:
=  Compressions - JPEG, ZIP or LZW. For JPEG and ZIP you also have control on the level and
quality of compression.
o Postscript (separated) - Exports the current job as a separated PS file.
o Tiff Multichannel - Exports the current file as a multichannel Tiff.

* (Calcheck Job - Launches the Calcheck application to check a job’s calibration status. The jobname is stored and
the results can be exported or printed. Measurement results from the Calcheck are stored in the Job Info. The
Job information shown in the Queue will change
colour to match with the result of the Calcheck
once completed (green pass, red fail) .

* (Calculate Ink Weight - Displays the Ink Weights window with the selected job’s ink weights and coverage
shown.

* Pause/Resume Printing/Processing - Pause or Resume the output queue of the selected job at their current
stage of processing or printing (Imaging, Rendering, Nesting or Printing). Incomplete jobs in paused queues
will display in red.

* Change Output Media - Change the Media assigned to the output queue for the selected job. Once re-assigned,
all jobs held awaiting the new Media will begin processing.

* Auto Queue Order - When this option is enabled, the QueueManager displays jobs for all existing process and
output queues. Any new queues created will be shown automatically.

Configuration Options
The following options are available from the right click (contextual) menu within the QueueManager window:

*  Queue Colour - Select a colour for the currently selected Queue for easy identification.

*  Queue Order - Allows you to organise the queues into your preferred order, or adjust any settings.

* Joblist View - View the queue in Joblist mode. This is the same as selecting Show > Jobs.

* Publication View - View any publications in the queue. This is the same as selecting Show > Publications.

* PrintGallery View - View the jobs as thumbnails. This is the same as selecting Show > Thumbnails.

* Edit Output - Allows you to edit the Output and not the job. For changes to be effective, resubmit the job for
printing or rendering, depending on the attribute changed.

* Edit Media - Allows you to edit the Media the job was processed with. For changes to be effective, resubmit the
job for imaging or rendering, depending on the attribute changed.

* Edit Pagesetup - Allows you to edit the Pagesetup the job was processed with. For changes to be effective,
resubmit the job for imaging or rendering, depending on the attribute changed.

¢ Edit RIP - Allows you to edit the RIP of the source file (where the job was submitted from if a configured RIP).
For changes to be effective, resubmit the job or refresh polling.

* Edit Signature Group - Allows you to edit the Signature Group used for de-imposing of the currently selected
job. For changes to be effective, resubmit the job for de-imposition.

Important Note: When editing any of the items from here, you are editing the queue for all future jobs, not just the
currently selected job.
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QueueStatus

The QueueStatus module is a progress meter that shows the current status of active jobs on the selected queue. The
look and feel can be adjusted for the QueueStatus module and the queue it is monitoring. The options are available by
right clicking on the window.

Note: Not all options listed are available on all QueueStatus windows. Some are only available while the job is in
progress.

* (Cancel Job - Cancels the currently active job and is only available when a job is active.

* JobInfo - Displays info about the currently active job.

* Pause Printing/Processing - Pauses the queue so no further jobs will process. Any job currently active in the
queue will finish. The text in the window changes to red, showing the paused state.

* Resume Printing/Processing - Takes a queue out of a paused state. Any waiting jobs will now be processed.
Note: The Pause/Resume function can be toggled using the tick box to the left of the progress bar. This
function also affects the Output for the queue, changing the status to Active/Inactive. Inactive Output’s are
displayed in red in the Workbench > Output > [tems list.

* Change Queue - Allows you to choose which queue the status window will show.

* Edit Output - Allows you to edit the output or create a new one. You can only edit if the queue is showing an
output. If the queue is set to Spooling, Auto Detect, Imaging or Rendering you can only make a new output.

*  Thumbnail - Turns on/off a mini thumbnail on the printer queues only, which gives an indication as to how
much of the current job has printed.

* Font Options - Allows you to change the size of the text.

* Queue Order - Select which queues you wish to view. Selecting this presents you with a chooser window
showing two lists - The Available queues on the left and the Showing queues on the right. To move queues
between lists, select one or more and drag from one list to another. Alternatively, double click to move between
lists. The order of the queues in the Showing list determines the order of display. Queue Order can be used to
show multiple Queues in a single QueueStatus window.

* Increase/Decrease Indent - Increases or decreases the size of the QueueStatus in view.

Double clicking the QueueStatus window displays a floating QueueManager window showing that queue. This has the
full functionality of the standard QueueManager.
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RIPMonitor

The RIPMonitor displays the RIPs that have been configured under the RIP section of the Workbench. Jobs that have
been successfully polled are displayed and can be expanded to show any associated plates. These jobs can then be
submitted to a Pagesetup/Media for processing.

View =T — e ) (Vi) Gt 1 {50 B S 0 g e 9

* Toolbar - Contains job handling functions and
viewing options.

* Jobs - This is the large window to the right and
displays all successfully polled jobs from the
selected RIP.

e RIP List - A list of all the configured RIPs,
allowing the user to select each in turn to
display any jobs. This is on the left side of the
window and can be shown or hidden as
desired. Active RIP queues are displayed in black; inactive are red.

¢ RIP Menu - This is a pull down list at the top of the window of RIPs configured and shows the current selection.
Hiding the RIP Menu will also hide the Polling On/Off drop down selector.

Note: If you only have one RIP configured it is better to hide the left RIP list and top RIP menu as there is nothing else to
display. This will provide more room to view your jobs.

Toolbar
QUeTTS—PrMTGaTery R TO0S
) (ExpandJobs ) ( Collapse Jobs ) ( Submit... ) (" Submit For Deimposition... ) (" Submit As Imposition... Submit As Asset... ) { VPress... ) ™ Group By Job ( Poll ) ™ Toggle RIP Polling ™ Show RIP Menu
# Show RIP List

* Expand/Collapse Jobs - Show/Hide the plates associated with the selected jobs. Double clicking a job will also
expand or collapse the plate view for the selected job.

¢ Submit - Submits the selected jobs for processing. This pops up a chooser to select which Pagesetup/Pagesetup
Pool and Medias to send the job to.

¢ Submit As Asset - Select files to send to the Studio application Asset queue.

¢ Submit for De-Imposition - Submits the jobs for de-imposition. This pops up a choose to select which Signature
Group will be used to de-impose the job and which Pagesetup/Media combination will be used.

¢ Submit As Imposition (Veripress/Blackmagic Softproofing Add-on Only) - Submits the job in it’s original form,
but attaches a Signature Group via a popup chooser to allow the job to be deimposed on-the-fly using the De-
Imposed Pages button in the Veripress SoftProof Touch Console (See the “Touch Console” section for more
information).

* VPress - Adds the selected jobs to the VirtualPress. For further information see the “VirtualPress” section.

Note: The text in the Submit, Submit for De-Imposition, Submit as Imposition and VPress buttons will show in italics if
the job selected has unrecognised or unassigned plates. The plates will need to be assigned using VirtualPress.

* Group By Job - Keeps the plates in their respective job group when they are copied into the VirtualPress (see
below note).

Important Note: If you have multiple jobs selected for copying into VirtualPress, when this option is ticked they are
kept as their respective jobs. If this is un-ticked, all the jobs and plates selected are copied in as one job. This is useful if
you are polling a RIP and the plates are shown as separate jobs, with one plate each.

* Poll - Initiates a manual poll of the selected RIP.
* Toggle RIP Polling - Turns the polling on or off for the selected RIP. When the RIP is in the off state, the name in
the RIP list turns red.

Note: The RIP jobs list is cached and may require clearing. To do this, turn the RIP off and on again and click on the Poll
button three (3) times consecutively.

¢  Show RIP Menu - Shows or hides the RIP pull down list at the top of the window.
¢ Show RIP List - Shows or hides the RIP list on the left.
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Contextual Menu Options
The following are available via the contextual menu (right click) from within the job Display panel:

Display

Edit RIP - This enables the user to edit the RIP selected. Choose to edit a single section or all sections of the
configuration. Alternatively, you can create a new RIP.

Colour Scheme - Choose a colour for the module.

Font Options - Choose the preferred font size.

Language Encoding - Choose the language encoding for the operating system. This allows jobs to display
correctly in the RIPMonitor in the native language.

Panel View Options

The display panel columns can be configured to show specific information by right-clicking on the header titlebar. The
following are available for display:

Name - Job Name (and plate names if expanded).

Size - The size of the job (disk space used).

Date - The data and time the newest plate belonging to the job was RIPped.

Path - The directory path to the RIPped file for an assigned job plate. This information is visible when the
polled job is expanded.

Publication - The publication name.

Section - The section of the publication.

Page - The page number of the job.

ServerLog
The ServerLog shows messages from the Server.

Display

Fetch back log - Displays the log for the time specified, e.g., it retrieves and displays the last 4 hours of
messages. Choose the time period from the dropdown list.
Trim older lines - Trims the log based on the time selected in Fetch back log. If this is set to 60 minutes, the log
file is trimmed back so only the last 60 minutes remain.
Export - Allows you to export the log to a file. Selecting
this displays a window with further options as detailed
below:
o Destination File - Choose the filename and
location where the file is to be saved. Use the
Browse button to navigate to your preferred
location.
o Message Lines - Choose to save all messages in the log window or only those that are highlighted. This
way you can save just a few lines if desired.
o Format - Choose the format to save the file in, either html or plain text. The plain text file is saved with
tab characters between the columns.
o Cancel - Revert to the Server window without saving any changes.
o Save - Save the file based on the settings selected.
Configure Filter - You can filter messages in the log. Choose between the following options:
o Completed Jobs - Shows messages about completed jobs.
o Polled Jobs - Shows messages about polled jobs.
o Errors - Shows errors from the Server.
Search - You can search the log for messages. Enter the text of characters you want to search for and the
ServerLog will only display the lines matching the search.

Options

Module - The Server function that generated the message.
Routine - The operation within the Server function.

Date - The time the Server called the module.

Message — The message resulting from the routine.
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Status

Status shows the current disk status (usage) of the Server processing areas, such as spooling, temporary directories and
DropFolders. Editing the ss.conffile in the installation directory under the “etc” folder can change disk locations.

The available options are:

Spool &

* Update - Checks the disks and updates the view. Print I

e Preferences - Sets the Status window preferences. A further option P
available is:

OSTemp &

o Update Interval - Sets the time between updates.
* Colour Scheme - Changes the colour of the Status window. Dropfolders &
* Font options - Allows you to change the size of the text.

Thumbnail

This module displays a thumbnail of jobs as they are imaging and rendering. Thumbnail progress is updated at the
same time as the Imaging or Rendering QueueStatus is updated.

The following options are available from the contextual menu (right click):

¢ Show Imaging - Show the Imaging thumbnail, denoted by “gears” in each inset.

* Show Rendering - Show the Rendering thumbnail, denoted by a “paintbrush” in each inset.
¢ Normal Thumbnail - Displays the default size thumbnail.

¢ Large Thumbnail - Displays a large thumbnail.

¢  Small Thumbnail - Displays a small thumbnail.

Each active Thumbnail module may only show either Imaging or Rendering, not both. The module window displays as
many Thumbnail insets as there are simultaneous Imaging/Rendering tasks configured in the Server Settings.

VirtualPress

VirtualPress gives users the ability to manage the plates of the job. You can drop plates, change plate colours and merge
plates from other jobs. If a job contains an un-allocated plate (i.e., no colour), use VirtualPress to allocate a colour,
unless a Replace Colour Set is selected containing the plate.

* The History keeps jobs that have been imported into L —
VirtualPress. Any changes or additions are kept so the
jobs can be resubmitted at any time without having to -
recreate the changes. The history is held while the 0 niy Mo s O o s
Client is running. Once the Client has quit, any history S I ——— -
is purged. A 'Submit' button to the bottom left of the
Virtual Press allows multiple VPress History items to
be selected and printed simultaneously.

Subemnt Receder P . Clew Al Damis

*  Quick Submit shows a pull down list of the configured Pagesetups. Clicking this button submits the selected
job to the Pagesetup shown. The option to Hold After Imaging or Rendering is also available.

* Edit Plate Colour displays a colour editor, allowing you to change the colour attributes for this plate only. The
edit is not stored anywhere and does not affect the Special Colour Set. This option is also available when right
clicking on a plate.

* Choose allows you to select a colour from the colour libraries. This is only available for special plates. You can
also double click the plate in the list to choose a colour from the libraries.

* Reorder Plates allows you to change the order of the process plates. Plate position is used for Overprint,
Knockout, Opacity and Transparency simulation. The order of the list dictates the order the plates are merged
and can affect the job where plates have attributes such as Opacity. The button will appear in italics when the
order has been changed from the original.
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Applications

The applications available within Serendipity Blackmagic add functionality to the Client and provide additional tools for
managing the Server and your jobs.

There are fifteen (15) Applications available, including the Workbench and Monitor. All are accessible via the
Applications menu in the Client. Some, such as Calcheck, can be launched via other Applications or Modules.

The available Applications are listed here with further details on each following:

Archives - Make partial or complete backups of your Workbench configurations.

Calcheck - Verify the calibration status of a printer.

Clustering - Allocate and manage Imaging and Rendering tasks across multiple computers and networks.
Densitometer — Measure and display density readings taken with a Densitometer or Spectrophotometer.
Displays - Create ICC profiles for system monitors for accurate onscreen colour softproofing.

FlipBook - Display a publication as a 2D or 3D virtual book.

Jobs - Display jobs before, after and during processing and allows users to manage jobs through the system to
plot their progress with a pre-configured user-interface.

Lineariser — Create a Linearisation curve for use with a Pagesetup or Media.

Monitor - Display and manage jobs as they pass through Blackmagic (see the “Monitor” section for more
information).

Press Agent - Interface with press console controls to load/reload softproofs.

SoftProof - Proof jobs onscreen.

Spectro - Display, compare and/or save colours measured using a Spectrophotometer.

Studio - Designed for the manual nesting or tiling of jobs.

Touch Console - Use a touch screen to load, manage and proof jobs within the SoftProof application.
Workbench - The principal configuration tool for Blackmagic (see the “Workbench” section for more

information).
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Archives
The Archives application allows you to make backups or archives of your Workbench configurations. Individual items
or complete systems can be archived for safekeeping. Stored items can be loaded into the Archives app for adding to the

Blackmagic database. This can be used for copying a database to
another Server, or for recovery from failure or corrupt configurations.
You can configure the Archives app to automatically backup your
settings on a regular basis.

Important Note: Archives cannot be back-ported to previous versions,
i.e., version 5 archives cannot be used with version 3. Version 3
archives can be used with Version 5 however, and will be
automatically allocated to their respective databases when loaded.

File Menu Options

Open Archive - Open a previously saved archive. A chooser
window allows you to browse and select an archive (.sdb file)
to load. You can also load an archive by dragging the database into an open Archives application.
Save Archive - Saves the archive to a compressed (.sdb) file.
Save Version 5.3 Archive - Saves the archive to a non-compressed (.sdb) file compatible with version 5
installations up to and including version 5.3.xx.
Close Archive - Closes the currently opened Archive.
Perform Full Backup - Adds all Workbench data types to a new Archives window. Once done, you are
prompted to choose a name and location to save the file. Once saved, the Archives window is dismissed
automatically.
Automatic Backup Preferences - Allows you to configure the frequency, time and location that a system backup
is performed. The options are:

o What Day - Choose a day of the week, every day, every number of days or never.

o What Time - Choose the time the backup is performed.

o Location - Choose the location the archive should be saved to.

A check is performed Auto Backup Time Client Started Client Quit Time Backup Performed
when the Client is first - -
started and every hour Monday 2am Monday 9am No When Client is started - 9am
afterwards to see if a
backup  should  be Tuesday 12:10pm Tuesday No Tuesday 12:30pm

. 9:30am
performed. The Client —
must be running for a Everyday Tuesday N When. Client is started -
backup to take place. The 12am Midnight 8:20am 0 12:20am each day
table gives you a guide as The following
o yhen abackup woud | sy 1pm | TR o weiat 15303
scenarios.

Sunday 10pm Monday 8am Friday 5pm Never

Edit Menu (and Context Menu) Options
* Add to Archive (All) - Select everything or all of a particular data type, for e.g., All Pagesetups.

¢ Add to Archive (Selection) - Allows you to select individual items from the database to add to the Archive.

Selecting the type, for e.g., Gradation Curves, displays a chooser with all the Gradation Curves allowing you to
choose one or more to add to the Archive.

Add to Database - Choose to add items from the Archive to the database. You can add the whole Archive or
selected items.

Remove from Archive - Remove the selected items from the Archive.

Collapse - Collapses the selected items if they are expanded.

Expand - Expands selected items if the item contains references (denoted by a ‘+’). For example, a Pagesetup
will contain at least a Media, an output and ICC Profiles. Expanding the Pagesetup will display the other items
connected with it.

Open/Save/Save version 5.3/Close Archive - Open, save or Close the Archive as mentioned previously.
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Calcheck

The Calcheck application is used to verify the calibration status of a printer, ensuring proofs are printed accurately.

Calcheck Charts are generated by either manually defining or importing
Lab or CMYK values. Each chart represents print/press standards against | ==~
which the printer and media are to be checked (see the Workbench > |
Calcheck Chart section for more information).

The selected Calcheck Chart is printed from the Calcheck application to the ow 13
Pagesetup and Media being used to proof jobs. Alternatively, the chart can n—
be assigned to a Pagesetup to print with each proofing job. The chart is T
then measured, using a supported Spectrophotometer. ros han

After measuring the chart, the results are displayed in the Calcheck

window. A pass (green tick) or fail (red cross) is determined by whether alms __ =B
the measured patches fall inside the tolerances defined in the Calcheck |~ = o
Chart. The results can be printed as a label or a complete report to a system o
printer. If a Media or job was loaded into Calcheck before measuring, the %
results will be saved to the Media Calcheck Info, or stored in the job’s Job | >

s

Info (see below).

gratomerer |3me)
retag Eye-One #) (Measere

The Calcheck application is made up of a Summary Panel, Measurements s o

Panel and a Device/Spectrophotometer dropdown menu.

Summary Panel

This panel is viewed by selecting the (left) cross/tick button at the top right of the Calcheck window. It displays
Summary information about the completed Calcheck. This information is also available for view within the MediaStatus
module, the Calcheck Info section of a Media, or the Job Info window of jobs that have been calchecked. The following
information is displayed:

¢ The panel title bar shows the Calcheck Chart used for the check.

e AAll/Ae/AH/AC - These buttons switch between summaries of the respective A standards. The buttons
available depend on which A standards are defined in the chart for the Calcheck. The Ae summary values listed
are CIE76 by default. This can be changed to CIE94 or CIE2000 by setting either as the measurement standard
in the Calcheck Chart.

* Job/Media - The Job or Media being calchecked. The field displays N/A if a Calcheck is done without assigning
a Job or Media to it.

* Date - The date and time the Calcheck was completed.

* ACyan/AMagenta/AYellow/ABlack/AGray/APaper — The A values for the significant CMYK process, gray and
paper (substrate) patches are displayed here.

* Pass/Fail - Displays a green tick (pass) if all the measured patches fall within the A tolerances as defined in the
Calcheck Chart. A red cross (fail) is displayed if any patches measure outside the defined tolerances.

* A Average - The average delta of the patches measured in the Calcheck.

* A Maximum - The maximum delta measured for any patch in the Calcheck.

* Ao - The standard deviation of the patches (from the A Average).

* Score - The relative quality of the printed Calcheck as compared to the reference values. Rated from 1-100.

Measurements Panel
The Measurements panel contains the detailed reference and measurement data for each colour patch in the Calcheck
Chart used for the check. Colour patches that pass are shown in black, those that fail are shown in red.

The following sort columns are available, depending on the Astandards defined in the Calcheck Chart:

* Name - The name of the colour patch.

*  Colour (ref) - A colour swatch of the reference colour in the Calcheck Chart.

* Colour (meas) - A colour swatch of the measured colour.

* Lab (ref) - The reference Lab values of the colour patch in the Calcheck Chart.

* Lab (meas) - The measured Lab values of the colour patch.

* Ae max - The maximum Ae (CIE76, CIE94 or CIE2000) tolerance value for the patch as defined in the Calcheck
Chart.
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Ae - The measured Ae (CIE76) of the colour patch.

CIE94 - The measured Ae (CIE94) of the colour patch.

CIE2000 - The measured Ae (CIE2000) of the colour patch.

AH max - The maximum AH tolerance value for the patch as defined in the Calcheck Chart.
AH - The measured AH of the colour patch.

AC max - The maximum AC tolerance value for the patch as defined in the Calcheck Chart.
AC - The measured AC of the colour patch.

Device/Spectrophotometer Panel
This panel allows you to choose which measuring instrument is to be used.

Spectrophotometer - Select the Spectrophotometer to be used for measurement from a list of supported
instruments.

Measure - Initialises the chosen instrument and opens a popup window to select which Calcheck Chart is to be
measured. Measurement begins after the chart is selected. The data from a chart measured by a third party
software package can be loaded for a Calcheck be selecting CGATS/1S012642 file from the instrument list. The
file must have been saved in an appropriate format.

Print Chart - Opens a chooser window to select the Calcheck Chart for printing, and the Pagesetup and Media
to submit the chart to. The chart will be printed in a configuration suitable for reading by the chosen
instrument.

Menu Options
The following options are available from the Calcheck menu or the contextual menu (right click) from within the

Calcheck application:

Load Media - Select a Media to load into Calcheck. Any Media that have been calchecked previously will display
complete results of their last Calcheck. A new chart can be printed and/or new measurements taken and the
results updated to the Media.

Check Media - Select a Media to be measured. This option assumes a Calcheck Chart for the Media has been
printed. It immediately opens a window to select the chart for measuring and initiates measurement on the
selected Spectrophotometer. On completion, results are saved to the Media and previously calchecked Media
will be updated.

Load Job - Select from a list of previously calchecked Jobs sitting in the QueueManager. Once loaded, complete
results of the job’s last Calcheck are displayed. A new chart can be printed and/or new measurements taken
and the results updated to the Job Info.

Check Job - Select any job currently in the QueueManager to be measured. This option assumes a Calcheck
Chart for the job has been printed. It immediately opens a window to select the chart for measuring and
initiates measurement on the selected Spectrophotometer. On completion, results are saved to the Job Info and
previously calchecked jobs will be updated. ¢ I50conted v2 o0

Print Label - Print a summary label of the currently displayed 3 M {

Calcheck results to a system printer.
Print Report - Print a Calcheck report on the job / media, or choose
to save as a PDF.
Page Setup - Allows the user to configure the label printing properties for
the Print Label option above. Serengipity
Show Graph - Displays a representational graph of the Ae for each patch of T
the currently loaded Calcheck result. Checkboxes toggle pass/fail views.
Results can be displayed in one of three formats, selected via dropdown
menu: e E—
o Show Error Bars - Shows two (2) coloured spheres, joined by a
bar for each patch positioned in a 3D Lab colourspace. The dull
sphere represents the reference value for the patch; the shiny
sphere is positioned based on its Lab values in the colourspace. The relative distance between spheres
shows the Ae between them.
o Error Plane - Shows a line of coloured spheres representing each patch, lined up in order. The larger
the sphere, the higher the Ae.
o Error Spheres - Shows a coloured sphere for each patch position in a 3D Lab colourspace. The larger
the sphere, the higher the Ae.

Selenapit! o

:

Contextual Menu Options

Export - Export the colour patch data from the display panel to a text file.
Import - Import colour patch data into the Calcheck application from an exported text file.
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Clustering
Clustering is the ability to share the workload of processing jobs across multiple devices. Slaves or cluster nodes can be
installed on other machines on the network and jobs can be sent to them from the Master for processing.

The Clustering application allows you to add and manage these cluster nodes. They can be enabled for use in imaging,
rendering or both.

eno s skmnsrerbun el sty softws com 359100 NGR o fr s o

As a node device starts up, its speed is calculated. When a job is
submitted for processing, the Master machine has priority as no
network traffic is required. If the Master is busy processing
another job, the job can be sent to the fastest available node. The
node processes the job and once completed, sends it back to the
Master. It is then ready to accept another job. Nodes can be
installed on any machine on the network.

Running a Cluster Node requires a separate Blackmagic dongle. If you have extra Blackmagic dongles, any Server can
act as a node if it is started as a Cluster Node (see “The Blackmagic Server” section for more information).

Note: In this mode, the Server can only be used as a Node (slave) for another Server. It is recommended that the
database be backed-up and job queues cleared before a Blackmagic Server is started as a Cluster Node. This avoids any
conflicts with existing job IDs or settings.

Master Panel
This panel displays information about the Master Server machine.

*  Product - The Serendipity Blackmagic software in use.

* Version - The Server software version.

* Hostname - The network name of the Master Server.

* [P Address - The network IP address of the Server.

¢ Speed - The relative speed of the Server, calculated by Blackmagic.

* Processors - The number of CPUs in the Server machine.

¢ Platform - The operating system/kernel version of the software.

* Process Imaging/Rendering/Schedule Last - Check whether the Master Server is to perform any Imaging or
Rendering Jobs. The Schedule Last option allows nodes to have priority over the Master when jobs are
processing. This is advantageous when polling large RIPs, as it allows the Master to concentrate on gathering
the list of jobs and displaying them.

Cluster Nodes
This list shows nodes that are available and running on the network. Information about each node is displayed in the
window. Online nodes are displayed in green; offline nodes in red.

The following sort columns can be selected using the contextual (right click) menu on the column header bar in the
Cluster Node panel. Columns can be reordered by dragging and dropping them into the desired order, or by using the
Configure Headers option in the contextual menu.

The sort options are:

* [P address - The network IP address of the Node. Checkboxes become available to enable the node and select if
it is to be used for Imaging and/or Rendering tasks. Once enabled, the Master handles the clustering in the
most efficient manner possible.

* Hostname - The network name of the Node.

* Speed - The relative speed of the Node calculated by Blackmagic.

* Platform - The operating system/kernel version of the Node machine.

* (CPUs - The number of CPUs in the Server machine.

* Product - The Serendipity Blackmagic software being used for the Node.

* Version - The Server software version of the Node.

* Processing Pool - Optionally choose a Pagesetup Pool (see the Workbench - Pagesetup Pool section) for which
the Node will perform image and render tasks.
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Image - Shows the number of simultaneous Imaging tasks that can be performed by the Node. Click on the field
to change the number.

Render - Shows the number of simultaneous Rendering tasks that can be performed by the Node. Click on the
field to change the number (see the Server Settings for details on Imaging and Rendering task settings).

Refresh - The Refresh button polls the network for active Nodes and registers any Nodes in the list that are offline.

Cluster Node activity can be monitored in the ClusterStatus module (see the Modules - ClusterStatus section for more
information).

Menu Options
The following options are available from a contextual (right click) menu within the Cluster Node panel:

Add Node - Add a Cluster Node that cannot be seen. Sometimes Nodes on subnets cannot be detected. Selecting
this allows you to enter the hostname or IP address of the Node and add it to the list manually. The Node to be
added must be running.

Add Processing Pool - Select, change or remove the current Pagesetup Pool for which the Node performs
Image and Render tasks.

Remove All Offline Slaves (Nodes) - Remove a Node from the list that has gone offline.

Remove Node - Available for offline Nodes only. This option removes the selected Node from the list.
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Densitometer

The Densitometer application allows you to measure and display density readings with a supported
Spectrophotometer. When measuring a patch, the densities of all four process CMYK colours making up the patch are
read.

The Last Measured panel in the top half of the application window shows the density and dot percentage values for the
dominant process colour of the measured patch, with the values of the other three colours to the right. The values can
be recorded and saved to a file if desired.

Note: The Densitometer application is a utility allowing you to use a Densitometer or Spectrophotometer that does not
have a display to read values. This can be as a one-off reading to compare densities, or you may want to read values and
export them for plotting on a graph. There is no requirement to use this for the normal operation of Serendipity
Blackmagic.

Densitometer/Measurement/Paper Options
*  Yule Nielsen Number - Enter the YN number for the paper you are reading (if known). The default is 2.0.
* Densitometer - Choose one of the supported instruments from the available list.
* Instrument Default Density Standard - Select your desired density standard from the available list.
* Activate/Deactivate - Connect or disconnect the chosen device.
* Add - Add the measured values to the list. This appears after the Densitometer has successfully connected.

To begin measuring:

1. Select a Densitometer from the dropdown list and click the Activate button.
2. The status field is shown when the device connects without error.
3. Follow any instructions when prompted - Calibrate, Measure Cyan Solid, etc.

Measure Targets

In order to read percentage tint values of any plate, you must first read the paper white and the solid density value for
that colour. The Measure Targets menu or contextual (right click) menu allows you to measure the solid reference
densities for the process colours and the paper white. With these values stored, colour percentages can be calculated
and displayed. You can measure or update an individual Solid density or Measure All Targets.

Colour List
This is a list of readings taken if the Add is enabled. Each reading is appended to the list and the values measured are
displayed. The columns can be resized or reordered as required by dragging the header to the preferred position.

The columns are:

* Name - The name of the colour read. Defaults to “Untitled” but can be changed by selecting the name and
entering a new one.

¢ Colour - Shows the dominant colour read, i.e., the one with the highest density value. This may not be the
colour you perceive it to be, but the contents making up the colour are recorded and the colour is calculated
and shown.

* Density - The density value for the colour. This is the highest density read from C, M, Y and K. It shows the
density of the colour stated in the Colour column.

¢ (Cd/Md/Yd/Kd - The C, M, Y and K densities of the colour read.

* Dot% - The dot percentage of the colour shown in the Colour column.

¢ C%/M%/Y%/K% - The C, M, Y and K percentage values for the colour measured. If any of the % columns are
blank, the reference paper white or solid density for that colour has not been measured.

Export
You can export the values from the Colour List to a file. The available options are:

¢ All - Saves all entries in the list.
* Selected - Save the selected entries in the list only.

Selecting either of these options displays a window allowing you to choose the values to be saved. The choices are:
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* Name - Save the name of the colour. - AR

*  Colour Density - The highest density reading regardless of colour. i G

¢ Cyan/Magenta/Yellow/Black Density - The density reading of the chosen e Coloue Dty ElColie Percantae
colour. For e.g, if Cyan is selected, the Cyan density for each reading is [ Cyan Density (] Cyan Percentage
taken. This is the value displayed in the Cd column of the list. (] Magenta Density ] Magenta Percentage

* Colour Percentage — The percentage reading of the highest density read as [l Yellow Density ] Yellow Percentage
displayed in the Dot% column. [ Black Density  [] Black Percentage

* (Cyan/Magenta/Yellow/Black Percentage - The percentage reading of the T er——
chosen colour. For e.g, if Cyan is selected, the percentage of Cyan for each | (w7 ™
reading is taken. This is the value displayed in the C% column of the list. m\——m

The percentage values must be present for the values to be exported. If they are not,
the exported file will show a 1% value in place of the reading.

* Order Values - Choose whether to export the file in CMYK or KCMY order.

* Separate Values With - Choose to separate the values with either a tab character or a space.

* Cancel - Cancels the Export action.

¢ Export - Displays a file chooser allowing you to enter a name and select a location to save the file to.

Table 1 - Supported Density Standards

Density Standard - Status
Instrument A E I T Default
DTP41 v v v v v
DTP34 x x x x v
DTP22 v v v v v
DTP20 v v v v v
Spectrolino v x x v v
EyeOne 4 x x v v

Not all instruments support all density standards.
This table is not a complete list. Consult your instrument user guide for more information.
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Displays

The Displays application uses a supported Spectrophotometer to calibrate and create an ICC profile for a selected
monitor or light booth. Suitable graphics monitors can be calibrated to match a chosen print gamut, allowing colour
accurate softproofing of print material and can be verified at any time to ensure correct colour output.

Creation of a profile is very simple, requiring a supported instrument and a few minutes of time. The
Spectrophotometer is placed on the screen to be calibrated. A series of adjustments are made to the screen gamma,
white point and brightness (if available). Measurements are taken, from which an ICC profile is created and saved in
Blackmagic and the operating system as the native display ICC profile.

Note: The Displays application creates a profile for use with the Match ICC profile assigned to the monitor in Server
Settings. Ensure the correct match profile is set before creating the monitor profile (see the Server Settings — Colour
Management section for details).

The Displays interface comprises of a function list (left) and a multi-purpose display area (right) that will change
depending on the function selected.

The function list is made up of the following selectable items:

Calibration

- iMac * (Calibration - Lists each connected display available for calibration.
Calcheck * (Calcheck - Lists each connected display available to calcheck.

[ iMac | e History - Lists the calcheck history (reference only) of each connected display.

* Ambient - Measure the ambient and white point of the light source.

¢ Light Booth - Appears only when a light booth is connected and will list each connected
device.

Calibration
The Calibration function displays currently connected monitors and their calibration status.

By clicking on the Calibration header, each connected monitor shows the following details:

* The name of the Display, viewable screen dimensions in mm x mm, and its

@]
identification number (in a multi-display environment).

Display iMac (520 mm x 320 mm)
Pixels 1920 x 1200

*  Pixels (width/height).

* Resolution (DPI).

¢ ICC profile.

¢ Calcheck Status.

¢ Last Calibrated (time).

¢ (Calibration Expires (time period).

Resolution

ICC Profile

Status

Last Calibrated
Calibration Expires
Calibration

93.78 x 95.25 DPI
iMac-070911.icc

0K

7/09/11 1:09 PM
Never

4

* Hardware Calibration (supported or not for the particular display).

By clicking on the Display name, calibration options and settings available for the monitor are shown. These include:

* Brightness - Only available if hardware calibration is supported and selected for the monitor (see below).

Choose to set the brightness level in either:

Brightness.

o Candela - Brightness in cd/m? ——
o Setthelevel from 0-100% O ook 0
o Measure - Click to use a connected © (Mesure.)

Spectrophotometer to measure and display the “’""‘t‘m‘:‘mi

brightness (cd/m? and white point (K) of the e &

monitor. Follow any onscreen instructions for the
selected instrument. The reading is constantly
updated, allowing the user to manually adjust the

U

brightness using the monitor’s own controls. This option is only available if the Use Software

Calibration option is selected or is the only mode available (see below).
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White Point - Select the white point temperature for the monitor. Choose from:
o Custom - Type in the field provided or use the slider to enter a custom temperature in Kelvin (K).
o D50 - Sets the white point to D50 (5003 K/Horizon Light).
o D65 - Sets the white point to D65 (6504 K/Noon Light).
o Native - Sets the Displays application to use the monitors native white point.
Gamma - Select the gamma correction to be used for the monitor.
o Custom - Type in the field provided or use the slider to enter a custom gamma value between 1.0 and
2.6. The Custom button will auto-select if a non-standard gamma setting is chosen. Note: If either 1.8
or 2.2 are chosen, the 1.8 or 2.2 buttons will auto-select.
o 1.8 - Select this to set the gamma correction value to 1.8. This button will auto-select if 1.8 is chosen
via the Custom field/slider option.
o 2.2 - Select this to set the gamma correction value to 2.2. This button will auto-select if 2.2 is chosen
via the Custom field/slider option.
Options
o Use Hardware Calibration - When supported, this option uses the monitor’s own internal hardware
for calibration, allowing the screen brightness to be adjusted automatically.
o Use Self Calibration - Available on some high-end graphics monitors. Uses the monitor’s own internal
hardware and calibration routines for calibration.
o Use Software Calibration - Calibration is performed using the Displays application software.
Instrument (offline/online) / Instrument Name - Displays

the currently activated instrument. nsrumen g
o Instrument - Select from the list of supported | =" e e, C
Spectrophotometers to use for display calibration. = e —

o Display Type - Select the type of display being
calibrated from LCD, CRT or RAW.

Monitor Identification Number - Click to popup an identification number in the centre of the screen for the
display to be calibrated.
Calibrate - Click this button to start calibrating the selected display to the chosen settings and create the
display ICC profile. Follow any onscreen instructions for your instrument. When calibration is complete, a file
chooser will popup to name and save the ICC profile. The profile will be saved as the operating system native
ICC profile for the display and will appear as the Native Profile in Serendipity Client Preferences > Colour
Management (see System Settings for more information).
Save Profile - Opens a file chooser (as above) to save or rename the ICC profile.
Information Panel - Appears while the ICC profile is being generated, showing the progress and final results of
the calibration process.

Calcheck
The Calcheck function displays Calcheck status summaries for all attached monitors, as compared to the values defined
in the Calcheck Chart assigned to the SoftProof Default Press and

Camera setting. o ..

Clicking on the Calcheck header allows users to quickly view whether a
display is currently calibrated for softproofing a particular press [ Semm——
profile. See Applications > SoftProof; Workbench > Press for details. -

Note: If a Calcheck summary is blank, this means: s

o

No Calcheck data exists for the monitor; -
That the current Calcheck for the monitor was measured |} v
against a different Calcheck Chart than the one assigned to the |
SoftProof Default Press; or S ot
No Calcheck Chart has been assigned to the default Press.

SoftProof | M Default Press ?
Press M Auto SoftProof Press ~ ~
Calcheck Chart 150coated_v2_eciF39 MaUremant [YPe  Udse contve of rven 21 e
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The top section of the display area shows:

¢  SoftProof - The currently selected Default Press or Default Camera configuration.
¢ Calcheck Chart - The Calcheck Chart assigned to the above configuration.

The remainder of the display area shows the current Calcheck status of each connected monitor. Information includes:

* Process Colour/Gray/Paper delta values

* Average/maximum/standard deviation delta values
* Display name (top left)

* Timestamp of the last Calcheck (top right)

* Chart and Instrument used (bottom left)

* Overall Calcheck score (bottom left)

Note: In cases where multiple areas of a screen have been calchecked, the summary will display the worst results from
across all calchecked areas.

Clicking on a Display name under the Calcheck header (e.g., iMac) will allow the user to perform a Calcheck on the
chosen monitor.

The main part of the display area (white box) will show the detail or summary of the Calcheck as it is performed.

The top section above the main area has the following options:

AAIl| Ae | AH | AC

e A All - Shows all of the A results measured, as defined in the Calcheck Chart.

* Ae - Shows all of the Ae results only. The Ae standard used
(DeltaE/CIE94/CIE2000) is selected in the Calcheck Chart (see Workbench > Calcheck Chart for details).
CIE2000 is a recommended standard to use for display verification.

¢ AH - Shows all of the AH results only.

¢ AC - Shows all of the AC results only.

¢  Summary button - Shows Calcheck summary results. X,

* Detail button - Shows results for each measured patch of the Calcheck Chart.

The lower section of the main display area contains the following:

* Screen Area buttons - These buttons enable the user to look at e — -
results from one of the nine (9) defined areas of the monitor = | | ] o [3: = o | -
screen. The buttons are grayed out (cannot be selected) if a
screen area has not been calchecked. Areas that have been checked will enable the button and show whether
the area passed (green) or failed (red) a Calcheck.

¢ Instrument (offline/online) / Instrument Name - Displays the currently activated instrument.

o Instrument - Select which supported Spectrophotometer is to be used for the Calcheck.
o Measurement Type - Select which area of the screen to Calcheck or Calcheck the whole (3x3 grid)
screen. The middle centre of the screen if the default option for standard Calchecks.

History
By clicking on the History header, users can see at a glance the Calcheck summaries for all attached monitors. This is
useful for keeping track of any changes in your monitor’s performance
(i.e., drifting).

Information includes:

* Process Colour/Gray/Paper delta values

* Average/maximum/standard deviation delta values
* Display name (top left)

* Timestamp of the last Calcheck (top right)

* Chart and Instrument used (bottom left)

* Overall Calcheck score (bottom left)
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These summaries show Calcheck results for the monitor(s) in relation to the Calcheck Chart used at the time of
checking (shown at the bottom left of the summary). The summaries are independent of the currently assigned
SoftProof Default Press / Calcheck Chart although, in most cases they will match the current Calcheck summaries (see
above section).

Clicking on a Display name under the History header (e.g., iMac) will allow the user to review past results of Calchecks
for the monitor. The window shows a sort list of previous Calcheck results, with the time and date the Calcheck was
performed and the Calcheck Chart used. Selecting a history item will display a summary or the detailed results.

Calcheck history within the Displays application is only kept for a period of 30 days from creation for each history item.

Ambient
By clicking on the Ambient header, the option to select a supported
Spectrophotometer becomes available to measure the ambient (cd/m?2) iscumens 167 510,170,405, 102050

and white point (K) of the light source, e.g., a light booth or room.

¢ Instrument (offline/online) / Instrument Name - Displays the
currently activated instrument.

* Measure - Select from the list of supported ambient-mode
Spectrophotometers to use for measurement.

Note: For some Spectrophotometers, after initial instrument calibration,
an ambient light filter will need to be attached before measurement.

The lower, white area displays constantly updated measurements.

Light Booth
By clicking on the Light Booth header (when available), any currently connected
light booths will be shown.

. . . Display Just Normlicht
Each connected light booth shows information on: s
Resolution
¢ Name/Model ICC Profile
e  Driver Status
° Driver Vers]on Last Calibrated
Calibration Expires
Clicking on a light booth name under the header will make calibration options Ruivenfie bams just-bootso
. . Driver Version 1.02
available for the booth. These include: S
Hardware Calibration

* Brightness - Choose to set the brightness level in either:

o Candela - Brightness in cd/m? = —
o Setthelevel from 0-100% i R 5
* Instrument (offline/online) / Instrument Name - Displays the TS
currently activated instrument. e Gretogtyeone =
o Instrument - Select which supported C s
Spectrophotometer is to be used for the light booth | i uminsrce orss5.16com, wntepointor sosss
calibration.

o Adjust - Click this button to calibrate the brightness of
the selected booth. Follow any onscreen instructions.

Note: For some Spectrophotometers, after initial instrument calibration, an ambient light filter will need to be attached
before placing it in the booth and commencing the booth adjustment.
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FlipBook

The FlipBook application allows you to view a publication as a virtual book. In Blackmagic, a publication is defined as a
group of pages with the same publication name. This is a collection of book or magazine signatures that have been de-

imposed, but a publication may consist of any number of pages.

FlipBook allows you to load the publication and flip through
pages as you would with a real magazine or book. This enables Name: Publication 123016680 (Pages)  Stanpage: 3 (1] TopPage:  Qfven © 0dd
you to check that your de-imposition has worked correctly, that
pages are in the correct order, orientation and if there are any g
duplicates. Larger views of the pages can be called up and the
whole publication can be exported to PDF or as a QuickTime
movie.

FlipBook can be opened in three ways:

1.

A M O Flipbook<2> - swievel. i oftware.com.au:9100 - NFR (not for resale)

Publication Pagination

From the Application menu of the Serendipity Client.
Publications can be dragged and dropped from the
QueueManager into the FlipBook window and will open
automatically.

From the QueueManager application by Selecting a ]Ob 19532 COLF TEXT job (MPOSITION) Page 6 [[N610] [IN700] 19532 COLF TEXT job IMPOSITION) Page 7
and choosing View Flipbook. The View FlipBook option =———————— )
is only available if the job has a publication name. 3 EMAC ST o] 10 u[ 1] ) 1l 15[ 1] 18

From the BookMonitor application by selecting a
Publication title and choosing View FlipBook (Available
for Veripress/Blackmagic Softproofing Add-on Only). If the pages for the selected publication title have not
been imaged or rendered in the QueueManager yet, the FlipBook will open but will not show any pages.

The FlipBook window comprises of four (4) main panels - Publication, Pagination, Page View and Page Index.

Publication Panel
This panel contains the name of the Publication being viewed.

Pagination Panel

Start - Enter the page number for the starting page or use the arrows to select the first page number of the
FlipBook. If the first page loaded is page 1, you cannot alter the start page number. If the first page loaded is
greater than 1, you can enter a lower value as the start page number. This can be used if you are viewing a part
publication where the first pages have not been processed.

Top Page - Choose whether the top page of the FlipBook is Even or Odd.

Page View Panel
This panel is where the FlipBook pages can be viewed. When a FlipBook is opened, the pages of the publication are
loaded and displayed in 2D (two-dimensional) view. There are various ways to navigate through the publication:

Clicking on the page of the image - If you click on the right page, you move forward through the publication.
Clicking on the left page moves backwards.

Clicking on the pages in the Page Navigator Panel - displayed below the Page View panel. The view jumps to
the page (pair) you select.

Space Bar - The space bar moves forward to the next pair of pages. Hold the shift key and press the space bar
to move backwards.

PageUp/PageDown - Use these buttons on the keyboard to navigate forwards and backwards through the
publication.

Arrow Keys - Use down or right arrow keys to move forward through the publication and left or up to move
backwards.

Scroll Bar - Moving the scroll bar below the image moves forwards or backwards through the publication.
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Page View (Contextual Menu)
There are various options available from the context (right click) menu:

* Open Publication - Opens a QueueManager showing all jobs processed in the system. Select a job or publication
job to load and click OK.

* Reload Publication - Reloads the current publication with files from the queue. This is used if additional files
have been processed as part of the publication, or changes have been made and the publication needs to be
updated.

* Choose Press - Select a Press configuration to apply to the job currently (and subsequently) loaded into the
FlipBook. (see Workbench - Press for details)

* Job Info - displays the Job Info information about the currently selected page. (see Workbench - QueueManager
for details).

* Swap Page with - This allows you to swap the page currently selected with another page from the same
(currently loaded) publication.

* View Original - opens and views the imaged file of the selected page in the SoftProof application.

* View Printed - opens and views the rendered file of the selected page in the SoftProof application.

¢ View 3D - toggles between a 3D or 2D view of the publication. Three dimensional viewing shows the page
turning as you navigate through. The turning speed can be adjusted FlipBook Settings.
3D mode adds 2 sliders on the right side of the Page View. The first alters the angle at which the 3D virtual
book is viewed, the second zooms the view in and out.

Note: The performance of the page turning may vary depending on the size of the thumbnail being viewed and the
performance of the graphics card.

¢ View as Calendar - Only available in 3D mode. Changes the flip axis to horizontal so pages flip up and down in
the same manner as a calendar.
* Export - Exports the FlipBook as a PDF. Select the resolution, compression type and quality. Choose between
exporting the whole book or a range of pages.
* Export as Spreads - Exports the FlipBook as a PDF but as spreads. The same options as above apply.
* Export as Movie (3D view mode only) - Exports the FlipBook as a QuickTime movie. After selecting this there
are three further options:
o Codec Type - Choose the preferred compression type from the menu.
o Quality - Choose the preferred quality.
o Keyframe Spacing - Choose how often a keyframe is saved.

The settings you choose will affect the size of the movie, the quality and the compatibility with other applications.
There are many Codec types available and not all work on all systems. Commonly used types are Apple MPEG4 and
H.264 avcl. Increasing the quality setting also increases the file size. This is also true for the keyframes. The more
keyframes, the better the quality but the larger the file size. Trial and error will provide you with the desired result.

* Render Queue Thumbnails - View the Rendered thumbnails in rather than the default Imaged thumbnails.
Page Index Panel

The Page Index displays a numbered box for each page making up the loaded Publication. It allows for direct navigation
to any page by clicking on it.

The page boxes are colour coded:

Light Green indicates the pages are loaded into the FlipBook and can be viewed. These show as dark

green when selected.
2 3
Purple indicates there are duplicate pages, i.e.,, they have the same publication name and page I‘

numbers. Dark purple indicates the pages are selected. Al R ol 3 ’

Clicking on these pages allows you to select and view the alternative page:

[ 1[ I ——r I ===al; —l =1 ==

19532 GOLF TEXT.job (IMPOSITION) Page 7

22
19532 GOLF TEXT.job Page 007 (IMPOSITION 07)

38 3
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Light Red indicates the page is not in the FlipBook. This occurs when there are other pages
greater than the numbers displayed. This could be due to the imposition signature not yet being

117

rendered. As they render, you can simply reload the publication to update the pages.

The status colours are updated whenever Reload Publication is selected.

A bar directly above the Page Index displays the Job Name for each currently viewed page on the left and right sides
respectively. Pages with more than one version will show a dropdown to select which version to view. The Page
Numbers being viewed are shown in the centre of the bar.

Menu Options
The following are available from the FlipBook File Menu:

Open Publication
Reload Publication
Export

Export as Spreads
Export as Movie

Two other options are also available:

View Menu

Edit Touch Console Ul (Veripress/Blackmagic Softproofing Add-on Only) - Opens an Edit Interface window
allowing for the configuration of the buttons enabled (and visible) for control of the FlipBook in the Main
screen of the Touch Console (see the Applications - Touch Console section for more information). Enable or
disable buttons by clicking on them. Those disabled will appear with a red cross and will be excluded from the
Touch Console when using it to view a FlipBook.

The Toolbar has a Preview toggle to see how the Touch Console controls will appear and a Reset button to
restore and enable all buttons.

FlipBook Settings — Configure the FlipBook viewing options and press configuration.

View Options
o Allow Multiple Windows - Enable or disable. Allows multiple Publications to be opened and viewed in
separate FlipBook windows. If disabled, a newly opened Publication will replace the one currently
being viewed.
Page Order - Choose between reading left to right or right to left.
Flip Time (3D) - Select the speed for the flipping of pages when in 3D mode.
Render Queue Thumbnails - Enable or disable render queue thumbnails.
Show Borders (2D) - Enable or disable the borders when viewing in 2D mode.

O O O O

Press Configuration
o This panel allows you to view or change the Press configuration FlipBook uses to display Publications.

These options are also available from the FlipBook View Menu:

View 3D
View as Calendar
Ink Weight - Opens the Ink Weights window displaying the FlipBook publication’s ink weights and coverage.
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Jobs

The Jobs application is used to display jobs before, after and during processing and allows users to manage jobs
through the system to plot their progress.

The Jobs application consists of an easy to navigate user-
interface, with tabs and layouts available for various
monitoring functions. Tab layouts may be added or managed
according to individual preferences and are saved at the Client
level, allowing different users to display information
appropriate to their location and workflow.

Jobs is the default monitoring application and will be run
automatically on launch of Blackmagic after the initial
software installation.

Menu Options

Tabs Menu
* Add Tabs - Add a new tab to the Jobs main window. Select from a list of factory default layouts. New tabs can
be imported for use via the Manage Tab Library option.

The factory default tab layouts available are:

Job Queues (default loaded view)

RIPMonitor - Adds a tab with the RIPMonitor module.

Book Monitor - Adds a tab with the BookMonitor module (Blackmagic SoftProofing Addon Only).
Status and Drop - Contains the MediaStatus, Status, QueueStatus, DropZones and ClusterStatus
modules.

Logs - Contains the ServerLog and ClientLog modules.

Jobs - Contains the QueueManager module with the Jobs view selected.

Assets — Contains the QueueManager module with the Assets queue selected.

Drop Area - Contains the DropZone module with Assets dropspot added by default. Right-click to add
any additional dropzones to the Drop Area tab.

o ServerLog - Contains the ServerLog module only.

O O O O

O O O O

* Rename Tab - Rename the selected tab.

* Manage Tab Library - Add, remove or preview tab layouts for the Jobs application. There are eight (8) layouts
available as standard (factory).

* C(lose Tab - Close the currently selected tab.

View Menu
* Previous tab - Opens the previous tab window.
* Nexttab - Opens the next available tab window.
* Titlebars - Show or hide the titlebars for each module within the Jobs application tabs. This will show or hide
all titlebars in all tabs and is not limited to the currently selected tab.

Job Queues Tab
The default tab layout (Job Queues) for the Jobs application contains the following modules:

* QueueManager

¢ Thumbnail - Imaging Preview

*  Thumbnail - Rendering Preview
¢ QueueStatus - Imaging Queue

For information on each module, see the Modules section of this manual.

Serendipity Blackmagic User Manual - Version 5.4 97



Lineariser
The Lineariser application creates a Linearisation Curve for an output device (printer). Assigned to a Media after paper
profiling, it brings the output device to a known (linear) state. This means a 50% Cyan will print at 50%.

The user first prints a stepped wedge chart for a selected Spectrophotometer/Densitometer to the output device in the
colourspace specified by the Media. The chart is measured and
the resulting curve is saved, assigned to the Media and a History

recorded. ~EEE ':::EEEEEEE
TEDNEEEEEEEE

At this stage, ICC profiles can be created and applied for
accurate colour representation. If the printer output varies due
to ink batches or head wear, a quick re-linearisation process is
all that’s required to get back to the same linear state initially
created. The original ICC profiles can be re-applied to achieve
the same colour output.

The Interface
The Lineariser window is made up of a Toolbar and a number of panels - Available Media, Linearisation History,
Measurement, Advanced Options, Spectrophotometer or Densitometer information and Curves display.

Toolbar
The Toolbar has the following options (also available via the Lineariser Menu):

* Customise Patches - Allows for the selection of patches to be used in the Linearisation
Chart. Choose which Patch Percentages using the numbered buttons. Total number of =
patches selected is displayed. 3 1) 0 I £ 2 1

o Restore Defaults - Restore the patch selection to the default 23 patches per Elefotalatal
channel.

* Use Lab - Toggles between Density and Lab measurement modes. Lab mode for
linearisation is required for printers with built-in Spectrophotometers.

* Measure Patches - Initialises the connected Spectrophotometer. Follow any
instructions in the status bar to measure the chart.

*  Submit Linearisation - Save the data in the Measurement panel to the Media being linearised. A popup will
request a name for the curve.

LR L

s

3
LR E L

Note: The Customise Patches and Use Lab options are new to Blackmagic Versions 4 & 5. If viewing curves loaded from
a Version 3.x or earlier database, the options will be unavailable until the Update Legacy Curves option is selected from
the Measurement panel contextual menu (see below).

There is no need to update Version 3 curves if your printer is performing satisfactorily. However, there have been
significant improvements made to the Lineariser so it is worth considering re-linearising with Version 5.

Available Media
This panel displays a list of available Media. Select a Media to view its current linearisation curves and data, or to
linearise a new Media.

Any changes made are applied to the currently selected Media.

Linearisation History
Shows a list of all the linearisations performed for the selected Media, allowing the user to track the performance of the
output device.

The following sort columns can be selected using the contextual menu on the column header bar. Column order can be
changed by dragging and dropping the columns into the desired order, or by using the Configure Headers option in the
context menu:

¢ Date - Date and time the linearisation was measured.
¢ Type - Shows whether each linearisation curve was measured in Density or Lab mode.

The panel has one (1) button:

e Trim To - Trims the number of stored histories to the value shown from oldest first.
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The following options are available from the context (right click) menu within the History list:

¢ Show Charts - Launches a separate window that plots the linearisation history of the Media/Gradation Curve
on various charts (See below for further information on the available charts). Checkboxes at the top of the
window allow you to choose which ink channel to view. Shift+click to view another channel at the same time.
Double click a channel to see all.

* Revert to this Date - Reverts the linearisation curve assigned to the Media to the selected, historical
(previously measured) curve.

¢ Unload - Unloads the historical curve data being viewed in the Measurement panel and loads the currently
assigned curve.

Measurement
* Curve Name - Displays the name of the Linearisation Curve currently selected. This can be the saved curve
assigned to the Media or a selected History item.
* Last Linearised - Located top-right above the measurement panel, Last Linearised displays the date and time
the printer/media combination was last linearised.

The display shows the colour-coded linearisation patches for each ink channel. The patch number and the Dot % it
represents are listed across the top of the panel. Measured Values (Density or Lab) are shown within each patch. If no
values are present, the Media has not yet been linearised.

Advanced Options

*  Yule Nielsen Number - Enter the YN number if you know what it is for the media in use. The default is 2. The
Yule Nielsen number or N-Factor is used to compensate for dot spread on different media types. This is
basically a “fudge factor” added to the standard Murray-Davis formula used to calculate dot area from a density
reading. An N-Factor of 1 means no compensation is made and just the Murray-Davis equation is used. An N-
Factor of 2 seems to work well with most media types. As adjustments are made, the curve preview on the
graph will change, showing the effects of the value entered. Further information on the Yule Nielsen Number
can be found below.

* Maximum Densities Override - Enter a value to limit the top end density for each of the process colours. The
default is 0 (no override). As adjustments are made, the curve preview on the graph will change, showing the
effects of the value entered. Further information on Maximum Densities Override can be found below.

Densitometer/Spectrophotometer
* Device - Select the appropriate instrument from the pull down list of devices.
Note: The Embedded Printer Spectro option is only available when in Lab measurement mode (Use Lab
enabled).
* Instrument Standards - Choose from the list which instrument standard is to be used for measurement. This
will only appear when Use Lab is not enabled.
* Measure - Connects to the selected instrument and prepares to read patches. The patch window changes to a
measuring window and the instrument list changes to a text field where instructions are displayed.
¢ Print Chart - Print the appropriate chart for the selected instrument to the Media selected. You will be
prompted with an options window with the following:
o Cancel Printing - Cancels the action and returns to the previous window.
o Don’t Apply. Print to Linearise - This will disable all colour management except for Paper Profile. Use
this to make a Linearisation Curve.
o Yes. Print to check Linearisation - This applies all colour management so you can check a
Linearisation.

Curve
This panel shows the Linearisation Curves for each ink channel.

Select individual channel checkboxes to view a channel. Shift+click to add more channel curves to the view. Double click
a channel to show all curves.

Show Charts

Selecting Show Charts will display another window with a chart for each channel in the linearisation curve. At the top of
the window is a series of tick boxes, one for each colour. Selecting one displays the single colour and hides all others.
Selecting another box changes the graph to that colour. Select the same colour again and all graphs will be displayed.
Use SHIFT+Click to show more than one graph.
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Chart Types

There are five (5) chart types available for selection:

Density / History - Plots the date of the curve on the X-axis and the density values .
for each patch on the Y-axis. If the density begins to drop off, it will be displayed in S ——— -

the chart.

Dot % / History - Plots the date of the measurements on the X-axis against the dot
percentage on the Y-axis. The points on the chart represent the patches. For any
patch, the effective dot % and how it varies across the history is shown.

Dot %

nsity

Det

Density / Patches — Plots the patches along the X-axis and the density on the Y-axis.
For each patch in the history, a point is placed on the graph. If the density for a
given patch does not vary greatly, the points will appear on top of each other.
Where there is some change, a line will appear between points.

Dot %

Date

Dot % / Patches - Plots the patch number along the X-axis against dot percentage
on the Y-axis. A diagonal line from 0 to 100 is shown as a guide to a linear curve.
This graph will show if the patches are generally higher or lower than a linear
measurement, as well as differences over the course of time.

Dot % Delta / Patches - Plots the patch number along the X-axis against the dot
percentage delta on the Y-axis. It shows the percentage difference from the target.
For example, if the target is 40% and the measured value for that patch is higher
or lower, the error is shown in the graph.

Dot % Delta

Patch Number

Serendipity Blackmagic User Manual - Version 5.4

100



Yule Nielsen Number
The Yule Nielsen Number is essentially a “fudge factor” applied to the standard Murray-Davis formula used when
calculating dot percentage area from density.

The value is used to compensate for various media types, as some react differently to others in the way a dot will
spread on a particular media and thus affect the dot percentage value. It is sometimes helpful to change the YN number
(and some manufacturers will quote a YN number for a given media) but this is rare.

The YN formula used for calculating the dot percentage is:

-dot

YN
1-10 dot is the value of the density being measured
Dot %= — x100%
%‘I\‘d solid is the density of the solid patch
1-10

Therefore, a YN value of 1 has no effect on the dot percentage area. A value other than 1 will compensate for the dot
spread on the media. If the YN is greater than 1, the Dot % decreases and if the YN is less than 1, increases.

. M R A | ]
T.hlS can be seen from the graph on the | YN=1 YN =2 YN=05
Lineariser: [ |

The curves display the compensation; therefore if the YN number is less than 1 the dot percentage calculated is
increased so the curve applied will go down. The reverse is true for a YN number greater than 1.

For most of the testing done during initial development, the value of 2 (the default setting) seemed to work well. It was
also noted on occasions, better results were obtainable by setting different values for each process colour.

Note: As the ICC profiles are created after Linearisation, any value entered will be used for printing the ICC chart and
will affect the output. This means when the ICC profiles are applied, the same YN number must always be used in the
Lineariser to obtain correct results.

Maximum Densities Override
The Maximum Densities Override allows the user to cap the top end density to any value less than the maximum value
read.

If a value less than the highest value measured is entered, the curve will change. The top end will move down and the
rest of the curve will adjust to compensate for the new end position. The values in the middle of the curve will also
change.

Pros and Cons

There are various arguments for and against setting a maximum density override. In general, the Match ICC profile
would set the maximum density values so there should be no need to set them here. However, some users have found it
to be an advantage to set the values to the target densities required for the final proof output and in doing so, have
achieved very good results.

Reducing the density of the output used to print the ICC chart will affect the gamut. However, as the gamut of a press is
generally smaller than that of a proofing device, this may not have any noticeable effects.

It is desirable to drop the top end densities of the output prior to ICC creation, as sometimes there is a need to boost the
values after ICC is applied. This should only be used as a last resort and is not desirable as a general rule. If the top end
densities drop, the ICC profiles are generally to blame and therefore should be corrected.

Note: It is the Match ICC profile that has the biggest bearing on the output and sets the output top end densities.
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Monitor
The Monitor application is an alternate user-configurable version of the Jobs application, central to the Serendipity
Client interface (see Applications > Jobs). Like Jobs, it displays jobs before, during and after processing and allows users
to manage jobs through the system to plot their progress. The Monitor = ——
provides feedback from the Server and Client via logs. Modules can be |z =
added and configured to suit specific requirements. See the Modules
section for further information.

The Monitor consists of one or more user-defined tabs. Modules are
added, positioned and sized according to individual preferences.
Settings are saved at the Client level, enabling Serendipity Clients on
different systems or in different departments to display information
appropriate to their location.

The Monitor can be in one of two modes - Edit or Use.

Edit

This mode allows the user to move and resize modules on a tab. The mouse pointer changes to a cross when in Edit
mode. Resize a module by grabbing the corners or sides and dragging to the preferred size. Click anywhere in the
modules and drag it to the desired position. Modules close together will snap-to each other.

While in Edit mode, all Modules have a contextual menu available (right-click) with the following options:

* Remove (Module) - Removes the module from the Monitor tab.

* Set Size For (Module) - Allow the user to enter a width and height (in pixels) for the selected module via a
resize popup.

* Duplicate (Module) - Duplicates the selected module. The duplicate has all the size, layout and configuration
options of the original.

* Use Layout - Switches the Monitor to Use Mode.

Use
This is the normal user mode. It locks the module sizes and position and allows you to configure the modules
preferences and manage jobs. Select this after Editing to use the configured layout.

Menu Options

Layout
¢ Edit - Switches the Monitor to Edit Mode (see above explanation).
¢ Use - Switches the Monitor to Use Mode (see above explanation).
* Dynamic Update - Enables or disables updates to the modules while in Edit mode.
* Show Titlebars - Shows or hides module titlebars.
* Add Modules - See the “Modules” section for further information on each module.
* Load - Loads a previously saved Monitor configuration.
* Save As - Saves the current Monitor configuration.
* Search Ul (User Interface) - Activates a search bar for finding buttons and functions in the current Monitor tab.
Note: Module Toolbar functions can only be searched if the toolbar is open.

* New Tab - Creates a new tab.

* Rename Tab - Renames the currently selected tab.

* Duplicate Tab - Duplicates the currently selected tab and all modules within it.

* Choose Tab Colour - Allows the user to select a colour for the currently selected tab.

* Choose Tab Image - Allows the user to select an image for the currently selected tab background. Valid types
are PNG and JPEG. It is recommended a large image not be used, as it will take up memory.

* (lear Tab Colour/Image - Reverts to the default background colour.

* Remove Tab - Deletes the currently selected tab.

¢ Remove All Tabs - Deletes all tabs.

* Next/Previous Tab - Switches to the next or previous Monitor tab (right or left).

Reordering Tabs
Tabs can be moved to a new position by clicking on and dragging the tab to the desired place in the order. A red pointer
appears, showing the drop point between two tabs.
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Press Agent

The Press Agent application allows Blackmagic (available via the Blackmagic Softproofing Add-On) to be connected to a
Press console through a network port. After selecting the appropriate Press Agent Driver, a press operator can load or

turn softproofing jobs/pages using press console buttons.

Other options include interfacing with a press desk camera. The press operator turns a hardcopy page on the press
desk - Press Agent will use the page recognition data from the camera/console to automatically load the correct left and

right pages, or page spreads.

Log

The Press Agent window has a central Log panel to show
events/messages/commands received from the press console
while the Agent is active.

The following sort columns can be selected by using the
contextual (right click) menu on the column header bar. Column
order can be changed by dragging and dropping the columns, or
by using the Configure Header option from the contextual menu:

Press Agent - sdman@goiem swdevel serendoty-software.com 2u:9100 - NiR (not for resale)

Export

Configure Headers.

.....

*  Press - The Press console that generated the event/message/command.

¢ Date - The date and time of the event/message/command.

* Message - The event/message/command generated by the press console.

Log Options

* Fetch Back Log - Displays the log for the time specified. For example, it retrieves and displays the last 4 hours

of messages. Choose the time from the dropdown list.

¢ Trim Older Lines - Trims the log based on the time selected in Fetch Back Log. If this is set to 60 minutes, the

log file is trimmed back so only the last 60 minutes remain.

¢ Export - Allows you to export the log to a HTML or tab delimited text file.

Interface Options

* Press Agent Driver - Select the required Press Agent Driver from the dropdown list of supported press

consoles.

* Configure - Opens a Configuration pop-up for the selected Press Agent Driver. Available options vary

dependent upon the press console driver.

* Configure is not available while the Press Agent is running. Hit Stop if settings need to be changed.

e Start/Stop Button - Starts or stops the Press Agent.
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SoftProof

The Softproof application is used to proof a job on the screen. There are many tools available to check every aspect of
the job at any stage of production or processing. SoftProof can be used in conjunction with or instead of a hardcopy
proof. Using a calibrated monitor and configured press settings, proofs can be viewed and verified onscreen with
precise colour accuracy.

All job plates are shown and can be turned on or off, or changed as desired. Colour attributes and plate characteristics
can be changed to see the effects of different printing processes, including paper types and the effects of show-through
from the reverse side. The data can be exported to various file formats, including CIP3 and PDF. An Ink Key Viewer can
display a job as it would be on the press, with the values for each key shown. The ink weight can also be calculated and
over-ink areas identified. The proof can also be verified using the Displays application to give a pass or fail status in
accordance with chosen colour standards.

Layout
The SoftProof application consists of a large, central viewing window for jobs; a visual Tools menu on the left and a
View panel to the right; a Navigation Thumbnail at the top right; and a status bar along the bottom of the window.

Navigation Thumbnail

This thumbnail shows the entire image loaded for softproofing. The area currently shown in the
main viewing area is represented by a rectangle on the thumbnail. Mouse over and left-click to
view a new area of the proof.

Status Bar

This bar shows the information about the currently loaded proof, the SoftProof Press Setting and the current
calibration status of the monitor in relation to the
Press Setting (see Applications > Displays for more  |SoftProof - Nested job 19078 (Printed preview) 50% « Auto Softproof Camera
information on screen calibration).

The left of the bar displays:
* Jobname (Original/Printed Preview) and current zoom level %
The right of the bar displays:

¢ Current Press or Camera settings, along with the Embedded ICC Profile for the image (if applicable). Use the
tick box to override the currently selected Press or
Camera profile and enable the embedded ICC Profile.

Auto Seftproof Camera [V Embedded ICC Profile: Adobe RGB (1998)

Clicking on the Press or Camera profile button will popup a menu with the option to choose
another Press/Camera setting if available. [- Auto Softproof Camera

.

. . X v’ @ Auto Softproof Camera
When Calcheck Managed is enabled (Client Preferences > Colour Management) a small tick @ SRCB V4 ICC

or cross representing the Calcheck status will be displayed in the status bar at the bottom

right of the SoftProof window. Chogse Gamen...

Hovering the mouse pointer over the cross or tick shows a tooltip (when Tooltips are enabled) displaying information
including:

¢ The ICC Profile used by the monitor (normally created using the Displays ;‘sfftf??)‘: ‘
application, Calibrate option). Eores newer

* The Calcheck Chart assigned to the Press/Camera Settings currently used in |~
SoftProof and the current Calcheck Status of the monitor.

Expires: Never

Filename:

fhome/mandy/Library/ColorSync/Profiles/iMac-070911.icc
i
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Click on the Tick/Cross to popup a menu with the following options:

Calibrate - Begin calibration of the monitor using the current settings and Spectrophotometer assigned in the
Displays application. Once calibrated, the monitor ICC profile is
automatically saved as the operating system default replacing the
previous ICC profile.

£

TeT

.
Calibrate
Calcheck monitor (MediaWedgeV3 ISOcoated_V2_eci (Fogra39 )}

Note: When calibrating or calchecking, the Spectrophotometer assigned in the Displays application for either tasks
should be connected and ready for use. If the instrument is different to the assigned one an error will occur, ceasing the
operation. It is recommended to check the appropriate Spectrophotometer has been assigned before using the Calibrate
or Calcheck Monitor functions (see Applications > Displays).

Calcheck Monitor (Chart Name) - This option will open the Displays application and begin a Calcheck of the
softproofing monitor using the Calcheck Chart assigned to the current Press settings. The chart is named in
brackets. The pass/fail status may change as a result of the check. Detailed results can be viewed in the History
area of the Displays application.

Note on Spot Colours: When performing a monitor calcheck from the SoftProof application, any special/spot colours

included in the currently loaded job are measured and added as extra patches to the end of the Calcheck Chart.

Tools

- H g P

Pan (H) - Navigate around the image by clicking and dragging the job around the screen.

Zoom (Z) - Zoom in or out of the job. Clicking the mouse zooms twice the current percentage factor.

SHIFT+Click will zoom out half the percentage factor. Click and drag over an area to zoom it.

Note (N) - Create, manage and delete notes.

Measure (I) - Take a measurement on the image. Use the shift key to draw straight lines.

Crop (C) - Crop an image and resubmit it.

Guide (G) - Display guide lines on the image to check for alignment. Change the orientation by

pressing SHIFT. ESC will remove the guides.

Spectro (X) - Take measurements of the job being viewed. A popup window will appear displaying

the Lab/Lch/XYZ/Density values at the point the Spectro cursor is onscreen.

Veripress/Blackmagic Softproofing Add-On only - Additionally, the Spectro Tool gives the user the option to
choose an instrument which can be used to measure a hard proof. The measurement taken is compared to
the softproof and the deltaE displayed onscreen.

SoftProof Widgets

There are four (4) sliding widgets available from the left panel of icons in the SoftProof viewing window.

4
(1
L
@

These include:

Channels (Shift+C)
Publications (Shift+P)

Ink Keys (Shift+])

Get Info (CTRL+I / CMD+I)

Channels Widget

The Channels Viewer shows the channels or plates of the job currently being
viewed in SoftProof. Plates can be turned on or off by clicking the relevant
coloured checkbox to the left of the plate name and can be reordered by clicking
and dragging to a new position. The plate colour and associated attributes can be
changed by double-clicking and choosing another Special Colour Set from the
library, or edited for that SoftProof instance only.

Name - The plate name. The checkbox indicates whether or not the plate
is displayed.
Value - The percentage of colour at the point of the cursor in the window.
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Total ink displays the total amount of ink at the point of the colour selector, i.e., the sum of all plate
percentages. For RGB it will show the relative RGB values only.

The contextual menu (right-click) reveals additional options for non-RGB jobs only:

Choose Plate Colour - Select a plate colour from a Special Colour Set for the selected channel. Double-clicking
will display the same Special Colour Set window.

Choose Paper Colour - Select a colour from the Special Colour Set to use to simulate the paper colour. Once set,
the option to revert becomes available.

Edit Plate Colour - Displays a colour editing window to edit the selected colour for the current SoftProof
instance only. The edits are not stored in a library.

Apply a Replace Colour Set - Select a Replace Colour Set to apply to the job. Any plates matching the set will be
replaced.

Revert All Plates to Press Settings — Changes all plates back to the press configuration currently selected.

Apply Blueline Set - Replaces all colours with varying shades of blue to see any traps or bleed issues.

Publications Widget
When softproofing a job that forms part of a publication, additional controls and [i&
. S
view options are available: : PR
£ Sr Bt Page
° e

Single Page — Display just the single page selected. Disabling this option
enables the following:

o Show Back Page - Display the reverse side of a page through the : cctonono
page currently loaded, as if the final print was being held up to
the light. The Back Page Opacity setting in the Press Settings
controls the amount of show-through.

o Show Page Spread - View the spread of the selected page, for example, pages 2 and 3 as a spread.

Edit Imposition - When an imposition flat is loaded, changes can be made to the Signature Group here without
closing SoftProof. Any alterations can be viewed using Signature Overlay.

o Show Signature - Overlays the signature used to de-impose onto the image. This is only available if the
job has been de-imposed.

o Show Deimposed Pages - When an imposition flat is being viewed, SoftProof will show all available
pages when this is enabled. Each page from within the imposition may be previewed via the Page
Index tab.

Ink Keys Widget
The Ink Keys icon will display the Ink Key Viewer containing the loaded image in the SoftProof window.

At the bottom of the window will be a series of ink keys. Colour bars give a
graphical display of the proportion of each ink contained within the job across the

keys.

For each key selected, the relative percentage of ink for each of the plates is
shown. An information panel runs down the right side of the window. The top of
the panel shows information about the currently loaded Press Settings. Job view
and placement can be changed and ink weight can be calculated for any job.

Colour checkboxes - Positioned above the image, these show the inks or '

plates used in the job. Cllcklng on one will turn the gthers qff and leave the —— fr—)
ticked colour on. SHIFT+Click allows for multi-selection of colours.

Double-click to show all.
Ink Keys - The keys at the bottom of the window show the inks selected to be viewed on a graph. The scale of
the graph varies, depending on the amount of ink in the job. Hovering over or clicking on an ink key will display
the key number and its ink values at the bottom of the information panel.

Press Settings - Shows the values for the currently loaded press. Click the box to show or hide the details. Press
settings used are selected in the Default Press panel of the SoftProof Settings.

Show Excess Ink Weight Area - Display areas exceeding the Maximum Ink Weight setting as defined in the
Press configuration.
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Max Ink Key Value - Set the size of the ink keys to match your press. Ink values are calculated based on the size
entered. If the size is 100, percentages are displayed.
Sheet Placement - Show the job as positioned on the press sheet defined in the configuration. The job can be
centered (selecting the Centre checkbox), or offset from the left (X) and bottom (Y). De-selecting this displays
the whole job in the viewer and changes the ink keys to show total ink amounts for the job.
Ink Weight Calculator - Calculate the amount of ink required to print (x) number of copies.

o Print Run Size - How many to print.

o Ink Weight (g/m?2) - Enter the weight of the ink used in grams per square metre.

o Calculate - Based on the values entered for ink weight and print run size, the total weight of ink for

each colour will be calculated for the loaded job and displayed in the ink value area.

Contextual (right-click) menu options include:

The Get Info icon will display job information about the currently viewed image in SoftProof -
how it was processed, what Pagesetup and Media were used and other useful processing
information. Click the icon again to hide the panel.

Get Info Widget - =
T el

Loupe
The Loupe is available via the sidebar menu. Once opened, the Loupe will appear
with the default setting “Loupe to Mouse” enabled.

Loupe Options (accessed via the Spanner icon):

Show Ink Key Table - Shows a separate window, listing the ink key values of all keys for each plate. These can
be printed using a local printer or exported to PDF.
Export Tab Delimited - Exports the values for the keys and ink values to a tab delimited text file.

-\gn-ng and prod

and df

Screened Pixel Readout (Veripress/Blackmagic Softproofing Add-On
only) - Toggles the HUD between crosshair point measurement of ink
percentages and a square for measuring area average dot percentages.
The square resizes depending on the zoom level to always cover an area
equal to a full halftone cell at the LPI defined in the SoftProof Settings.
Screening LPI - Enter the desired value for screen ruling for SoftProof in
Lines Per Inch (LPI). The defaultis 150.

Loupe to Mouse - This is enabled by default. The mouse pointer location
is used as the reference point for the Loupe display. This allows you to
position the Loupe off image and use the mouse to display the relevant
part of the image within the Loupe for proofing.

Rulers — Turn rulers on or off. The rulers will appear in the Loupe window with measurement units displayed.
The rulers are centered or at the mouse pointer location if held over the Loupe window.

ucing quality
t materials and glesigns, and
2 is properly

Ty O et

fNO Loupe Options

__ Screened Pixel Readout

erUEODTNLa A

Screening LPI | 150

W Loupe To Mouse
__ Rulers
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The Loupe is moved around the SoftProof by left-click and holding to drag it.

The Loupe can be resized by clicking on the button with 3 lines (see image) and dragging outwards. The mouse scroll
wheel will also increase/decrease the Loupe size when the mouse is positioned over the window.

A number of display and control options are available via the buttons at the bottom of the Loupe window:

+ (button) - Click to increase the zoom factor of the Loupe. The zoom factor is displayed at the bottom centre
of the Loupe. Note: 100% = the resolution at which the proof was originally imaged, i.e., 1 screen pixel is 1 job
pixel.

- (button) - Click to decrease the zoom factor of the Loupe.

Spanner - Opens the Loupe Options window.

Eye - Displays the HUD (Heads Up Display) showing the CMYK dot percentages at the centered crosshair or
within the average percentage box. If the image is RGB, the relevant R, G and B values will be displayed.
Show/Hide Channel HUD Toggle (Veripress/Blackmagic Softproofing Add-On only) - Show or hide the
SoftProof Channels Widget. Only visible when a job contains too many plates to fit in the Channel panel of the
HUD.

SoftProof Menu Options

File Menu

Open Files - Load an image file directly into SoftProof. Supported file types are Canon RAW format (CRW),
JPEG, PNG, PPM, Serendipity Blackmagic Image, TIFF and Adobe Photoshop PSD.

Open Jobs - Load completed jobs into SoftProof. The Imaged (Original) or Rendered (Printed) file may be
viewed.

Save - Save the preview as a Blackmagic Image File. This can be submitted or placed in a hot folder, or on a
DropSpot.

Export - Export data from SoftProof. The available formats are CIP3, PDF, Postscript (Separated) and TIFF
Multichannel.

Submit - Submit the current job to a Media and Pagesetup with any changes. This re-images and re-renders the
file. When submitting the image to be processed again with any relevant changes, the current image resolution
is submitted. If the resolution is restricted in the Server Settings, this is the resolution that will be used.

Edit Touch Console Ul (Veripress/Blackmagic Softproofing Add-On only) - Opens an edit interface window to
allow the configuration of the enabled (visible) buttons for control of SoftProof in the Main screen of the Touch
Console. Buttons are enabled or disable by clicking on them. Any disabled will appear with a red cross and will
be excluded from Touch Console when using it to view softproofs. The Toolbar has a preview checkbox to see
how the Touch Console controls will appear and a Reset button to restore and enable all buttons.

SoftProof Settings - Opens the preferences for SoftProof, allowing for configuration of default viewing
conditions. See below for further information.

SoftProof Settings

The SoftProof Settings allow you to select viewing preferences including how to load a job, and the quality and press
settings used to produce accurate proofs. The settings window is split into three (3) tabs - View Options, Default Press
and Default Camera.

View Options

Window

On Load

800 _ SoftProof Settings

TIM| Default Press | Default Camera |

(] Allow Multiple Windows

Status Bar Siz

Allow Multiple Windows - When enabled, allows jobs to be opened and

viewed in separate SoftProof windows. If disabled, each job viewed will Honour Embesed CC Pofes
appear in a tab running along the top of the same SoftProof window. If a — :
job is dragged and dropped into SoftProof from the QueueManager, it will Cloteiech s
replace any open image in the viewing window selected. St s
Status Bar Size - Select the size of the status bar text from Small, Medium @ ..

or Large. e ——
Rulers - Show or hide the rulers. Cene @ orzonaly (1 Vertcaly

Scrollbars - Show or hide the scrollbars.

Cancel | [ 0K ]

Honour Embedded ICC Profiles - When enabled, this will honour any
embedded ICC profiles when viewing the image in SoftProof.
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Rotation - Control the orientation of jobs when they first load. The option None leaves the job in its imaged or
rendered orientation.

Zoom Level - Select the default zoom setting. All fitting zoom modes calculate the size based on the monitor
resolution. This is set in the Colour Management tab of the Client Settings.

Show Back Page - (Checkbox) Toggles whether publications with consecutive pages will open in SoftProof
displaying back page show-through (based on Press settings) by default.

Publications

Image

Enable Pager Thumbnail - Enable or disable the thumbnail viewer when viewing a publication. When enabled,
a thumbnail of the page appears when the mouse pointer hovers over the page number box.

Enable Pager Sections - When enabled a Section label/button is displayed above
the pages in the SoftProof Page Index panel. This allows for loaded multi-section
publications to be viewed one section at a time, displaying the page range within
each section. Clicking the section label bar will open a menu to choose which
section to view or to view all sections.

All Sections

001
002

Resampling Algorithm - Set the resampling algorithm for jobs as they are viewed in
SoftProof.

Screening LPI - Enter the desired value for screen ruling in lines per inch (LPI). The default is 150.
Centre - Select to align any images opened in SoftProof either Horizontally or Vertically or both.

Default Press
The default press tab allows the selection of a Press configuration from the database

to be applied to the loaded jobs and for all subsequent jobs loaded in SoftProof.
Press 1 - The default press used for softproofing jobs.

Press 2 - Assign an alternate press configuration for publications that include pages
printed on a different stock, e.g. glossy magazine covers.

An information window shows the settings of the currently loaded Press setup.
Configurations are managed in the Workbench and contain information such as size,
number of keys and colour information.

Default Camera

1016.00mm
762.00mm
30

W Press2... | Newspaper (Fogra 42)

1016.00mm
762.00mm
30

Cancel | [0k ]

The default camera tab allows for the selection of a Camera configuration from the
database to be applied to any loaded jobs using an RGB colourspace. If Honour Embedded ICC Profiles in the SoftProof
Settings is unchecked and the RGB image contains an ICC profile, the default camera configuration will be used in its

place.

An information window shows the settings of the currently loaded Camera setup. Camera configurations are managed
in the Workbench and contain information such as the ICC profile to be used, rendering intents, black point
compensation and Calcheck Chart reference.

View Menu ES— .
Select menu items are also available as icons within the SoftProof window (see image). % %l | ‘"’] +
* Tabs - Control the tabbed viewing of images in SoftProof. [e——
o New tab - Opens a new, empty tab ready for a job. Use the Open Job option El! o ,Q
or drag and drop a job from the QueueManager to view it. P~ 4\| Q’i = 1 ]
o Close Tab - Close the currently selected tab. E 6‘79:6
o Next Tab - Loads the next available tab. .
o Previous Tab - Loads the previous tab.

o Show Tab - Show/hide the tabs listed at the top of the screen.
Get Info - Display information about the softproofed job and how it was processed.
Show Page Boundary - Display a red line around the page area of the job.
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Show Notes - Display any notes attached to the job.

Screened Pixel Readout (Veripress/Blackmagic Softproofing Add-On only) - Toggles the HUD between
crosshair point measurement of ink percentages and a square for measuring area average dot percentages. The
square resizes depending on the zoom level to always cover an area equal to a full halftone cell at the LPI

defined in the SoftProof Settings.

Ink Weights - Opens a window displaying the ink weights (source and print inks) for the job.
Proof Colours - For use with RGB images only. Automatically select a Press Configuration to display onscreen

what the RGB image will print like using a specific Press profile. The

selected Press will appear in the status bar at the bottom right of the Tabs >
reen. Clicking the status bar button will allow you to adjust which

;(liofile is used.g g ] 9 GetInfo %!
Zoom In/Out - Zoom in or out of the image. [0 Show Page Boundary P
Show All - Fit the entire job into the SoftProof window. &= Show Notes #N
Show Actual Pixels - One pixel of the screen is equal to one pixel of the ® Screened Pixel Readout ~ *
job. This is shown at 100%. This view mode has the quickest load time & Ink Weights o3l
as resampling for scaling is not required. )
Show Actual Print Size - Show the print size of the job. =
Fit Width/Height - Fit the job to the height or width of the SoftProof @ Zoom In #®+
window. & Zoom Out 8-
90 CW - Rotate the image 90 degrees clockwise. %2 Show All %0
90 CCW - Rotate the image 90 degrees counter-clockwise. & Show Actual Pixels %81
180 - Rotate the image 180 degrees. [ Show Actual Print Size 382
Invert - Invert (negate) the image. = Fit Width 583
Mirror - Mirror the image. T Fit Height 304
Autocrop - Remove any whitespace around a job. There must be a
completely clear area on any one side of the job. 90 CW
Unsharp Mask - Apply an unsharp mask to the image. This will affect the 4~ 90 CCW
edges within the image. () 180

* Use Press 2 - Switch between Press 1 and 2 as configured in the = Invert
SoftProof Settings for non-RGB images viewed in SoftProof. W] Mirror

¢  Full Screen - Switch between full screen mode and window mode. 1§ Autocrop

¢ Thumbnails - Select the Thumbnails tab within the SoftProof window. Unsharp Mask

* Page Index - Select the Page Index tab within the SoftProof window. e5 Use Press 2

* Notes - Select the Notes tab within the SoftProof window.

* Loupe - Display a virtual loupe on top of the loaded image. The loupe (&1 Full Screen F
can be resized and magnification level changed if required. The current 7
magnification is shown at the bottom of the Loupe; 100% means 1 v £/ Thumbnails o
screen to 1 job pixel. i Page Index X

= Notes N
E3 Loupe L

Thumbnail Panel
The thumbnail panel displays a small image of any jobs currently open in SoftProof. Clicking on the
relevant image will switch the SoftProof preview to that window.

Notes Panel 5|n[Ee
Notes gives users the ability to draw a text box on the imaged Alalo/Ew
or rendered SoftProof to make a note. The note is attached to %@

the job file and remains attached until it is either deleted or the job is
removed from the system. There is no limit to how many notes can be
created, and they can be shown or hidden as required.

2
Check ink for red

Notes cannot be attached to files opened in SoftProof via File Menu > Open
Files. The file needs to be submitted as a job before any embedding of notes can take place.

When creating a note with the Note Editor, a configurable arrowhead pointer option is available along with the existing
area marker for a more precise commentary on the job. The User and Group of the note creator are also displayed (see
Secure Mode). Notes can be edited or the anchor adjusted by double-clicking on the Note.
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The Note panel displays any notes attached to the job currently selected in the main viewing window. There is also a
Note column in the QueueManager showing the number of notes attached to a particular job. The Notes icon on the left
menu bar is used when adding Notes to the softproofed image. The Notes icon in the right panel is used to display or
hide any notes on the image.

¢  Show Notes - Show or hide the notes on the preview. Notes can also be toggled by clicking the icon on the right
panel (see image above).

* Text - The text making up the note.

* User / Group - The User and Group responsible for the note.

Page Index Panel

The Page Index panel displays a numbered box for each page making up the loaded publication. This
allows for direct navigation to any page by clicking on the page number. Hovering the mouse over a page
number will pop-up a thumbnail for the page.

The page boxes are colour coded:

Light Green indicates the Publication pages are loaded and can be viewed. These show as dark green

when selected.
2 3

Purple indicates there are duplicate pages, i.e., they have the same publication name and page
numbers. Dark purple indicates the pages are selected.

R || ]

Clicking on these pages allows you to select and view the alternative page:

I 1[ I === I ===l — =1 ==

19532 GOLF TEXT.job (IMPOSITION) Page 7
19532 GOLF TEXT.job Page 007 (IMPOSITION 07)

22 2
38/ 3

Light Red indicates the page is not yet available for viewing in SoftProof. This normally occurs
116 11 /| when there are page number gaps if pages have not yet imaged or rendered; or when processing

a de-imposed publication with known (signature defined) page numbers. As the missing pages
image/render, close and re-open SoftProof to update the publication pages.
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Spectro
The Spectro application allows for the measurement of colours with a Spectrophotometer. The accuracy of the
measured value can be viewed against an imported value

when mapped through a selected ICC profile. ano oo 9108~ Gem s b 39 e

13
<

1111111

The window is split into two sections. The right side allows for S
the import and viewing of a Special Set, which is used as the ——
comparison base. The left side displays the measured values.

ace

Selecting a particular measured value matches the closest 000
colour of the imported set, giving it relative deltaE values. —M '<
These can also be filtered to only show the closest matches for et
better viewing,.

2322
122

0 item Rendering Intert  Relatve Colounmetrc B

Spectrsgrenrrerer (ow

Options Gy e-Oow

* Load Set - Select a Special Colour Set to load. This is
the set used to compare measured values with. Choose from any of the Special Colour Sets created.

¢  Match ICC - Select a Match ICC profile.

* Rendering Intent - Select the rendering intent for the Match profile.

* Spectrophotometer - Select your device from the list of supported Spectrophotometers.

¢ Activate - Connect to your selected device. Once connected, the pull down device list will change to display any
status messages from the device and the values measured.

*  Turn Off - Disconnects the connected Spectrophotometer. Alternates with the Activate button.

* Add - Select this to append to the list for each reading. If this is not selected, the last reading is updated. This is
available after the device has successfully connected.

* Ae - Select the value of deltaE to display for when comparing measured colours with those in a loaded set. This
is used in conjunction with the Show All Swatches option.

¢ Show All Swatches - Select this to view all swatches. By de-selecting this, only those swatches below or equal
to the deltaE value entered will be displayed. Colours within the defined tolerance values will show in blue.

Measured / Loaded Set Panels
The Measure and Loaded Set panels show the following information:

¢  Colour - A swatch visually representing the colour.

* Name - The name of the colour. This can be edited by clicking in the name field.
* Space - The colourspace of the colour (Lab or CMYK).

* Mode - The paint mode of the colour.

¢ Tint - The tint value of the colour.

* DotGain - The dotgain curve assigned to the colour (if any).

In addition, the Loaded Set panel displays the following:

e Ae/CIE94/CMC (1:1)/CMC (2:1)/Delta L/Delta a/Delta b - These columns list the relative delta’s of the loaded
set colours when compared to the selected, measured colour.

Export Menu

The Export menu allows for the measured values to be exported to a space or tab delimited file. Save all or only selected
entries and select the format for export:

* Lab - Exportjust the Lab values.

* XYZ - Export just the XYZ values.

¢ Lab XYZ - Export the Lab values followed by the XYZ values on the same line.

* XYZ Lab - Export the XYZ values followed by the Lab values on the same line.

* Separate Values With - Choose if the values are to be separated with spaces or tabs.

A contextual (right-click) menu in the Measured / Loaded Set panels has the option to Delete (a selected colour); Delete
All (measured colours); Print (the measured/loaded set to a system device); and Font Options.
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Studio
The Studio application is designed for the manual nesting or tiling of
jobs being processed and output by Blackmagic.

Jobs to be nested or tiled are submitted to an Asset queue before they
can be used in Studio. This can be done in a variety of ways:

¢ Submit Files as Asset option via the Submit Menu.

*  Submit As Asset button via the RIPMonitor module.

* Dragand drop files into the Asset area within Studio.

* Dragand drop files into the Layout area within Studio.

* Drag and drop files into an Asset dropspot within a
DropZone.

HIcs: Buems: o i

—

Submitted assets are visible in the Asset queue in the QueueManager and remain in the queue, even after printing, until
deleted from the Asset queue. This can be done via Studio or the QueueManager module.

Unlike other queued jobs, assets exist only as placeholder thumbnails until a manual nest or tile is submitted for
printing from Studio. The submitted jobs are then imaged, rendered and the nest is output, appearing in the

appropriate queue.

Studio Interface
The Studio interface is made up of four (4) sections:

* The main Layout area - where jobs (assets) are placed and nests

created.

* The Asset panel - displaying thumbnails of assets available for

nesting or tiling.

Asset,ii?rc.)ﬂpér v &
Template Pangls

Layout Area

Menu Options

The Property panel - defining the tiling document area, editable
media dimensions and frame properties.

The Template panel - where nesting templates can be loaded
from a library of saved templates.

Studio Menu
Save New Template - Saves the current frame layout to the Template library. The untitled nest can be renamed
by clicking on the text “Untitled”. Only frames are saved, not the images within them.
Save Template - Saves the current nesting layout to the selected template from the library, overwriting any
existing data.

Remove Template - Removes the selected template from the library list.
Export Template - Export a saved template (or templates) to a user-defined location.
Import Template - Import a saved template. The imported template (or templates if multiple layouts exist in
the file) will appear in the library list when loaded.
Print / Print Tiles - Displays a chooser window to select a Media and Pagesetup combination to send the job to
for processing.

¢ Studio Settings - Access the preferences for Studio. These include: .00 Studio Settings
o Cloak Submitted Frames - Locks images and frames after they have
. . . . Cloak Submitted Frames |_!
been submitted for processing, preventing changes. Cloaked images
will appear shadowed. Avtosplace &
o Auto-place - Allows for the automatic placement of assets onto the Auto-place Spacing (025
Layout area when dragging and dropping them. The default position Snap To Grid [
is top left. If a job has already been placed in the area, the auto Grid Size[0.25 In
position will align with the left side of the frame. Faner e ing Cropmaria i
o Auto-place Spacing - The distance (gap) between jobs being auto-
placed in the Layout area. (Ceancel
o Snap to Grid - Allows for assets to snap to a user-defined grid
spacing, measured from the left ruler. The asset frame will snap to the closest defined grid position,
taking into account any auto-place spacing settings.
o  Grid Size - Define the snap-to-grid size for frame placement in the Layout area.
o Paper-saving Cropmarks - Enabled by default. Cropmarks will appear in paper-saving mode when the

option is enabled via the Property panel. Only available when using Studio.
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Edit Menu

Undo - Undo the last change made. The amount of available undo levels is configured via the Client Settings (0
= Operating System default level).

Redo - Redo the last undone change. The amount of available redo levels is configured via the Client Settings (0
= Operating System default level).

Cut - Cuts the currently selected frames to the Clipboard.

Copy - Copy the currently selected frames to the Clipboard.

Paste - Pastes the frames in the Clipboard to the Layout area. Paste is centred at the current mouse pointer
position.

Delete Assets — Deletes any selected assets from the Studio application and the Asset Queue.

Create Crosshair (SHIFT+1) - Create a frame containing a configurable crosshair in the Layout area.

Click on the E box within the Property panel to view further options.

Create Horizontal Line (SHIFT+2) - Create a frame containing a configurable horizontal line in the Layout area.
Click on the E box within the Property panel to view further options.

Create Vertical Line (SHIFT+3) - Create a frame containing a configurable vertical line in the Layout area.

Click on the E box within the Property panel to view further options.

Create Colour Box (SHIFT+4) - Create a frame containing a configurable colour in the Layout area.

Click on the E box within the Property panel to view further options.

Note: For all Create options, a 1x1linch frame will appear at the current mouse pointer position if using the shortcut
keys. If selected from the menu, the frame will appear in the centre of the current Layout view.

Special Characters - Displays a character map for selecting any special text characters or symbols.

Frame Menu

Bring to Front - Move the selected frame to the front (top) layer of the layout.

Bring Forward - Move the selected frame one layer forward (up) in the layout.

Send Backward - Move the selected frame one layer backwards (down) in the layout.

Send to Back - Move the selected frame to the back (bottom) of the layout.

Group - Group multiple selected frames for movement, deletion, locking or asset multi-drop.

Ungroup - Ungroup any currently grouped frames.

Align Left - Align grouped frames along the left edge of the leftmost box in the group.

Align Right - Align grouped frames along the right edge of the rightmost box in the group.

Align Top - Align grouped frames along the top edge of the uppermost box in the group.

Align Bottom - Align grouped frames along the bottom edge of the lowest box in the group.

Align Horizontal Centre - Align grouped frames along the averaged horizontal centre line of the frames in the
group.

Align Vertical Centre - Align grouped frames along the averaged vertical centre line of the frames in the group.
Orient Up / Down - Alters the frame orientation to either upright or upside down (180 degree rotation).
Orient Right / Left — Alters the frame orientation to either right or left by 90 degrees from the upright position.
Lock - Lock the selected frames. Locked frames appear transparent and cannot be edited until unlocked.
Unlock All - Unlock all currently locked frames.

Decloak All - Decloaks all frames. Allows for movement, deletion or editing of frames that were locked/cloaked
after submission (only available when Cloaking mode is active).

Select All - Selects all frames in the nest layout area for grouping, ungrouping, movement, locking or deletion.
Frame properties may be adjusted and will affect all selected frames and their positions within the layout area.
Select Inverse - Deselects current frames while selecting all previously unselected frames.

Step and Repeat - Allows users to create a set of size specific frames for image placement or copy the
dimensions of existing frames and repeat them across and down the Layout area.

Auto arrange - Automatically arranges (nests) the images placed in the Layout area to fill the media
dimensions.

Auto arrange with Rotation - Automatically arranges (nests) the images placed in the Layout area to best fill
the media dimensions by appropriately rotating the frames.

View Menu

Zoom In - Zoom into the Layout area view. Holding down Z+Left click will also enable this function.

Zoom Out - Zoom out of the Layout area view. Holding down SHIFT+Z+Left click will also enable this function.
Fit All - Scales the Layout area view to show all frames currently in the nest.

Fit Document - Scales the Layout area view to show all assets and frames within the dimensions as defined in
the Document panel.

Print Size - Shows the nest in the Layout area at actual print size.
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Fill with Document - Scales the Layout area, filling the view to the shorter width or height dimension as
defined in the Document panel.

Full Screen - Toggles between a windowed or full screen view.

Asset - Toggles the Asset panel. F1 can also be used.

Property - Toggles the Property panel. F2 can also be used.

Template — Toggles the Template panel. F3 can also be used.

Sidebar - Toggles the view of the sidebar containing the Asset, Property and Template panels.

Section Headers - Toggles the headers of each section within the sidebar under each panel on or off.

As an added option, holding down the spacebar will allow you to pan around the Layout area when moving the mouse,
similar to a navigator used in graphics applications. The mouse cursor will change to a hand when enabled.

Studio Layout Area
The Layout area is where jobs (assets) are laid out for nesting or tiling.

The area is surrounded by a ruler, marked with the user-defined measurement units,
appropriately scaled to the current zoom level. All assets and frames are shown at
accurate relative size.

The dark gray area is the work surface onto which assets are placed and positioned. If
in tiling mode, the edges of the total area to be tiled appear on the work surface as a
red box.

2 L R I T IO I

Layout area with loaded template

Asset Panel

The Asset panel displays all jobs that have been submitted to the
Asset queue. Any assets that appear may be used in Studio for
nesting or tiling. Place assets by selecting with the mouse and
dragging+dropping them onto the Layout area. Assets can be
selected singularly or in multiples (see image example).

The Asset header bar has the following view options:

List View - Display assets in text form (filename/jobname).
A thumbnail preview of the image will appear at the
bottom of the panel.

Small Thumbnail - Display the assets as small thumbnail == =l ;;:;:na
images with the jobname listed beside them. il | Bkl |-

Large Thumbnail - Display the assets as a large thumbnail
image only.

A search field is available at the bottom of the panel. Enter text to find a jobname containing the search string.
Non-relevant assets are temporarily filtered out of the view as the string is typed. This search field will not
appear when in Large Thumbnail view. Clear the search box to view all jobs.

Property Panel
The Property panel displays information on defined elements used in the Layout area. Configurable measurements can
be entered using any supported unit (for e.g.,, 60cm, 32in) and will be automatically converted to the chosen default

measurement unit as defined in the Client Settings.

The panel has three (3) sections: Document, Media and Frame. Each section can be shown or D ‘,
hidden by clicking the appropriate box icon (see image right).

Document - Used to activate Tiling Mode and define the total area to be tiled.

Media - Set the media size for the printable area used when nesting or tiling. Set sizes are available from a
dropdown menu or custom dimensions may be entered in the width and height fields.

Frame - Edit parameters for the currently selected frame, including fields for size, orientation and scaling.
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Document
The Document section of the Property panel is used when tiling an image or nest of images that are larger than the
available print media.

When activated, a red box will appear in the Layout area, defining the
total area being used for tiling.

A media length (height) must be defined when using tiling mode. If using
roll sheet media, the length of paper to be used for each tile can be
entered into the Length field in the output settings of the Media itself
(see Workbench Data Types). Alternatively, the tile length can be entered
using the Height field in the Media section of the Property panel (see
below Media section for further information).

The dimensions entered will appear in the Layout area, tiled and
overlapped accordingly to cover the entire document area. After placing
and locking an asset (making it transparent) in the document area, you are able to preview how the image will be tiled
and overlapped onto each media sheet before submitting to print.

¢ Width - Total width of the area to be tiled.

* Height - Total height (length) of the area to be tiled.

¢ Tiling - Enable or disable tiling mode.

* Tiling Overlap - The size of image overlap for each tile.

Media

The Media section of the Property panel is used to define the print size of the media, be it a roll or sheet. The height
(length) does not necessarily need to be entered for roll sheet media. The Layout area will automatically adjust the
sheet guide length when assets are placed if a width has been entered.

* Page Size - Select a pre-configured page size from the dropdown menu or enter custom dimensions.
¢ Width - The width of the media being used for printing.
¢ Height - The height (length) of the media being used for printing.

Frame / Canvas Wrap / Marker

This section of the Property panel displays options for the currently selected frame. The frame and contained asset can
be edited from within this panel; the Canvas Wrap style can be applied to the frame and edited; or various markers may
be generated for use.

Frame

* Left - The offset distance of the frame from the left guideline. Offset is measured from the top left corner of the
frame.

* Top - The offset distance of the frame from the top guideline. Offset is measured from the top left corner of the
frame.

*  Width - The width of the frame. This field will lock when Canvas Wrap mode is selected.

¢ Height - The height of the frame. This field will lock when Canvas Wrap mode is selected.

* Lock Button - Locks the current proportions of the frame size if resized along one dimension. The locked
proportions are overridden by free resizing with the mouse within the Layout area. Frames can be unlocked
and resized to any required dimension.

¢ Cropmarks - Enable this to add cropmarks to the selected frame. The cropmarks will appear when viewing the
rendered (printed) preview in SoftProof. Cropmarks will appear enabled by default when Canvas Wrap mode
is selected.

Note: Cropmarks (Standard) will take up extra space around a job when selected for use, changing the position of
the job on the media and the total size of the job (once rendered). Cropmarks (Paper-Saving) will not expand the
rendered job size. The type of cropmark used is configured via the Studio Settings.

* Overprint - Enable this to convert the selected frame to overprint mode. Not available in Canvas Wrap mode.
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Canvas Wrap

Using an appropriate canvas print media (paper), the Canvas Wrap option allows you to turn any asset into a canvas,
ready for stretching around a wooden (or other) frame.

Canvas Wrap options include:

Front width - The width of the front of the canvas.

Front height - The height of the front of the canvas.

Frame thickness - The thickness of the canvas frame. The default size is 1.25in.
Back wrap - The length of canvas to wrap around the back, once the canvas is
stretched around the frame. This will always remain as an unprinted area. The
default size is 20mm.

Wrap style - The style of canvas to create. Further options are:

o Gallery - This is the default canvas style, stretching the image to expand
to the frame thickness as defined above.

o Mirror - This option will mirror the edges of the image to the frame
thickness as defined above.

o Colour - Select a colour to fill the frame thickness as defined. Double-
click the colour display box to select a colour from a Special Colour Set
(Blackmagic Only), or create a colour using the Lab, CMYK or RGB sliders.
Note: If the colour selected does not match the colourspace of the image,
a preview will not be available for viewing using the SoftProof
application.

NN Canvas Wrap Options

Canvas Wrap Options

Fromt width' (6.0 in
Front beight. 26647 in
Frame thickness: 125 in
Backwrap, 0.7874in

Weap style. | Callery

........

Colour 5pace %

“Cancel ) ((Sawe ) (Fit&Save )

Save - Saves the canvas wrap configuration but does not change the size of the asset (image) to fit the

dimensions specified if they have been altered.

Fit & Save - This option will fit the asset (image) to the configured canvas wrap settings and save the layout,

returning to the Studio screen.

Cropmarks are enabled by default when Canvas Wrap mode is in use. This is to assist in cutting the canvas. Two (2)
types of cropmarks are available for selection, configured via the Studio Settings - Standard or Paper-Saving
Cropmarks.

Note: Cropmarks (standard) will take up extra space around a job when selected for use, changing the position of the
job on the media and the total size of the job (once rendered). Paper-Saving Cropmarks will not expand the overall
rendered job size.

If multiple canvases are to be printed, a quick and easy method of duplicating a finished canvas is to use the Step and
Repeat function:

1.
2.
3.

4,

Marker

Configure the asset with the appropriate Canvas Wrap settings as defined above.

With the canvas wrap image selected in the Layout area, select Frame menu > Step and Repeat.
Configure the amounts for horizontal and vertical repeat and click OK. The canvas will repeat across the layout

area as the values increase.
Autoarrange if needed and print when ready.

The Marker option allows for the placement of a frame containing a style of marker in the
Layout area. Options include:

Crosshair (SHIFT+1) - Create a frame containing a configurable crosshair in the
Layout area.

Horizontal Line (SHIFT+2) - Create a frame containing a configurable horizontal
line in the Layout area.

Vertical Line (SHIFT+3) - Create a frame containing a configurable vertical line in
the Layout area.

Colour Box (SHIFT+4) - Create a frame containing a configurable colour in the
Layout area.

Marker Options

arker Type: | Crosshair )

Line thickses;

_Cancel ) (‘Save’)
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Click on the E box within the Property panel to view further options for each Marker style.

If a frame is selected in the Layout area and Marker is chosen from the dropdown menu, the frame and image in the
Layout area will be replaced with the selected marker.

Note: For all Create options, a 1x1linch frame will appear at the current mouse pointer position if using the shortcut
keys. If selected from the menu, the frame will appear in the centre of the current Layout view.

Marker Options include:

* Marker Type - Select from Crosshair, Horizontal Line, Vertical Line or Colour Box.

* Line Thickness - Set the thickness of the line for Crosshair, Horizontal and Vertical Line options. This does not
apply when Colour Box is selected.

* Line Colour - Select a colour for the line or box as selected above. Double-click the colour display box to select
a colour from a Special Colour Set (Blackmagic Only), or create a colour using the Lab, CMYK or RGB sliders.
Note: If the colour selected does not match the colourspace of the image, a preview will not be available for
viewing using the SoftProof application.

Content
The Content section within Frame/Canvas Wrap allows for the editing of the asset held within the frame. This is
available in both Frame and Canvas Wrap modes, but not in Marker mode.

* Left - The offset distance of the asset image from the left edge of the frame.
* Top - The offset distance of the asset image from the top edge of the frame.
*  Width - The width of the asset within the frame.
¢ Height - The height of the asset within the frame.
* Lock Button - Locks the current proportions of the asset if resized along one dimension.
* Scaling - The method of scaling used for any asset placed within the frame.
o To Fit - The entire asset image is rescaled and shown within the frame proportions.
o To Fill - The asset expands to fill the frame, scaling to show as much of the image possible, given the
proportions and centring options of the frame.
o Custom - The dimensions and frame offset of the asset are independent of the frame. This scaling is
selected automatically when Crop Mode is activated.
* (Centring - When enabled, any selected frames will have their asset centred within the frame. This is useful to
revert to the original placement when undoing any cropping.
* Orientation - The rotation angle applied to both the frame and the asset. If custom scaling is used and the asset
has different dimensions to the frame, rotation is only applied to the asset.

Asset  Peoperry o Template |

Template Panel

Templates are a useful tool for anyone needing to make repeat prints using a specific layout for the
available media. Studio gives users the opportunity to create and store a library of templates, set to
specific sizes and orientations.

Loading Stored Templates
Templates (nesting layouts) can be loaded from the Template library by double-clicking the name
of the saved template.

O Template with Tiling

Assets dragged into an empty frame are resized to fit or fill, rotated and cropped according to the o
frame’s settings. A singular asset dragged into a selected frame grouping will be duplicated and o
placed into every frame in the group. s
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Creating Templates

Templates can be created from existing asset files or by using the Step and Repeat function within Studio. Both methods
are outlined below. Templates saved when in Tiling Mode do not save the tiling setup, only the frame placement for the
asset.

To create a template from submitted asset files:

1. Select Submit menu > Files as Assets.

2. Navigate and select any files to use in Studio. Once the assets appear in the Asset queue/Asset panel they may
be used.

3. Dragand drop an asset into the Layout area.

4. Adjust the size and properties for the frame. The frame may be copied and pasted into the Layout area for
quick duplication of properties, or the Step and Repeat function (Frame menu > Step and Repeat) can be used.

5. Save the template when complete. This will not save the images within the frames, only the frames and their
placement in the Layout area. The saved template will appear in the Template Library list, with the name
“Untitled”. Click the text to rename as required.

6. To load the template, double-click the name. An empty frame set of the nest will appear, ready to accept any
asset files dropped into the frames.

7. Submit the nest to print when done. If a new set of images using the template is required, double-click the
template name again to reload it. An empty nesting set will appear in the Layout area, ready for use.

To create a template using the Step and Repeat function:

A0 Step and Repeat
1. In Studio, go to Frame menu > Step and Repeat. A popup window will appear (see C e gy
image). Frame Weight: 50 in
2. Enter the dimensions for the frame/s required for placement in the Layout area. Hersonual Rapaa: 1

Vertical Repeat: 1

3. Select how many are to appear both horizontally and vertically and specify any
spacing required between each frame. As the horizontal and vertical values are
increased frames will automatically appear in the Layout area. Stop when the desired I Cines) | (R
level is reached and created.

4. Select frames and adjust their properties as required.

5. Save the template when done and rename it as desired.

Spacing: 0.3937 in

Note: If the Step and Repeat function is used when there are multiple frames selected and they are of varying size, all
frames will be repeated in the Layout area. The size dimensions for the frames in the Step and Repeat window will not
be editable.

Using Studio

Positioning Assets for Nesting

A media guide sheet will appear to scale (in light gray) in the Layout area when dimensions have been entered into the
Media panel fields. This allows for clear and simple placement of assets for nesting. When submitted to print,
everything on the media guide sheet is printed. If only a width is entered, once an asset is placed in the Layout area, the
media guide sheet will automatically lengthen to fit the job. As more assets are placed, the sheet will extend to display
the total nesting area.

Note: It is not necessary to have dimensions entered for the Media when creating a manual nest with Studio. When
submitted, the nest will print to your selected media from the top left origin point, printing as much of the width or
length of the nest as the paper in the printer will permit. The remainder will be cropped.

Creating a Nest
Studio allows for single or multiple assets to be dropped into the Layout area.

1. Select the assets (jobs) from the Asset panel.
2. Drag and drop the assets into the Layout area. Assets will appear at their native size unless placed into an
empty frame with specific properties configured (from a template or step and repeat frame).
3. Resize and adjust the frame properties as required. This can be done via the Property panel when the frame is
selected, or by using the following mouse options:
o Left click (on a frame) - Selects the frame for editing, movement, locking or deletion. Selected frames
will appear with a magenta border.
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o Leftclick (on empty Layout area) - Deselects all frames.

o Left click (hold) + Drag (on empty Layout area) - Creates a temporary framing square for selecting
multiple frames. Any boxes wholly or partially within the square when the mouse button is released
will be selected.

o Left click (hold) + Drag (on a frame) - Moves the selected frames around the Layout area. Release the
mouse button to drop and place the frames.

o Right click - Opens the contextual menu with options depending on where in the Layout area the click
occurred.

o Double click (on a selected frame containing an asset) — Activates Crop Mode for the selected frame. A
frame in crop mode will appear with a green border (see Cropping Assets section for information on
this feature).

o Spacebar + Left click (hold) - Activates the grip tool, allowing you to pan around the Layout area. The
mouse cursor will change to a hand.

o The following resizing options are available when clicking at the borders of a frame:

= Left click + Drag - Enlarge or shrink the frame. Proportions are maintained. Resize is
anchored at the opposing edge or corner of the frame.

= ALT + Left click + Drag - Enlarge or shrink the frame. Proportions are maintained. Resize is
anchored at the centre of the frame.

=  SHIFT + Left click + Drag - Free resizing of the frame, ignoring locked width/height ratios.
Assets within the frame will fit or fill the resized frame depending upon frame settings. Resize
is anchored at the opposing edge or corner of the frame.

=  CTRL + Left click + Drag (Windows users) - Snaps the frame proportions to the asset’s native
proportions and resizes. Resize is anchored at the opposing edge or corner of the frame.

= 3 + Left click + Drag (Mac OS X users) - Snaps the frame proportions to the asset’s native
proportions and resizes. Resize is anchored at the opposing edge or corner of the frame.

Cropping Assets

Cropping mode is activated or deactivated by double-clicking anywhere within a frame containing an asset image.
When active, the asset is separated from the frame and appears with an orange border. The cropping frame will have a
green border.

Either the frame or the asset itself can be selected and moved to the
desired spot for cropping. Double-clicking the box after placement will
show how the asset will be cropped.

If the crop box is resized larger than the asset within (see cropping
example), the space around the asset will also be printed to the size of
the entire frame.

Asset before and after cropping

Submitting a Nest or Tiles
The menu option Studio > Print opens a Submit Chooser window to send the manual nest to a Pagesetup and a Media. If
tiling mode is active, this option will change to Print Tiles.

Cloaking and Nesting with Large Format Flatbed Devices
One of Studio’s primary functions is the laying out of jobs for print, using
large format flatbed printers.

When activated, the cloaking feature locks images and frames after they
have been submitted as a nest to the printer. Cloaked images appear
shadowed in the Layout area (see example), are static and non-editable
unless decloaked. This allows for easy placement and printing of new
jobs onto blank, available areas of the flatbed media. Cloaked images are
not reprinted when a new nest is submitted for printing.

Cloaking - Before and after submitting to print
If desired, it is certainly possible to place jobs over others that have

already been printed. Any new image will print exactly where it is placed, regardless of whether or not anything has
already been printed in that area.
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Important Note: The cloaking feature is disabled by default. It is not recommended for use with printers using roll
media unless the device has the ability to roll back to previous areas of unused media.

Tiling with Media

Studio’s

tiling feature allows you to set the total document area and automatically create a tile grid based on pre-

configured print media dimensions and overlap.

Tiling is
(paper).

To tile a

1.

w

8.

useful for billboard printing, or any type of printing where the image is larger than the available print media
job: —
Activate the tiling mode by ticking the Tiling option in the |: =

Property panel. =
Enter the width and height of the area to be tiled. -
Enter any overlap size if required.

A Media width and height must be entered for tiling mode. Enter
these in the relevant fields. This is the size of the print media
(paper) being used.

Once the above have been entered, an image similar to the
example shown will appear.

Drag and drop the Asset file to be tiled. It can be resized as
required.

Once the Asset has been placed, lock the frame in place (Frame
menu > Lock). This will allow you to preview how the image will Tiling enabled with overlap specified
overlap and the tiling by making the image transparent.

Submit to print when ready. The option will appear in the Studio menu as Print Tiles.

Note: Automatic cropmarks and alignment marks will be added to any tiling jobs when submitted via Studio.

Studio Rendering Effects
There are various rendering effects available when using Studio. They will not be visible in the Layout area and will
only affect the job when it is rendered, ready for printing. Any effects can be previewed using SoftProof once the job has
been rendered and nested.

The available rendering effects are:

Cropmarks - Available as a checkbox within the Studio application. Enabling this will place cropmarks around
the selected frame. This effect will adjust the placement of the job on the media to compensate for adding
cropmarks during the rendering phase. The type of cropmark to be used is configured in the Studio Settings.
Convolution Matrix - Available via the Pagesetup (see Workbench data types). Allows you to design your own
filter effect according to a pre-defined mathematical operation known as convolution. This effect is not
available when using the C5 Client.

Mirror - Available via the Pagesetup. Mirrors the job.

Negative - Available via the Pagesetup. Allows for the job to be negated or inverted. Useful for printing to film
using a white ink printer.

Watermark - Available via the Pagesetup. Allows for the placement of a watermark across the job. This effect is
not available when using the C5 Client.

ColourKeys and Screenprinting mode are also available when using Studio, accessible via the Pagesetup used for
processing the job files.
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Touch Console

The Touch Console application offers enhanced control and usability of the SoftProof application through the use of a
touch screen. Ideal for press room environments, the separate touch screen acts as the console, controlling jobs that are
loaded and softproofed on the main screen. Individual jobs or entire publications can be quickly located for proofing.

A Touch Console Settings menu saves valuable time, enabling the operator to choose default navigation options; the
queues the Touch Console will search for jobs; and whether the console switches automatically to the Main control
screen, the SoftProof view navigator, or the page navigator (for publications) once a job or jobs have loaded.

A Mode Bar allows instant switching between control
interfaces from the main Image and Navigation control,
through to Ink Keys and Channels; the Virtual Loupe;
Press Configurations; Page Navigation; Notes and
Tabbed Views.

When the Touch Console is launched, a blank screen
will appear on both monitors (the touch screen and the
main monitor) with instructions to select which
monitor is the touch screen. Simply touch whichever
screen is to be the Touch Console to begin.

The Interface
The interface occupies the whole of the touch screen. = =) |2=
At the top is a banner advising which section the user is
in at the time. The title banner will change to reflect the different modes in use. The bottom of the screen displays the
various modes to use with SoftProof. Return to the starting point at any time by pressing the Home button.

Using the Touch Console
When first starting, Home is the default position. View the jobs in the system by selecting one of the mode buttons along
the bottom of the screen:

* Publications - View a list of jobs that are part of a publication only.

* Books - View a list of jobs that make up a Book as defined by the Bookfilter and BookMonitor application. This
is available for Veripress/Blackmagic Softproofing Add-on Only.

* Jobs - View alist of jobs that are not part of a publication only.

¢ All - View alist of all jobs in the system.

* Search - Open a virtual keyboard on the touch screen allowing a character based search of all available jobs,
publications or books. See TouchConsole Menu > Search Order for details on setting which job types are
available to search. Note: The Search virtual keyboard can be configured to other input languages (see Touch
Console Settings). The default input language of the operating system must be set to the same language.

Jobs must be in the print queue to be displayed, i.e., they must have completed rendering. It will not show any jobs
Waiting to Render or in a Held status.

Once a mode has been selected, the screen will change to display the appropriate list of jobs with the available sorting
and viewing options:

Sort Name Sort Name Sort Time Sort Time View

Ascending Descending Ascending erersina View Imaged Rerdered View Flipbook

Actions available include:

* Select - Touch your finger on a job in the list and it becomes selected. The mode options change to display View
Imaged, View Rendered and View Flipbook.

* Scroll - Touch your finger on the list and drag it up or down the screen. Lift your finger off and position it again
to scroll further.

* Fast Scroll - Touch your finger on the list and drag it fast up or down and let go in a “throwing” action. To stop
the list at any point, touch a job on the screen.

¢ Scrollbar (optional) - If enabled, drag your finger down the overlaid scrollbar to move up and down the list.
Moving your finger left-right will change the position of the scrollbar itself.
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When the required job has been located and a viewing mode selected, the Touch Console will open the Main, Navigate
or Pages control panel.

Main Navigate Loupe Press Config Show Pages Show Tabs Calibrate Close

Actions and modes of the Touch Console will adjust to give the options normally associated with the SoftProof
application. Selecting View Flipbook will load the job into the standard Flipbook application with relevant actions and
modes on the Touch Console.

Modes available include:

* Main - The default main screen displayed when a job is first loaded. This is a control screen for macro-
manipulation of jobs. Includes functions such as image inversion and rotation, back page show through, image
size on screen and so on.

* Navigate - A control screen for closer examination of proofs — features controls for the viewed image size (fit
width/height, original 100%, printed size) and zoom controls.

* Loupe - Opens the Virtual Loupe on the main screen, with controls for the Touch Console.

* Press Config - Opens a list of available Press configurations to apply to the SoftProof. This will switch to
Camera Config when an RGB image is opened.

¢ Show Pages - Opens a modified Page Navigator for instant page-to-page viewing.

* Show Tabs - Displays a list of job currently loaded in SoftProof Tabs.

¢ (Calibrate - Opens a control screen with Calibration and Calcheck options for the main SoftProof display.

* C(lose - Closes the current job, publication or tab.

Main

A job can be manipulated in various ways once loaded, just as with the conventional controls for the SoftProof
application. Some actions will only apply if certain types of jobs are viewed. The actions are colour coded to help group
them into like actions. Buttons can be shown or hidden using the Touch Console settings.

Text Tab Image Tab Tools Status Full Screen e WlndOW / DlSplay

Revert . .
e £ SO T Micort ) JiAwoCropl] |iSShacet | Biolngs < Image manipulation
";::" Next Page Notes ) Next Tab &« Navigation

< Overlaying objects &

Page

Boundary viewing publications
e I | - | I A s | Dacnine < Fitting methods & tools

* Text Tab - Toggles the text job name tabs for multiple loaded images in the SoftProof screen.

* Image Tab - Toggles the job thumbnails in the SoftProof screen.

* Tools - Toggles the Tool Palette in the SoftProof screen. The Palette must be enabled in the SoftProof
application for this to function.

e Status - Toggles the status bar in the SoftProof window. Note: If the monitor is Calcheck Managed and the
current Press has a Calcheck fail (red cross) status, the Status Bar cannot be hidden.

*  Full Screen - View the SoftProof window in full screen view or the user-defined view.

* 90CW/180/90 CCW/ - Rotate the currently viewed proof in the desired direction.

* Invert - Invert the image displayed.

Serendipity Blackmagic User Manual - Version 5.4 123



*  Mirror - Mirror the image displayed.

* Auto Crop - Remove white space from around a job. There must be a completely clear area on any one side of
the job.

* Blueline - Replace all colours with varying shades of blue to see any traps.

* Revert Channels - Revert to the original channel values.

* Previous/Next Page — Move to the previous or next page when viewing a publication.

* Notes - Show or hide any notes embedded in the job (see SoftProof - Notes for more information).

* Previous/Next Tab - Move to the previous or next tab when viewing multiple tabbed jobs.

* Page Boundary - Toggle a red line showing the page/image boundary of the proof.

* Signature - Overlays the signature used to de-impose the job/page if it was submitted for de-imposition. This is
only enabled when viewing a de-imposed job/publication.

* Deimposed Pages (Veripress/Blackmagic Softproofing Add-on Only) - De-impose a job submitted as an
imposition on-the-fly into separate pages, defined by the signature attached to the job and return it to its
original state. (see RIPMonitor - Submit as Imposition for more information).

* Back Page - Display the reverse (back) page through the page currently loaded as if the final print was being
held up to light. The Back Page Opacity setting in the Press Settings controls the amount of show through.

* Spread - View the spread of the selected page, for example, pages 2 and 3 as a spread.

¢ Show Channels - Opens a simplified Channel Viewer touch console interface, featuring a coloured and labeled
button for each process and spot ink channel. Selecting each button will toggle the ink channel on or off. If the
Channel Viewer (see SoftProof) is open, the channel’s on/off state will be reflected in the panel. Touch the Main
button in the Mode Bar to return to the Main screen.

¢ Ink Keys - Opens the Ink Key Viewer for the current proof on the main SoftProof display. A custom set of
controls on the Touch Console allows for switching between Channels and Keys with ease. The following
control buttons are available:

o Excess Ink Area - Displays areas exceeding the Maximum Ink Weight setting as defined in the
currently selected Press configuration.

o Sheet Placement - Toggles the Sheet Placement view in the Ink Key Viewer, placing the page on the
press plate and displaying the Ink Keys as defined in the Press Config.

o Print Run - Opens a virtual number pad to enter the size of the print run. Used with Ink Weight to
calculate the total ink weight for the entire run of the page.

o Ink Weight - Opens a virtual number pad to enter the average weight of the process inks used in
grams per square metre (g/m?). Used with Print Run to calculate the total ink weight for the entire
print run of the page.

o Calculate Ink Weights - Calculates and displays the total ink weight used for each process ink channel
for a complete print run of the loaded page. Totals are based on the entered Ink Weight and Print Run
values.

* Find Note - If any Notes are attached to the currently viewed job/page/spread, this button will open a list of
the Notes in the Touch Console. Select a Note to navigate to its location on the proof. Finding a Note will toggle
the Notes button to show all notes.

¢ Show All - Show the whole job within the SoftProof window.

*  Print Size - Show the job in the SoftProof window at print size.

* Actual Pixels - Show the job in a one screen pixel to one job pixel ratio (i.e.,, 100% zoom).

This view mode has the quickest load time as no resampling for scaling is required.

* Fit Width/Height - Fit the job to the width or height of the SoftProof window.

Navigate
In Navigate mode, it is possible to pan around the image and change the zoom or fitting method. A thumbnail of the
image is loaded into the centre action area of the console.

Touch the thumbnail to jump to that location on the image in the
SoftProof; or touch-drag around the thumbnail to pan around the proof.

On either side of the thumbnail are Touch Console buttons controlling the
scaling of the softproof on the main display, including Full screen/100%
(actual pixels), Fit Width/Fit Height, Zoom Out/Zoom In, Show All/Print
Size.

Optional Previous Page/Next Page buttons are also available if selected in
Touch Console Settings — Navigate option.
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Loupe

The Loupe mode positions a loupe on the SoftProof window. The Touch Console action pane acts like a drawing tablet.
Touch and drag your finger on the touch screen to move the loupe over your image.

Buttons around the edges of the console control the Loupe’s features:

Smaller / Bigger - Decrease or increase the size of the loupe.
Zoom In / Out - Increase or decrease the magnification of the loupe.

For Veripress/Blackmagic Softproofing Add-On users only:

Solo Previous / Next Channel - These controls allow individual Ink Channels of the job to be viewed within the
Loupe, acting as the Show Channels function. The buttons cycle through each individual channel then show all
channels (default view).

Toggle HUD - Toggles the Heads Up Display in the Loupe window, showing the CMYK dot percentages at the
centered cross-hair or within the average % box.

Screened Pixel Readout - Toggles the HUD between cross-hair point measurement of ink percentages and a
square for measuring area average dot percentages. The square resizes depending on the zoom % to always
cover an area equal to a full halftone cell at the LPI defined in SoftProof Settings.

Calibrate
The Calibration control screen allows operators to initiate Monitor Calibration and Calchecks for the main SoftProof

display.

Calibrate - Opens the Displays application and begins the calibration process for the main SoftProof display.
Once calibrated, the monitor ICC profile is automatically saved as the operating system default, replacing the
previous ICC profile.

Note: When calibrating or calchecking, the Spectrophotometer assigned in the Displays application for either
task should be connected and ready for use. If the instrument is different to the assigned one an error will
occur, ceasing the operation. It is recommended to check the appropriate Spectrophotometers have been
assigned before using the Calibrate or Calcheck functions (see Applications > Displays).

Calcheck - This option will open the Displays application, starting a Calcheck of the softproof display to the
standard patch set in the chart assigned to the current Press. On completion, the Calcheck status of the monitor
is updated with a tick/cross. This button is only available if the currently selected Press Config has an assigned
Calcheck Chart.

Note on Spot Colours: When performing a calcheck of the softproofing display, any special/spot colours included in
the currently loaded job are measured and included in the Calcheck for the purposes of a pass or fail.

View FlipBook (Veripress/Blackmagic Softproofing Add-On Only)
View FlipBook opens the selected publication or book in the FlipBook application. Once a publication is opened,
FlipBook controls will appear on the console:

View 3D - Toggle between 2D and 3D views.

View Calendar - Toggle between left to right and calendar flip page turning,.

Show Borders

Rendered Thumbnails - Toggle between imaged and rendered thumbanils for pages in FlipBook.
Full Screen - Enable full screen mode.

Decrement/Increment Start Page, Even/Odd Top Page, Read | ..
Direction 1->2 / 2<-1 buttons. | [

Top Section and Page Navigator buttons allow sections of the D H
FlipBook window to be toggled on or off. EIE e
Previous/Next Page - Flip through the pages. o
Zoom In/Out - Adjust the zoom level of the loaded FlipBook. , nnnnnnn ] - I
Adjust Camera Angle - Toggle a popup slider to change the D
viewing angle. ‘
Reset Camera - Reset the camera to the default angle.
Main - Return to the FlipBook control panel screen.
Press Config - Change the press settings for FlipBook. ﬂ
Pages - Open a Show Pages panel to skip to the desired page.
Close - Close the FlipBook window.
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Touch Console Menu
The Touch Console menu has the following options:

* Font Options - Control the font size for the Touch Console text.

*  Queue Order - Select which Output queues are made available for view/proofing in the Publications and Jobs
lists on the Touch Console.

* Bookfilter Order (Veripress/Blackmagic Softproofing Add-On Only) - Select which BookFilter queues are made
available for view/proofing in the Books list.

* Search order - Select whether Publications, Jobs, and/or Books are available to the search function in the
Home panel of the Touch Console. Search results are displayed grouped by search order, e.g. Books,
Publications then Jobs.

* TouchConsole Settings — See below for more information.

Touch Console Settings ann TouchConsol Seogs
Default job viewing and touch screen navigation options can be configured using  TouehConsole . _saftfroot
the Touch Console Settings. There are two tabs — TouchConsole and SoftProof: Ecoliec Bl Soale

Default Left () Default Right

Thumbnails ¥ Publications ™ jobs ¥ All

Touch Console
¢ ScrollBar - Enable or disable the scrollbar and set the default side it . i
appears on (Right or Left). e -
*  Thumbnails - Enable or disable viewing thumbnails for Publications,
Jobs or All selection lists.

View M imaged _ Rendered ™ Flipbook

Cancel oK )

* View - Enable or disable View Imaged (default), View Rendered and/or
View Flipbook options for opening jobs or publications for softproofing.

Note: If only one of the View Images or View Rendered is selected, the eno YT
Touch Console button will simply be labelled “View”. If all options are (TouchConsole
disabled, View Imaged will be selected as the default option. e et ‘MMNT‘

* Button Size - Set the size of the Touch Console buttons in mm/inches. Ouplicate Page Viewing [ ManualSelect ]
Note: The Touch Console application must be closed and restarted for T T
settings to take effect.

¢ Virtual Keyboard - Select an input language/keyboard layout for the
Touch Console search keyboard.

Cancel ][Ok ]

SoftProof
¢ Entry Screen on Load - Select the control screen the Touch Console will default to when loading a new
job/page:

o Main - The console defaults to the Main screen on load.

o Navigate - The console defaults to the Navigate screen on load.

o Pages - The console defaults to the Show Pages screen on load.

* Navigate Option - Navigate Pages (checkbox) - Show/hide the Previous/Next Page buttons in the Touch
Console Navigate control screen.

* Duplicate Page Settings (Veripress/Blackmagic Softproofing Add-On Only) - When viewing a publication with
duplicate (purple) pages, choose from these page load options:

o Manual Select - When a page with duplicates is selected in the Show Pages screen, the page to view
must be manually selected. This is the default mode of a non-Veripress Touch Console.

o Select Newest Page — Useful in publishing workflows where page updates/revisions are common. This
option will automatically display the latest version of the page.

* Publication Load Page (Veripress/Blackmagic Softproofing Add-On Only) - Set the page to be viewed on load
when viewing a publication from the following options:

o Manual Select - When a publication is selected for softproofing the Touch Console opens and the Show
Pages screen allows the user to select the page to be viewed first.

o First Available Page - Publications are loaded on the first available (lowest
numbered) page.

o Show Sections - When enabled, section buttons are displayed in the Touch
Console Show Pages screen. This function allows loaded multi-section
publications to be viewed one section at a time, displaying the page range BEEEEEEE
within each section.

Note: An option to Edit the Touch Console User Interface is available via the File and contextual menus in the SoftProof
application for Veripress/Blackmagic Softproofing Add-On users only (below).
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¢ Edit Touch Console Ul - Opens an Edit Interface window to allow for the configuration of the enabled (visible)

buttons for control of SoftProof in the Main screen of the Touch Console.

Enable or disable buttons by selecting them. Those disabled will appear with a red cross and will be excluded

from the Touch Console when using it to view softproofs.

The Toolbar has a Preview checkbox, when ticked the edit interface will show the
Touch Console buttons as they will appear after saving. While in Preview mode,
the button titles can be edited to reflect local terminology. Click on the text to
open the name field. Hit Enter to save the name change.

The Reset button re-enables all buttons and restores default button names.

X[ [~

[9¢] ][] [ [ ]
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Serendipity Client Menu Items

The Serendipity Client menus provide access to direct job submission options, system settings and extra functions.

Application Menu (Windows/Linux) or Serendipity Client Menu (Mac OS X)

Preferences - Select this menu option to open the Client Settings (Preferences) for the Serendipity Client, containing
default values and preferences configured for the Client and its applications and modules. See the System Settings >
Client Settings section of this manual for further information.

Submit Menu

Submit Files
Select files to send to a Media and Pagesetup for processing. One or more files may be selected for processing.

Selecting Open will present a chooser showing the Pagesetups (or Pagesetup Pools) and Medias available. Choose the
combination to submit the files to and click the Submit button. This will copy the files into the system for processing.
The flow control can be enabled to hold the job after
imaging or rendering; the number of copies can be set;
or jobs can be placed as pages in a publication.

Toe e

Submit Window

The Submit window is comprised of four (4) sections - a
Pagesetup/Pagesetup Pools selection list; a Media
selection list; an Information panel displaying details of
the currently selected Pagesetup or Media; and a
Submission control panel. B P Cotnk Tl hr g B e iy D e

Pagesetup Selection List
This list has two (2) buttons above it. Only one can be
active at any time:

* Pagesetup - When selected, this button displays a list of Pagesetups available to submit jobs to.
* Pagesetup Pool - When selected, this button displays a list of Pagesetup Pools available to submit jobs to.

An active (selected) Pagesetup is highlighted in blue.

Media Selection List
This list is only active if the Pagesetup button is selected in the Pagesetup selection list.

When a Pagesetup has been chosen, a list of Media compatible with the Pagesetup will be displayed for selection.
An active (selected) Media is highlighted in blue.

If no Media is selected, the submitted job(s) will be output to the Pagesetup’s default Media.

Note: The Serendipity Client saves the last Pagesetup and Media selection so it need not be selected every time a job is
submitted to the same Pagesetup.

Information Panel
This panel displays the settings for the currently selected Pagesetup or Media.

Submit Options
The lower section of the Submit window has the following options available when submitting files:

Flow Control
* Hold After Imaging - Check this box to hold the job after the Imaging stage has completed. Held jobs can be
released to continue processing via the QueueManager toolbar or contextual (right click) menu.
* Hold After Rendering - Check this box to hold the job after the Rendering stage has completed. Held jobs can be
released to continue processing via the QueueManager toolbar or contextual (right click) menu.
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* Nest - Submits the jobs for imaging and rendering, then on to be nested with other jobs. Nesting criteria are
defined in the Output for the Pagesetup/Media to which the job is sent (see Workbench - Output for further
information). Note: This Nesting function only requires that the Output used has nesting parameters defined.
The Output itself can have nesting disabled for normal use. This allows selected jobs to be nested when
submitted while leaving the Output non-nesting for normal use.

* Rotate 90 - Rotates the job 90 degrees. This will override any rotation settings in a Pagesetup.

Copies
* No. of copies field - Enter the number of copies of the job to be printed.
* Copy Lock button - Locks the number of copies to be printed for any files submitted until unlocked and
changed.

Publication
* Publication Name field - Optionally type a publication name to which the submitted file will be assigned. The
job will be viewable in the Publication View of the QueueManager.
* First Page field - Enter the page number for the submitted file in the publication. If submitting multiple files,
the page numbering will start at the defined page number and increase sequentially for each job.

Submit Files For De-Imposition

Also available via the RIPMonitor, this option allows you to submit files directly for de-imposition, rather than from a
RIP queue. After selecting one or more files, a chooser will appear to enable selection of a Pagesetup and Media, or
Pagesetup Pool. A Signature Group can also be assigned to de-impose the files (see Workbench - Signature Groups for
more information).

Submit Files As Imposition

Also available via the RIPMonitor, this option allows you to submit files directly as an imposition, rather than from a
RIP queue. This will submit an imposed job in its original form, but attaches a Signature Group (via popup chooser) to
allow the job to be de-imposed on the fly using the Deimposed Pages button in the Veripress SoftProof Touch Console
(see Touch Console for more information). Available for Veripress/Blackmagic Softproofing Add-On only.

Submit Files as Asset
Select files to send to the Studio application Asset queue. Submitted Assets appear in the QueueManager queue as
thumbnails, but are not processed until submitted for printing from the Studio application (see Applications - Studio
for more information).

Submit ICC Target
After selecting one or more ICC target files, a chooser allows you to select a Pagesetup and Media to submit the ICC
target file to.

Note: This option is used as part of creating an ICC calibrated Pagesetup/Media. After creating and assigning a Paper
Profile and Linearisation curve to a Media, this option is used to submit an ICC target file to the printer with all ICC
options disabled. The target is then read by third party ICC profiling software and used to generate the printer’s output
ICC profile, which is then assigned to the Media.

Submit ICC Target Without Colour Correction
After selecting one or more ICC target files, a chooser allows you to select a Pagesetup and Media to submit the ICC
target file to.

Note: This option works in a similar way to “Submit ICC Target” however, all Linearisation data will be disabled at the
time of submission, unlike Submit ICC Target which enables colour correction curves. The job info will display
Calibration Target, ICC Disabled in the Properties field.

Test Prints
Send a Blackmagic Test Print to one or more Pagesetups/Medias. Select which test print(s) to submit by ticking the
checkboxes beside each file name in the Submission area of the Submit window.

Note: You can add your own files to the lib/testprints directory for use as test prints. Any files you have permission to
use that are placed in this directory will appear for selection in the Test Prints chooser window.
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Server Menu

Server Settings

Select this menu option to open the System Settings (Preferences) for the Serendipity Server. The Systems Settings
section contains default values and preferences configured for the Server. See the Server Settings section below for
further information on each panel.

Connect to Server

This allows the Serendipity Client to connect to a Blackmagic Server running on the network. The Refresh button will
search for and display any active Servers. Alternatively, you can enter the name or IP address of the Server in the
Server Address field under the Manual tab.

If there are multiple Servers (Masters) running on the network, the list is cached on the first “Connect to Server”
selection. A dropdown list of available Servers is accessible via the Auto Detect tab. If a new Server appears after this
time, the Refresh button must be pressed to find and add it to the list. Likewise, if a Server becomes unavailable, the
connection will fail and the list will require a refresh.

When the Serendipity Client is started, it will attempt to connect to the last Blackmagic Server accessed by default.

Accounts Admin

Accounts Admin allows an authorised administrator to create, modify and manage User accounts and User Groups.
Users can be reassigned to groups dependent upon the operating privileges granted to each User Group. See the
Accounts Admin/Secure Mode section below for further information.

Log Out (Secure Mode only)

This menu item only appears while Blackmagic is in Secure Mode (see Accounts Admin/Secure mode for more
information). Selecting Log Out while using Blackmagic in Secure Mode simultaneously logs out the current user and
generates the Login window. At this point, the options available are to enter a username and password; Choose Server
before login; and to Quit the Blackmagic Client.

While the Login window is displayed, the Blackmagic Client is effectively LOCKED to all users. The Server will continue
to operate as normal.

Chatterbox

Chat to other users connected to the same Server. The Chatterbox window will display the Clients connected to the
Server. If the user has entered a nickname in the System Settings, this name is displayed; otherwise the machine name
is used. If the user’s name cannot be selected, the user has selected the Away option and is not available.

Broadcast Message

This allows messages to be sent to all users connected with a Client to the same Server. Selecting the Broadcast option
displays a message window to type into and send. The message is displayed on the users window for a short time and
will automatically dismiss if it is not acknowledged by clicking OK.

Download PPD

This option downloads the Megarip PPD from the Server to the desired location. A chooser will appear to navigate to
the location for saving the PPD file on the drive. This saves having to get the PPD off the disk. Use the PPD when
installing a local printer. When installed, the Megarip PPD (Postscript Printer Description) is selected as the printer
driver when setting up a Blackmagic Published Pagesetup as a print destination for third party applications (see
Workbench - Pagesetup and the Publish to a Windows Printer sections for more information).
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Accounts Admin / Secure Mode
Blackmagic gives users the option to login using Secure Mode, which allows the administrator to create accounts for
users and groups, with each group configured to allow or deny its users
access to particular applications and functions.

When Secure Mode is active, users are required to enter a username and

password whenever the Client is started or users are changed. The Serend!pity Blal:kmagic

username and password are both case sensitive.

The Accounts Admin menu option is selected in order to display the panels
for configuring any Users and Groups and these should be created prior to
activating Secure Mode. Name:

Password:

golem.swdevel.serendipity-software.com.au:9100

The Log Out option only appears once Secure Mode has been activated.
Selecting this while using Blackmagic in Secure Mode simultaneously logs
the current user out and generates the Login window with options to login
as a new user and select a Server to connect to, or Quit the application.
While the Login window is displayed, the Client is effectively locked to all users. The Server will continue to operate
normally.

— AT ——
Quit ) Choose Server...

Setting up Users and User Groups
Blackmagic’s Secure Mode is set inactive by default. The software will continue to function normally whether or not
Secure Mode is activated.

Important Note: It is recommended all users and groups requiring access be setup BEFORE activating Secure Mode.
Secure Mode cannot be activated until at least one (1) user has been created. This would usually be the Admin account,
as this is automatically created when the Accounts Admin option is selected for the first time.

1. Select Server Menu > Accounts Admin... to display the configuration panels.

Activating Secure Mode
Once the initial user account(s) have been setup, Secure Mode can be activated by checking the tick box located via
Server menu > Server Settings (General tab).

dines oo
Secure Mode can only be activated or deactivated by an |{=
administrator (a member of the Admin group).

Configuration Panels

Users Panel
The fields within the Users panel are: Pt {ovmeee

* Name - The username of the account. This is case sensitive.

¢ User ID - This is a numerical ID assigned automatically but
may be changed by the administrator.

* Password / Verify - The password is entered and stored here. New
passwords must be verified by entering the details in each field. The
password is also case sensitive.

* Permission - The level of permission for the user is created here. Click Edit to
make changes to the user read/write/execute permissions. Note: The Group
(second line) and “Everyone” permissions in the Edit popup determine
whether jobs submitted by a user are able to be seen/deleted/edited in the
QueueManager by other users in the same user group, or by users outside the
group.

*  Email - Enter the users email address here.

* Comment - Allows the administrator to enter a note on the particular user account if necessary.
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Group (dropdown) - Assign a user group to the user account.

User Privileges — Privileges other than those in the user’s group can be added here.

Notifications — Select which email notifications the user is to receive by clicking the + icon or remove any via
the — icon. Notifications are available for Job Spooling failure, Job Autodetection failure, Job Imaging/Rendering
failure, Job Printing failure, Dongle removal, Server Crash, Media Remaining warnings and Software Updates
available.

To create a User:

1.

W

Lo

Click the + icon in the bottom left of the window. To delete a user, click the - icon

Enter a username in the Name field.

Enter a User ID number or leave the default value.

Create a password for the user and verify the details. The password boxes will always display black dots
irrespective of the length of your password.

Edit the permission level to the required access level.

Enter the user’s email address (if notifications are required).

Add a comment against the user if necessary.

Assign a Group for the user.

Add any extra privileges to the user if required. This will only show privileges not included in the group
selected for the user.

10. Add any notifications to the user if required.
11. Apply the changes or select Revert to cancel.

Groups Panel
An admin User and Group are created by default with access to all permissions and privileges when the Accounts
Admin option is selected for the first time. The admin user and group cannot be deleted. It is recommended this be

the only group with access to the Accounts Admin application.

The fields within the Groups panel are:

Name - The name of the Group.

Group ID - This is assigned automatically but may be
changed by the administrator.

Comment - Allows you to enter a note on the particular user
group if necessary

Group Privileges - This is a list of available privileges
relating to functions within Blackmagic.

Members - A list of Usernames and IDs belonging to the
Group.

Revert Apply

L

To create a Group:

1. Click the + icon in the bottom left of the window. To delete a group, click the - icon.

2. Enter a name in the Name field.

3. To add privileges, click the + icon in the Group Privileges panel. A list will appear to the left with all available
items. To add, highlight the privilege and click the + icon at the top right of the window.

4. Once you have finished adding privileges, click the X in the middle of the right edge of the panel to close the
window.

5. Click Apply to save any changes to the group or Revert to cancel.

Assigning Users to a Group [‘ Users @i Groups J

Users are assigned to the groups via the Users panel.

W

Once you have created the user group, click on the Users panel.

Select the User Name from the list of users.

Select the Group to assign the user to from the Groups dropdown menu.
Click Apply to save any changes or Revert to cancel.
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Important Note: A user can only be assigned to one User Group at a time. If extra privileges are required, these must
be assigned against the user via the Users panel.

Hosts Panel

The Hosts panel allows for the configuration of automatic Client logins for selected host computers or network IP

addresses when using Secure Mode.

i Users

i@ Groups | Hosts

Host
Test

Name: Test

Hostname/IP: 192.168.0.30

Automatic Login: | g guest

The fields available are:

* Name - Enter a name for the Host setup.

* Hostname/IP - Enter the Hostname or IP address of the computer the user will automatically connect to.

* Automatic Login - Disable or Select a User from the dropdown list. Only one user may be selected per Host
setup.

Activating Secure Mode
Secure Mode should be activated after any users and/or groups have been created. Only an administrator or member
of the admin group can activate or deactivate Secure Mode.

To activate: ann e—

{General_Colour Management  Working Paths |

1. Select Server menu > Server Settings. Oefauh nfs; (fn #

. Maximum Memory For PS RIP:  OMB.
2. Click on the General tab. S e
3. Tick the checkbox at the bottom of the screen - Secure mode - to ) Low qualty thumbnal faster

activate or deactivate. Comprmssion: (fuee 400

. . Maximum Print Preview Resolution: 180 on
4. Click OK and close the settings when done. o e
5. If activating Secure Mode, a login window will appear as soon as Sarves Bk Uogs o i

you close the Server Settings.

Processes:

Minimum Broadcast Interval

image 1

1s

Render |

If Email Notifications are setup for users: Output unknown fles ta printer

Log printed jobs
_ Secure mode

* Enter the mail server details in the Mail Server field. This is the it
outgoing SMTP server.
* Enter the email address for the Sender (From) field of the email v Caneel) (COK)

in the Sender Email Address field.

Sender Email Address
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System Settings
The Systems Settings section contains default values and preferences configured for the Server and Client. The settings
are split into two (2) different sections - Server and Client.

Access the Client Settings via the Application menu (Win) or Serendipity Client menu (Mac).

Access the Server Settings via the Server menu.

Client Settings

The Client settings are divided into three (3) tabbed categories: General, Colour Management and Application
Shortcuts.

General 8.0.60 Client Settings

Internationalisation - Select your preferred language from
those available. This displays all Client and log messages in the
chosen language. The default is English. A restart is required if
the language setting is changed.

Show Tooltips - Enable or disable tooltips within the Client.
Turn Sound FX Off - Check this to disable the sound effects.
Sounds are used for things such as drag and drop, and error
message alerts.

Undo Levels - Set the number of levels for Undo. The default is
zero (0), which means no restriction.

Default Units - Set the measurement units used by the Client
and all of the Applications/Modules.

Instant Messaging Nickname - Enter a nickname to use when
accessing the Chatterbox application.

Memory Cache Maximum Size - Set the maximum cache size for
the SoftProof application. The default is zero (0), where the
Server chooses the default depending on system configuration.

. ((Cancel )

[ General | Colour Management  Application Shortcuts

Internationalisation

General User Interface Settings.
¥ Show Tooltips M Turn Sound FX Off
Undo Levels: 0 r:ﬂ

Default Units: | mm =)
Instant Messaging

NickName:
SoftProof
Memory Cache Maximum Size: 0 1?‘ MB

Maximum Preview Resolution: 0 ‘? DPI

0K

Maximum Preview Resolution - Set the maximum preview resolution for SoftProof for both Imaged and
Rendered options. The default is zero (0), which is the full job resolution of the output file.

Colour Management
Choose Default Match ICC Profile — Select a default match ICC profile for accurate display of CMYK data.

CMS Dithering - Disabled by default. Use CMS Dithering for
smoother results whenever conversion between 16 bits to 8 bits
is required.

Calcheck Managed - Enabling this will display the current
calibration status of the selected monitor. When selected, there
will be a small icon showing a green tick or a red cross. This icon
is shown in the bottom right corner of the SoftProof window. Its
status depends on the expiration time of the monitor calibration
(as set below) and the Calcheck status.

Use Native Profile - Enable this to use the operating system
defined ICC profile for colour management. The Client will use
the monitor profile as setup for the operating system, i.e., Mac OS
will use what is in the Display Preferences Colour tab, Windows
will use the Display Adapter Settings.

Choose Monitor ICC Profile - Select a monitor ICC profile for the
display the Client is running on. The profiles are used so any
colour element viewed on the display is shown as accurately as
possible. This includes SoftProof and any colour swatch. It is
recommended the monitor be calibrated and set to the same
match profile as is used for the softproofing Pagesetup.
Resolution - Choose the default resolution to use for the

' Ya

(&) Client Settings

! General |- Colour Application Shortcuts

Match

("4 Choose Default Match ICC Profile... ) ../Resource...d_v2_eci.icc

™ CMS dithering

Monitor 1
[ Calcheck Managed ¥ Use Native Profile o

Choose Monitor ICC Profile /home/mandy...040711-3.icc
Resolution

Calibration expires

(® Use system setting: 93 x95 DPI

monitors. This is used in SoftProof for calculating various fit methods. Options include:
o Use System Settings — The Client will calculate the system’s monitor resolution.

o Custom Resolution - Specify your own resolution.

o Calibration Expires - Set a reminder to popup when a calibration needs updating.

Serendipity Blackmagic User Manual - Version 5.4

() Custom resolution: 72 DPI (Never %)
Monitor 2
[l Calcheck Managed ™ Use Native Profile =
Choose Monitor ICC Profile /home/mandy...D-040711.icc
Resolution
(@ Use system setting: 99 x 98 DPI Calibration expires
O Custom resolution: 72 DPI (Never %)
[ 4 Cancel ) (0K



Additional Monitors : :
Specific settings may be set for each monitor when in a multi-monitor environment. The [I] @
Client Settings will show additional sections with Monitor 2, Monitor 3 etc listed. To identify
which monitor is which, press the monitor indicator button to display a graphic in the middle
of the screen for the relevant monitor.

Calcheck Managed
The Calcheck Managed option (under Colour Management) constantly reports the status of the monitor used for
softproofing.

When this option is enabled a small tick or cross icon representing the Calcheck
status will be displayed at the bottom right of the SoftProof window in the status | ™ Auto SoftProof Press
bar.

Application Shortcuts
This tab displays a list of the Applications and Modules for which keyboard shortcuts can be created.

Note: It is the responsibility of the user to check the created shortcuts do not conflict with any other Blackmagic, third
party software, or operating system shortcuts/hotkeys.

To add a shortcut:

1. Highlight the selected application or module in the list.

2. Use the Edit option in the context menu (right click) or click in the Shortcut field to the right of the
application/module name.

3. Typein the key or key combination for the shortcut and press Enter.

The shortcuts will now appear in the Application and/or Modules menu of the Client.
To remove a shortcut:

1. Highlight the selected application or module in the list.
2. Use the Clear option in the context menu (right click); or
3. Click in the Shortcut field and delete the shortcut.
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Server Settings
Server settings are saved to the Server and are common to all connected Clients. The Server settings are divided into
three (3) tabbed categories — General, Colour Management and Working Paths.

General

Default Units - Set the units used by the Server. Options are mm, cm, inches, points, picas, metres or feet.

Maximum Memory for PS RIP - Set the maximum memory
used by the Postscript RIP. The default is OMB (which uses the
internal default amount).

Maximum Memory for Rotation - Set the maximum memory
used for Rotation. The default is OMB (Server chooses the
default depending on system configuration).

Low Quality Thumbnail - Selecting this produces a lower
quality thumbnail. This is faster but some detail may be lost in
the thumbnail.

Compression - Control the compression for the intermediate
file format (the Imaged file). Choices are Faster or Better. The
default is Faster.

Maximum Print Preview Resolution - Set the maximum

AN Server Settings
[-General . Colour Management  Working Paths
Default Units: | in T‘
Maximum Memory For PS RIP.  OM8
Maximum Memory For Rotation:  OMB
_ Low quality thumbnail (faster)
Compression: | Faster [}
Maximum Print Preview Resolution: 180 on
Polling Service Refresh: 0 h om hos

Server Back Log
Processes

Minimum Broadcast Interval

0
Image 1

1s

.| Days

Render 1

Output unknown files to printer
Log printed jobs
. Secure mode

Mall Server

Colour Management

Sender Email Address

resolution for the rendered preview. The default is 180dpi.
Polling Service Refresh - Set the interval between poll service
checks, i.e., how long between checks to see if any RIPs
require polling. The default is 50 seconds if the times are left at 0.
Server Back Log - Number of days to keep the log. Older days are trimmed when the Server starts. Zero (0)
means the log will not be trimmed.

Processes - Control the number of processes the machine will handle, i.e.,, the number of Imaging and
Rendering tasks simultaneously run on the Server. The defaults are 1/1. Up to one imaging and rendering task
can be set per CPU core the Server machine possesses. In practice, it is recommended the combined number of
imaging and rendering tasks be set to no more than the number of cores. For example, 4 CPU cores = 2 Image/2
Render.

Minimum Broadcast Interval - Set the interval between the Server sending out updates to connected Clients.
The default interval is 2sec. High-end systems with good networking are able to set the interval to Osec for
slightly improved image/render times when processing large numbers of jobs. Sites using the Client remotely
connected via the internet should set a longer polling interval of 10-20sec.

Output Unknown Files to Printer - Output any unknown files direct to a printer. If this is unchecked, any
unknown files will result in errors and will not be output.

Log Printed Jobs - When enabled, this option will log completed print jobs in the Server log. The jobname and
dimensions are noted.

Secure Mode - Enable or disable Secure Mode.

Mail Server - Enter the details of the mail server for error notification emails when using Secure Mode.

Sender Email Address - Enter the details of the Sender (From) address for error notification emails.

£? _Cancel ) (0K

Secver Settings
Ceneral - Colour Management  Working Paths

ICC Engine Accuracy: | Better 13
Default ICC Proties

ICC Engine Accuracy - Select Faster or Better, depending on
preferences.

Default ICC Profiles - Select the default ICC profiles used
when first creating a new Pagesetup (Input profiles) and
Media (Output profiles).

Version 3.4 spot colour handling - This is a compatibility
setting for users with Spot colour setups, upgraded from
Blackmagic v3.4 or earlier to get consistent results from spot
jobs. It is recommended as a temporary setting only and
setups should be recreated using the improved and more
accurate (post v3.4) spot colour handling.

Apply ICC Correction to CMYK Specials - Select this to apply
ICC correction to CMYK Specials.

+ Input RCE Profile ... monitors /AdobeRGE1998 icc

# Input CMYK Profile fogra-altona-testsuite /ISOcoated_v2_eciF39.icc

% Output RGB Profile . ) monitors/sRGB_v4_ICC_preferance.ice

. 4 Output CMYK Profile . fogra-altona-testsuite/ISOcoated_v2_eciF39.icc
_ Version 3.4 spot colour handling
| Apply ICC Correction to CMYK Specials
Force Relative Colourimetric Media White
# CMs dithering

& Change System Specials . ) Reference-Lab

% Unknown Specials . None

X? Cancel ) (0K
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* Force Relative Colourimetric Media White - Various ICC profiling packages and some older ICC v2 profiles
included an Lab value for media (paper) white in the Relative Colourimetric Intent LUT. This has the effect of
printing a paper layer when printing with Relative Colourimetric rendering intent. When enabled, this option
ignores the Lab value for paper in the Relative LUT, leaving paper white areas unprinted.

¢ CMS Dithering - Disabled by default. Use CMS Dithering for smoother results whenever conversion between 16

bits to 8 bits is required.

* Change System Specials - Select a default Special Colour Set for plate matching. This is used by the RIPMonitor
and polling service for plate assigning. Colours in this set are automatically assigned in the RIPMonitor.
* Unknown Specials - Select a Special Colour Set (optional) to which unknown special/spot colours included in

PDF or Postscript jobs can be automatically added.

Working Paths

Working Paths lists the default location of the paths the Server uses to process jobs.

* Raster - Holds all the imaged, rendered and print jobs while &=

they are live in the system.

¢ Spool - The location where the job is spooled prior to
processing.

* Temp - After spooling, the job is moved to the temp directory
where it is worked on.

* Drop - The default location for the DropFolders.

( Raster... )
ik
(" Spool... )
( Temp... )

( Drop... )

Server Settings

! General = Colour Management | Working Paths )

/Applications/Serendipity/bmagic/raster
/Applications/Serendipity/bmagic/spool
/Applications/Serendipity/bmagic/tmp

/Applications/Serendipity/bmagic/drop

The Raster directory holds all jobs while they are in the system and as such, can be very large. If this is moved it needs
to be placed on a disk with plenty of space. A Server restart is required if any paths are changed in order for the

changes to take effect.

Important Note: All existing files in the new working path directory are
deleted when the Server is restarted. Ensure the new working path directory
has no essential data. A warning message will popup to confirm whether to
proceed with the path change.

Server Working Path

All existing files in the new
working path directory will be
deleted at server restart.

Do you wish to proceed?

{ No ) [ Yes )
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Web Server

The Blackmagic Server has a built-in web server. Accessed via a web browser, the Web Server provides status
information about the Server and jobs currently in the system. It cannot be used for submitting or managing files in the

system.

Accessing the Web Server
To connect to the Web Server:

1. Enter the IP address or machine name (if using DNS) of the computer running the Server in the browser
window, followed by a colon and the port number 8080. For e.g., 192.168.3.43:8080

/% [ 192.168.3.43:8080

2. Press Enter once the address has been typed in. When it connects, the browser address bar will look like this:

7+ Mihup://192.168.3.43:8080/

3. Ifyou have a DNS Server, you can use the machine name instead:

/|‘ k4 http://papaya:8080/

4. Once you are connected, the front page will appear with an options menu on the left:

Welcome to Serendipity Blackmagic
Select 8 option from the st o7 the left 1o contnue.

*  Queues - Shows all the queues configured on the Server you are connected to.
* Log file - Allows you to view the log file.

* System info - Displays information about the system.

*  Support - Shows various support options & information.

Queues - Click on any of the queues to get information about jobs in that queue.

Serendipity Blackmagic

Quoues
Log Fie
Systemn Info
Suppont

Information about the job, including name and current
status will be shown.

o

Available queues:

* Spool
* Autodetect

Available printers

* Doublesided Printing
« £pson 7900

« Epson 4000
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Log File - To view the log file, select the option from the list on the left.

From here, you can select a particular time period to fetch from the Server.
Once viewed, you can print the file or save it to disk. The log can be printed,
saved or exported from the browser.

Disk usage:

Disk Used Total Path

Spool — 46.33G8 595.85G8 (ADplicatoNs Serendiply DMagicispoct

Print — 46.33G8 S95.85G8 IApplicatonsiSerendiptybmagiciraster

ProdTemp 48.33G8 595 A5G8 IApplicatonsSorendiptybmagictmp

OSTemp ) 46.33G8 595.85G8 /Applicatons/Serencipty/bmagicimp
System info - Choose this to display information about the system. e P P P [P

Product info:

Product Info, Licensed Modules - available printers and input filters; |, . . . coemon sscmsse e s ous 2102
s . s Procuct Croatod: Jul 22 2009 13:11:48 T ?
and Available Destinations are shown. Proa

ctType: NFR (not for resale)
Hostname:

swilevel sorendiplty-software com au

O
rind no: 4810b244 1538

Dongle created: Wed Oct 22 15:55.32 2008

Licensed modules:

Available Printers

Canon BJC-8500 Rev 3.04

Canon imagePROGRAF WE400 / W8400 Rev 1.07
Canon IPFS000 / PFB000 / PFI000 Rev 1.07

Support - To access the Serendipity Support site, select this option
from the menu. This is the same as if you accessed the Serendipity
Software website directly.

From here, you can download databases, release notes, manuals,
updates, tutorials, FAQs and other helpful information.

You will need to have an active Internet connection for access to the
support website function.

Serendipity Blackmagic User Manual - Version 5.4 139



Publishing a Pagesetup on Mac OS X (10.6.x)

Blackmagic Pagesetup’s can be set up as a Mac OS X system printer destination to allow jobs to be easily submitted via
the Print option of third party software or design packages.

Jobs printed to a Published Pagesetup will be automatically sent for processing and colour management in Blackmagic,
eliminating the need for dropfolders or manual file submission.

Note: Jobs printed via Blackmagic in this way must be in a file input format available to your Blackmagic version.

Installing the Serendipity Printer Drivers
The first step when Publishing a Pagesetup for the first time is to install the Serendipity Printer Drivers for Mac OS X.

The installation package is located on the Blackmagic 5.4 Installation DVD:

1. Navigate to the /drivers/mac folder and run the file Serendipity Printer Drivers.pkg
2. An installer window will appear. Follow the prompts to complete the installation of the drivers. The installer
will require administrator access privileges.

Configuring a Pagesetup for Publishing as a TCP/IP System Printer

To configure a calibrated Pagesetup for Publishing:

Publish
___ Publish DropFolder

1. In the Workbench, select the Pagesetup from the list of available data

Nafanlr

types.
2. Go to the Publish panel and enable the checkbox for TCP Port: Activate printer: || Mac L Windows
port number option. TCP Port: ¥ Activate port number 10201

Flow Control: |_ Hold After Imaging  __ Hold After Rendering

3. Enter the TCP port number into the field and Save the Pagesetup.

Port Numbers
It is recommended that the port number assigned to a Pagesetup be a port over 10000 to avoid any conflict with the
operating system or an existing application. Each Pagesetup to be published needs its own unique port number, for
example, 10200, 10201, etc.

Media

When submitting jobs to a Published Pagesetup, the default Media assigned to the Pagesetup is used. If you wish to
publish to different media on the same printer, each Media required needs to be assigned to its own Pagesetup, with its
own unique port number.

@nn

Creating a TCP/IP Mac OS X System Printer
A system printer needs to be created and configured on the Mac OS X computer that is
running the Blackmagic Server.

1. Open the System Preferences for the Mac OS X.
2. Choose Print & Fax.

Click the + icon at the bottom of the printer list panel to create a

new printer.

Select the IP icon at the top of the Add Printer window.

Protocol - Select HP Jetdirect - Socket from the dropdown menu.

6. Address - Enter the TCP/IP address and port information for the
printer setup in the following format: Computer
[Paddress:PagesetupPortNumber (see image for example). The IP
address for the printer should not be used.

7. Name - Enter the desired name for the printer. It should be easily
recognisable as a Published Pagesetup and/or the particular
Pagesetup being published. -

8. Print Using - Select Printer Software from the dropdown menu. &) &=

9. Alist of available Mac OS X system printer drivers will popup.

@

S

Serendipity Blackmagic User Manual - Version 5.4 140



10. Either scroll down the list and select Serendipity Blackmagic, or type “Serendipity” in the filter field and select

Serendipity Blackmagic and click OK.
11. Click Add to add the new printer.

12. Set the published Pagesetup “Printer” as the system default and/or share the

printer on the network as required.

LYol Print & Fax

[Showai ] Q

Configuring a Pagesetup for Publishing as a Bonjour Printer

To configure the Pagesetup for Publishing:

1. In the Workbench, select the Pagesetup to be Published from the list of

available items.

2. Go to the Publish panel and enable the printer: Mac checkbox. This lists
the Pagesetup in the Mac OS X system Bonjour destinations as

“Pagesetup name @ computer name”.
3. Save the Pagesetup configuration when done.

Creating a Bonjour System Printer for Mac OS X

Publish

Publish Dropiolder

Defavir

Printer: ¥ Mac Windows

TCP Port Activate port number

Flow Control: | Hold After Imaging Hold After Rendering | Nest

A system printer needs to be created and configured on the Mac OS X computer running the Blackmagic Server.

Open the System Preferences for Mac OS X.

Choose Print & Fax.

Select the Defaulticon at the top of the Add Printer window.

Choose the Pagesetup from the Printer Name list. The Pagesetup

will be listed as Kind: Bonjour and named “Pagesetup name @

computer name”.

5. Print Using - If you have installed the Serendipity Printer

Drivers, the Print Using field should auto-fill to show

Serendipity Blackmagic.

a. If the Serendipity Printer Drivers have not been

installed, cancel the printer setup and install the drivers
as per the above instructions.

b. If the field does not auto-fill, choose Select Printer
Software from the dropdown menu. A list of available Mac
0S X system printer drivers will popup. Either scroll
down the list and select Serendipity Blackmagic or type
“Serendipity” in the filter field and select Serendipity
Blackmagic. Click Add.

6. Name - Enter the desired name for the printer. It should be named

to be easily recognisable as a Published Pagesetup and/or the

particular Pagesetup being published.

Click Add to add the new printer.

8. Set the published Pagesetup “Printer” as the system default and/or
share the printer on the network as required.

B W e

N

ene

=

Default

Add Printer =

Q
Fax 1P Windows Search

Printer Name

com.au
gesetup @ rambutan.swdevel.serendipity-software.co
rjet CP2025dn

Name: | Blackmagic Bonjour Pagesetup

Location: Serendipity Blackmagic

Print Using: | Serendipity Blackmagic )

ATy —" Al
(More Printers...

( Add

800 Print & Fax

<[> ) [ showail Q

ation: - Serendipity Blackmagic

Serendipity Blackmagic
Status:  Idle

™ Share this printer on the network ( Sharing Preferences.

Default printer: [ Last Printer Used ]
Default paper size: [ A4 2

)
B Clckthe fock to prevent further changes. (©)
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Publishing a Pagesetup on Windows 7

Blackmagic Pagesetup’s can be set up as Windows system printer destinations to allow jobs to be easily submitted via
the Print option of third party software or design packages.

Jobs printed to a Published Pagesetup will be automatically sent for processing and colour management in Blackmagic,
eliminating the need for dropfolders or manual file submission.

Note: Jobs printed via Blackmagic in this way must be in a file input format available to your Blackmagic version.

Megarip Printer Driver
The first step before proceeding is to enable access to the Megarip.inf driver file. The Megarip printer driver is a
proprietary Serendipity Software driver that Windows will use as the printer driver.

The file is located on the Serendipity Blackmagic installation DVD in the following directory:

/drivers/win/win_xp_vista_7/

Configuring the Pagesetup for Publishing as a System Printer
To configure a calibrated Pagesetup for Publishing:

Publish
___ Publish DropFolder

1. In the Workbench, select the Pagesetup from the list of available data

types.
2. Go to the Publish panel and enable the checkbox for TCP Port: Activate printer: | Mac L Windows
TCP Port: (¥ Activate port number 10201

port number Optlon. . . Flow Control: |_ Hold After Imaging | Hold After Rondni;g
3. Enter the TCP port number into the field and Save the Pagesetup.

Nafanlr

Port Numbers
It is recommended that the port number assigned to a Pagesetup be a port over 10000 to avoid any conflict with the
operating system or an existing application. Each Pagesetup to be published needs its own unique port number, for
example, 10200, 10201, etc.

Media

When submitting jobs to a Published Pagesetup, the default Media assigned to the Pagesetup is used. If you wish to
publish to different media on the same printer, each Media required needs to be assigned to its own Pagesetup, with its
own unique port number.

Creating a TCP/IP Windows System Printer
A system printer needs to be created and configured on the Windows computer that
is running the Blackmagic Server.

1. Select Windows Start Menu > Devices and Printers.
2. Click on Add Printer. The Add Printer wizard will appear.
3. Select Add a Local Printer and click Next. _
4. Select Create a New Port and Standard TCP/IP Port from the Type of Port
dropdown menu. Choose a printer port

5. Click Next. S ot 8 e coinacton ek W ol cor R U S v o W P
6. Type a Printer or Hostname Address: R T

a. Device Type - TCP/IP Device ® Cresteanewport

b. Hostname or IP address - Enter the Network IP address L Sanda JCH/T ot <

of the Windows computer running the Blackmagic Server.
(e.g., 192.168.3.59). Bt —
c. Port Name - Enter a name for the Windows port (this iS | ,.umeor scues o
NOT the printer name). Boriume: WegorppPo
d. Uncheck the option to Query the Printer and —|ruyepinersnsomsicay e divetouse
Automatically Select the Driver to Use.
7. Click Next.
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8. Additional Port Information Required:
a. Device Type - Custom.
b. Click the Settings button. A configuration window will

Additional port information required

The device is not found on the network. Be sure that:

1. The device is turned on.

appear. 5. The donee  prapety Foiice
9. Configure Standard TCP/IP Port Monitor: R R
If you think the address is not correct, click Back to return to the previous page. Then correct the
a. Protocol _ SeleCt Raw. 3:3:::2::;:::;’" another search on the network. If you are sure the address is correct, select the
i. Raw Settings: Device Type
1. Port Number - Enter the unique TCP i —

© Custom | Settings...

Configure Standard TCP/IP Port Monit E

|| Por Senss \

Port number assigned to the Pagesetup
to be published, e.g., 10201.
2. Click OK. The window will close and return to the

Additional Port Information window. |- MegarippPD1
3. Click Next. PinterNeme P Address 192168359
10. Install the Printer Driver: P -
a. If this is the first time installing a Blackmagic system printer, P

Port Number: 10201

insert the Blackmagic Installation DVD and select Have Disk.
. Navigate to the /drivers/win/win_xp_vista_7/ directory.
c. Select the Megarip.inf file and click Open. The Serendipity
Megarip driver should now be displayed. ERIRECIEy

o P thelist.CI

d. Click Next. O it tiim oo 5 i

LPR Settings

Manufacturer

Serendipity Scftware
Sharp.

Note: The above step can be skipped for any subsequent installs of
Blackmagic system printers. The driver can be chosen from the Windows
printer driver list.

screndipity Megarp ) Coe )

Sony
TosHIBA

[ Windows tpane_] [ roveoies )

11. Which Version of the Driver do you want to use:

a. Select Use the driver that is currently installed (recommended) unless you are replacing an older
installed version of the Serendipity Megarip driver.

b. Click Next.

12. Type a Printer Name:

c. Enter a name for the printer. This is the name that will appear in the Windows Printers list and be
available as a printer option when printing from Windows applications. The name should be unique
for the Published Pagesetup.

d. Click Next.

13. Printer Sharing:

e. Select Share this printer so that others on your network can find and use it.

f.  Keep the default printer name or enter a share name.

g. Click Next.

14. You've Successfully added “Printer Name”:

h. Choose whether the Published Pagesetup destination is to be
the default system printer.

i. If desired, click the Print a Test Page button. The test page job
should appear in the Blackmagic QueueManager.

j.  Click Finish to close the wizard.

You've successfully added Megarip Published Pagesetup

] Set as the default printer

To
test page.

Printa test page

P g properly, orto the printr, print a

Cancel
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Printing to a Published Pagesetup Printer across a Network

Printing from Mac OS X - Mac OS X, or Windows = Windows
Printing to a Published Pagesetup printer across a network where both computers (the machine sending the print and
the machine running the Blackmagic Server) share a common operating system is straight forward.

If network sharing has been enabled for the system printer destination created for use with the Blackmagic Pagesetup,
the printer will be available in the printer options of any other computer on the network.

Printing from Mac OS X > Windows, or Windows = Mac 0S X
Printing from a computer on the same network, but with a different operating system to the computer running the
Blackmagic Server requires the creation of a new system printer on the computer wishing to print to Blackmagic.

This is done by following the appropriate steps outlined previously for the relevant operating system.
The only alteration is when entering the TCP/IP address and the TCP port number:

1. Enter the network TCP/IP address of the computer on which the Blackmagic Server is running, i.e., the machine
you wish to print to.
2. Enter the TCP Port Number assigned to the Published Pagesetup you wish to print to.
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Troubleshooting

Clustering
Here are some suggestions of where to look if you run into trouble and experience problems when using a Cluster.

Jobs Not Processing Through a Cluster Node
The possible reasons for this are:

Here the Cluster Node called “pomelo” is currently offline. In this |>/2ve Nodes

case, you would check the node server is up, the machine is still 'PVA%T;Z T S’;“{L":swdevelse '—;’?3927";;
connected to the network and can see the Master. If there is a # Imaging

problem with the node, check the error log. One the problem is # Rendering

resolved, click the Refresh button or close and reopen the Clustering v @m:a“ 3% |POmEl0.SWCleVel..... 163:03 Day
application. 4 Ren?;:?ing

The Cluster Node is not configured to image, render or both. Check the ClusterStatus to see if either of the
processing tasks have been disabled. To enable them, open the Clustering application and enable the
appropriate task.

The Cluster Node has a Processing Pool attached and the Pagesetup you are submitting jobs to is not contained
within the Pool. You can either unselect the Pool or add the Pagesetup to the Pagesetup Pool.

The Cluster Node has gone offline. To check, open the Clustering application and check the node. If the
Clustering application is already open, click the Refresh button. This will check for node status. If the node
appears grayed out or disabled, this indicates the node is not currently online.

The Node and Master are different versions. The node
should always be upgraded when the Master is to maintain the same versions in a Cluster.

Cluster Nodes Errors Log

The Cluster Nodes create an error log, which logs all the messages from the node. This is located in the Blackmagic
installation directory on the node’s own machine and is called “errors.log”. This can be viewed with a normal text editor
and can help to track a problem, or it can be sent to support for assistance in tracing a problem.

A Node Cannot Be Found
Once you have started your node successfully, you should be able to see it in the Clustering application. If not, you need
to add the node manually. If this fails, there are a few things to check:

Verify the node is still running and the clock is still counting up.
Check the error log for any messages.
Check that the Master machine can ping the node machine. If not, there may be a network issue and you will
need to contact your network administrator for assistance.
Check the ports on the machines are open for the node to connect to the Master and they are not being used by
anything else. The port numbers for the node are as follows:

o 9103 /tcp - Server connects here and submits jobs via this port.

o 9103/udp - Listens to broadcasts so the Server can enumerate available Node Servers.
Make sure the node is the same version as the Master. Nodes (Blackmagic Slaves) should always be upgraded
at the same time as the Master.
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Printing to a Pagesetup on Windows
Here are some suggestions of where to look if you run into trouble and experience problems when printing,.

For all of the methods documented in this guide, test each step to see where the problems arise. For example, when a
printer is created, try printing a test page.

Printing From Mac to Windows
When printing from a Mac to a shared Windows printer, there are a couple of utilities available to verify whether or not
the printer is installed correctly and working. These are:

The CUPs printing system on the Mac has a web interface that lets you view and test
printers. To access this, do the following: /g\ G http://localhost:631/

1. Open a web browser and enter the following address:

http://localhost:631
a. This will connect to the local print system.

2. Choose Manage Printers or select the Printers tab and the list of
printers configured on the Mac will appear.

3. Scroll down the list to locate the printer. A detailed description of
the printer is available here.

4. Print a test page to the Windows printer. This will determine if
the connection from the Mac to the Windows
device is valid. The test job should appear in
the Windows print spooler.

Sasrch in Primters: =) (6=

Maintenance vl

Print Test Page
. . . . . Clean Print Heads
As mentioned earlier, if a name is created with Print Self Test Page
Pause Printer
spaces or hyphens these are transposed to Reject Jobs
underscores for the actual printing device. Through Move All Jobs

Cancel All Jobs
CUPs the actual device name is shown.

The description still contains the spaces but the actual device being printed to has underscores. Another way to check
the status is to use the terminal.

1. Open aterminal from the Applications > Utilities folder
In the terminal type: lpstat -p
This will report on all printers configured on the Mac.
2. Search for your printer in the list and verify the name. The format will be like:
printer my_printer_with_spaces is idle. Enabled since Jan 01 00:00

3. Try and print from the terminal. Locate a print file (run a test job with the correct driver and find the file in the
raster folder in the installation directory) and type the following on the command line:

lp -P<printer> <jobname>
For the example of a HP printer, we can type the following: Ipr -Php_t1100_via_tanglefoot Quickcal_230166.rtl
This should submit the rtl file created by the Server to the printer spooler.

You must be in the raster folder when the command is typed or if not, enter the full path to the file, for e.g,
Applications/Serendipity/Serendipity Blackmagic/raster/Quickcal_230166.rtl.
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The Mac Spooler Reports “NT_ACCESS_DENIED”

This means that the print system cannot access the printer. It may be that there are insufficient privileges for the user
trying to connect, the username and/or password could be incorrect, or the username and password part of the string
have been forgotten.

Client Error
When testing with Ipr or from Serendipity Blackmagic and the error “client-error-not-found” is seen, it means it is
unable to find the printer the file is being sent to. Check to make sure the name of the printer is correct.

Unable to Print to Remote Windows Printer
This can happen from Mac or Windows.

If you are on a Windows machine and are creating a new printer to connect to the remote printer but it fails to find the
path, make sure the remote printer is shared and the name is correct.
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Glossary

Client - GUI that monitors jobs and allows configuration of the Server.

Clustering - The use of multiple machines on a network for distributed processing.

CMM - Colour Management Module.

CRT - Cathode Ray Tube. Describes the type of monitor.

CTP - Computer to Plate.

CUPS - Common UNIX Printing System.

Data Types - Database groups such as Pagesetups or RIPs etc.

DPI - Dots Per Inch (resolution).

EPS - Encapsulated Postscript File.

FTP - File Transfer Protocol - Method for copying files between computers across networks.
GUI - Graphical User Interface.

ICC - International Color Consortium.

ICC Profile - A colour lookup table used for converting colour of a job from one device to another.
LAN - Local Area Network.

LCD - Liquid Crystal Display.

LPI - Lines Per Inch (Screen Ruling).

Master - A Master Server, controlling Slave nodes in a Clustering environment.
QueueManager - Client module that displays job queues and jobs in those queues.
QueueStatus - Monitors the progress of a job through the system.

Real Density - Colour content of a patch as measured.

RIP - Raster Image Processor.

Server - Software module that handles the processing of jobs.

Slave (Node) - A separate processing node on the network. Used for processing jobs by a Master.
TCP/IP - Transmission Control Protocol / Internet Protocol.

Visual Density — The darkness of the patch measured (how much light is absorbed). The more light absorbed, the
darker the Visual Density.

WAN - Wide Area Network.
Workbench - Client application used to configure the Server.
YN - Yule Nielsen Number.

Yule Nielsen Number - A “fudge factor” used when calculating % tint (dot area) from density readings.
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Copyright Notices

PNG Library Copyright
Copyright © 1995, 1996 Guy Eric Schalnat, Group 42, Inc.

Contributing Authors: Andreas Dilger, Dave Martindale, Guy Eric Schalnat, Paul Schmidt, Tim Wegner.

The contributing authors would like to thank all those who helped with testing, bug fixes and patience. You know who
you are. This wouldn’t have been possible without all of you.

Thanks to Frank J. T. Wojcik for reviewing the documentation.

The PNG Reference Library is supplied “as is”. The Contributing Authors and Group 42, Inc. disclaim all warranties,
expressed or implied, including without limitation, the warranties of merchantability and of fitness for any purpose.
The Contributing Authors and Group 42, Inc. assume no liability for damages, direct or consequential, which may result
from the use of the PNG Reference Library.

Permission is hereby granted to use, copy, modify and distribute this source code, or portions hereof, for any purpose,
without fee, subject to the following restrictions:

1. The origin of this source code must not be misrepresented.
2. Altered versions must be plainly marked as such and must not be misrepresented as being the original source.
3. This Copyright Notice may not be removed or altered from any source or altered source distribution.

Compression Library Copyright
Copyright © 1995 Jean-loup Gailly and Mark Adler.

This software is provided “as is”, without any express or implied warranty. In no event will the authors be held liable
for any damages arising from the use of this software.

Permission is granted to anyone to use this software for any purpose, including commercial applications and to alter it
and redistribute it freely, subject to the following restrictions:

1. The origin of this software must not be misrepresented; you must not claim that you wrote the original
software. If you use this software in a product, an acknowledgment in the product documentation would be
appreciated but is not required.

2. Altered source versions must be plainly marked as such, and must not be misrepresented as being the original
software.

3. This notice may not be removed or altered from any source distribution.

Jean-loup Gailly and Mark Adler.

gzip@prep.ai.mit.edu madler@alumni.caltech.edu

Independent JPEG Group’s Copyright

The authors make no warranty or representation, either express or implied, with respect to this software, its quality,
accuracy, merchantability, or fitness for a particular purpose. This software is provided “as is” and you, its user, assume
the entire risk as to its quality and accuracy.

This software is copyright © 1991, 1992, 1993, 1994, 1995, Thomas G. Lane. All Rights Reserved except as
specified below.

Permission is hereby granted to use, copy, modify and distribute this software (or portions thereof) for any purpose,
without fee, subject to these conditions:

1. If any part of the source code for this software is distributed, then this README file must be included, with this
copyright an no-warranty notice unaltered; and any additions, deletions, or changes to the original files must
be clearly indicated in accompanying documentation.
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2. If only executable code is distributed, then the accompanying documentation must state that “this software is
based in part on the work of the Independent JPEG Group”.

3. Permission for use of this software is granted only if the user accepts full responsibility for any undesirable
consequences; the authors accept NO LIABILITY for damages of any kind.

These conditions apply to any software derived from or based on the IJG code, not just to the unmodified library. If you
use our work, you ought to acknowledge us.

Permission is NOT granted for the use of any IJG author’s name or company name in advertising or publicity relating to
this software or products derived from it. This software may be referred to only as “the Independent JPEG Group’s
software”.

We specifically permit and encourage the use of this software as the basis of commercial products, provided that all
warranty or liability claims are assumed by the product vendor.

ansi2knr.c is included in this distribution by permission of L. Peter Deutsch, sole proprietor of its copyright holder,
Aladdin Enterprises of Menlo Park, CA. ansi2Zknr.c is NOT covered by the above copyright and conditions, but instead
by the usual distribution terms of the Free Software Foundation; principally, that you must include source code if you
redistribute it. (See the file ansiZknr.c for full details). However, since ansi2knr.c is not needed as part of any program
generated from the IJG code, this does not limit you more than the foregoing paragraphs do.

“The Graphics Interchange Format © is the Copyright property of CompuServe Incorporated. GIF (sm) is a Service Mark
property of CompuServe Incorporated.”

Copyright © 1980, 1993
The Regents of the University of California. All Rights Reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the
following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following
disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

3. All advertising materials mentioning features or use of this software must display the following

acknowledgment:

This product includes software developed by the University of California, Berkeley and its contributors.

5. Neither the name of the University nor the names of its contributors may be used to endorse or promote
products derived from this software without specific prior written permission.

>

THIS SOFTWARE IS PROVIDED BY THE REGENTS AND CONTRIBUTORS “AS IS” AND ANY EXPRESS OR IMPLIED
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS
FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE REGENTS OR CONTRIBUTORS BE LIABLE
FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT
NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA OR PROFITS; OR
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT,
STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Copyright © 1990, 1994 Regents of the University of Michigan
All Rights Reserved.

Permission to use, copy, modify and distribute this software and its documentation for any purpose and without fee is
hereby granted, provided that the above copyright notice appears in all copies and that both that copyright notice and
this permission notice appear in supporting documentation, and that the name of The University of Michigan not be
used in advertising or publicity pertaining to distribution of the software without specific, written prior permission.
This software is supplied as is without expressed or implied warranties of any kind.

This product includes software developed by the University of California, Berkeley and its contributors.
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Code in sys/linux is developed by Alan Cox. You may redistribute it and/or modify it under the terms of the GNU
General Public License as published by the Free Software Foundation; either version 2 of the License, or (at your
option) any later version.

Research Systems Unix Group
The University of Michigan
C/0 Wesley Craig

535 W. William Street

Ann Arbor, Michigan
+1-313-764-2278
netatalk@umich.edu

GNU GENERAL PUBLIC LICENSE
Version 2, June 1991

Copyright © 1989, 1991 Free Software Foundation, Inc.

675 Mass Ave,
Cambridge,
MA 02139, USA

Everyone is permitted to copy and distribute verbatim copies of this license document, but changing it is not allowed.

Preamble

The licenses for most software are designed to take away your freedom to share and change it. By contrast, the GNU
General Public License is intended to guarantee your freedom to share and change free software-to make sure the
software is free for all its users. This General Public License applies to most of the Free Software Foundation’s software
and to any other program whose authors commit to using it. (Some other Free Software Foundation software is
covered by the GNU Library General Public License instead). You can apply it to your programs, too. When we speak of
free software, we are referring to freedom, not price. Our General Public Licenses are designed to make sure that you
have the freedom to distribute copies of free software (and charge for this service if you wish), that you receive source
code or can get it if you want it, that you can change the software or use pieces of it in new free programs; and that you
know you can do these things.

To protect your rights, we need to make restrictions that forbid anyone to deny you these rights or to ask you to
surrender the rights. These restrictions translate to certain responsibilities for you if you distribute copies of the
software, or if you modify it.

For example, if you distribute copies of such a program, whether gratis or for a fee, you must give the recipients all the
rights that you have. You must make sure that they too, receive or can get the source code. And you must show them
these terms so they know their rights.

We protect your rights with two steps: (1) copyright the software, and (2) offer you this license which gives you legal
permission to copy, distribute and/or modify the software.

Also, for each author’s protection and ours, we want to make certain that everyone understands that there is no
warranty for this free software. If the software is modified by someone else and passed on, we want its recipients to
know that what they have is not the original, so that any problems introduced by others will not reflect on the original
author’s reputations.

Finally, any free program is threatened constantly by software patents. We wish to avoid the danger that redistributors
of a free program will individually obtain patent licenses, in effect making the program proprietary. To prevent this, we
have made it clear that any patent must be licensed for everyone’s free use or not licensed at all. The precise terms and
conditions for copying, distribution and modification follow.
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GNU GENERAL PUBLIC LICENSE
TERMS AND CONDITIONS FOR COPYING, DISTRIBUTION AND MODIFICATION

0. This License applies to any program or other work which contains a notice placed by the copyright holder

saying it may be distributed under the terms of this General Public License. The “Program”, below, refers to any
such program or work, and a “work based on the Program” means either the Program or any derivative work
under copyright law: that is to say, a work containing the Program or a portion of it, either verbatim or with
modifications and/or translated into another language. (Hereinafter, translation is included without limitation
in the term “modification”). Each licensee is addressed as “you”.
Activities other than copying, distribution and modification are not covered by this License; they are outside its
scope. The act of running the Program is not restricted, and the output from the Program is covered only if its
contents constitute a work based on the Program (independent of having been made by running the Program).
Whether that is true depends on what the Program does.

1. You may copy and distribute verbatim copies of the Program’s source code as you receive it, in any medium,
provided that you conspicuously and appropriately publish on each copy an appropriate copyright notice and
disclaimer of warranty; keep intact all the notices that refer to this License and to the absence of any warranty;
and give any other recipients of the Program a copy of this License along with the Program.

2. You may modify your copy or copies of the Program or any portion of it, thus forming a work based on the
Program, and copy and distribute such modifications or work under the terms of Section 1 above, provided
that you also meet all of these conditions:

a. You must cause the modified files to carry prominent notices stating that you changed the files and the
date of any change.

b. You must cause any work that you distribute or publish, that in whole or in part contains or is derived
from the Program or any part thereof, to be licensed as a whole at no charge to all third parties under
the terms of this License.

c. If the modified program normally reads commands interactively when run, you must cause it, when
started running for such interactive use in the most ordinary way, to print or display an
announcement including an appropriate copyright notice and a notice that there is no warranty (or
else, saying that you provide a warranty) and that users may redistribute the program under these
conditions, and telling the user how to view a copy of this License. (Exception: if the Program itself is
interactive but does not normally print such an announcement, your work based on the Program is not
required to print an announcement).

These requirements apply to the modified work as a whole. If identifiable sections of that work are not derived from
the Program, and can be reasonably considered independent and separate works in themselves, then this License, and
its terms, do not apply to those sections when you distribute them as separate works. But when you distribute the same
sections as part of a whole which is a work based on the Program, the distribution of the whole must be on the terms of
this License, whose permissions for other licensees extend to the entire whole, and thus to each and every part
regardless of who wrote it.

Thus, it is not the intent of this section to claim rights or contest your rights to work written entirely by you; rather, the
intent is to exercise the right to control the distribution of derivative or collective works based on the Program. In
addition, mere aggregation of another work not based on the Program with the Program (or with a work based on the
Program) on a volume of a storage or distribution medium does not bring the other work under the scope of this
License.

3. You may copy and distribute the Program (or a work based on it, under Section 2) in object code or executable
form under the terms of Sections 1 and 2 above provided that you also do one of the following:

a. Accompany it with the complete corresponding machine-readable source code, which must be
distributed under the terms of Sections 1 and 2 above on a medium customarily used for software
interchange; or,

b. Accompany it with a written offer, valid for at least three years, to give any third party, for a charge no
more than your cost of physically performing source distribution, a complete machine-readable copy
of the corresponding source code, to be distributed under the terms of Sections 1 and 2 above on a
medium customarily used for software interchange; or,

c. Accompany it with the information you received as to the offer to distribute corresponding source
code. (This alternative is allowed only for noncommercial distribution and only if you received the
program in object code or executable form with such an offer, in accord with Subsection b above).

The source code for a work means the preferred form of the work for making modifications to it. For an executable
work, complete source code means all the source code for all modules it contains, plus any associated interface
definition files, plus the scripts used to control compilation and installation of the executable. However, as a special
exception, the source code distributed need not include anything that is normally distributed (in either source or binary
form) with the major components (compiler, kernel, and so on) of the operating system on which the executable runs,
unless that component itself accompanies the executable.
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If distribution of executable or object code is made by offering access to copy from a designated place, then offering
equivalent access to copy the source code from the same place counts as distribution of the source code, even though
third parties are not compelled to copy the source along with the object code.

4,

10.

11.

You may not copy, modify, sublicense, or distribute the Program except as expressly provided under this
License. Any attempt otherwise to copy, modify, sublicense or distribute the Program is void, and will
automatically terminate your rights under this License. However, parties who have received copies, or rights,
from you under this License will not have their Licenses terminated so long as such parties remain in full
compliance.
You are not required to accept this License, since you have not signed it. However, nothing else grants you
permission to modify or distribute the Program or its derivative works. These actions are prohibited by law if
you do not accept this License. Therefore, by modifying or distributing the Program (or any work based on the
Program), you indicate your acceptance of this License to do so, and all its terms and conditions for copying,
distributing or modifying the Program or works based on it.
Each time you redistribute the Program (or any work based on the Program), the recipient automatically
receives a license from the original licensor to copy, distribute or modify the Program subject to these terms
and conditions. You may not impose any further restrictions on the recipients’ exercise of the rights granted
herein. You are not responsible for enforcing compliance by third parties to this License.
If, as a consequence of a court judgment or allegation of patent infringement or for any other reason (not
limited to patent issues), conditions are imposed on you (whether by court order, agreement or otherwise)
that contradict the conditions of this License, they do not excuse you from the conditions of this License. If you
cannot distribute so as to satisfy simultaneously your obligations under this License and any other pertinent
obligations, then as a consequence you may not distribute the Program at all. For example, if a patent license
would not permit royalty-free redistribution of the Program by all those who receive copies directly or
indirectly through you, then the only way you could satisfy both it and this License would be to refrain entirely
from distribution of the Program.
If any portion of this section is held invalid or unenforceable under any particular circumstance, the
balance of the section is intended to apply and the section as a whole is intended to apply in other
circumstances.
It is not the purpose of this section to induce you to infringe any patents or other property right claims
or to contest validity of any such claims; this section has the sole purpose of protecting the integrity of
the free software distribution system, which is implemented by public license practices. Many people
have made generous contributions to the wide range of software distributed through that system in
reliance on consistent application of that system; it is up to the author/donor to decide if he or she is
willing to distribute software through any other system and a licensee cannot impose that choice.
This section is intended to make thoroughly clear what is believed to be a consequence of the rest of
this License.
If the distribution and/or use of the Program is restricted in certain countries either by patents or by
copyrighted interfaces, the original copyright holder who places the Program under this License may add an
explicit geographical distribution limitation excluding those countries, so that distribution is permitted only in
or among countries not thus excluded. In such case, this License incorporates the limitation as if written in the
body of this License.
The Free Software Foundation may publish revised and/or new versions of the General Public License from
time to time. Such new versions will be similar in spirit to the present version, but may differ in detail to
address new problems or concerns.
Each version is given a distinguishing version number. If the Program specifies a version number of
this License which applies to it and “any later version”, you have the option of following the terms and
conditions either of that version or of any later version published by the Free Software Foundation. If
the Program does not specify a version number of this License, you may choose any version ever
published by the Free Software Foundation.
If you wish to incorporate parts of the Program into other free programs whose distribution conditions are
different, write to the author to ask for permission. For software which is copyrighted by the Free Software
Foundation, write to the Free Software Foundation; we sometimes make exceptions for this. Our decision will
be guided by the two goals of preserving the free status of all derivatives of our free software and of promoting
the sharing and reuse of software generally.

NO WARRANTY

BECAUSE THE PROGRAM IS LICENSED FREE OF CHARGE, THERE IS NO WARRANTY FOR THE PROGRAM, TO
THE EXTENT PERMITTED BY APPLICABLE LAW. EXCEPT WHEN OTHERWISE STATED IN WRITING THE
COPYRIGHT HOLDERS AND/OR OTHER PARTIES PROVIDE THE PROGRAM “AS IS” WITHOUT WARRANTY OF
ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES
OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. THE ENTIRE RISK AS TO THE QUALITY
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AND PERFORMANCE OF THE PROGRAM IS WITH YOU. SHOULD THE PROGRAM PROVE DEFECTIVE, YOU
ASSUME THE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION.

12. IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING WILL ANY COPYRIGHT
HOLDER, OR ANY OTHER PARTY WHO MAY MODIFY AND/OR REDISTRIBUTE THE PROGRAM AS PERMITTED
ABOVE, BE LIABLE TO YOU FOR DAMAGES, INCLUDING ANY GENERAL, SPECIAL, INCIDENTAL OR
CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE THE PROGRAM (INCLUDING
BUT NOT LIMITED TO LOSS OF DATA OR DATA BEING RENDERED INACCURATE OR LOSSES SUSTAINED BY
YOU OR THIRD PARTIES OR A FAILURE OF THE PROGRAM TO OPERATE WITH ANY OTHER PROGRAMS),
EVEN IF SUCH HOLDER OR OTHER PARTY HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

END OF TERMS AND CONDITIONS

Appendix: How to Apply These Terms to Your new Programs
If you develop a new program, and you want it to be of the greatest possible use to the public, the best way to achieve
this is to make it free software which everyone can redistribute and change under these terms.

To do so, attached the following notices to the program. It is safest to attach them to the start of each source file to most
effectively convey the exclusion of warranty; and each file should have at least the “copyright” line and a pointer to
where the full notice is found.

<one line to give the program’s name and a brief idea of what is does>
Copyright © 19yy <name of author>

This program is free software; you can redistribute it and/or modify it under the terms of the GNU General
Public License as published by the Free Software Foundation; either version 2 of the License, or (at your
option) any later version.

This program is distributed in the hope that it will be useful, but WITHOUT ANY WARRANTY; without even the
implied warranty of MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE. See the GNU General
Public License for more details.

You should have received a copy of the GNU General Public License along with this program; if not, write to the
Free Software Foundation, Inc., 675 Mass Ave, Cambridge, MA 02139, USA.

Also add information on how to contact you by electronic and paper mail.
If the program is interactive, make it output a short notice like this when it starts in an interactive mode:

Gnomovision version 69, Copyright © 19yy name of author
Gnomovision comes with ABSOLUTELY NO WARRANTY; for details type “show w”. This is free software, and
you are welcome to redistribute it under certain conditions; type “show c” for details.

The hypothetical commands “show w” and “show c” should show the appropriate parts of the General Public License. Of
course, the commands you use may be called something other than “show w” and “show c”; they could even be mouse-
clicks or menu items-whatever suits your program.

You should also get your employer (if you work as a programmer) or your school, if any, to sign a “copyright
disclaimer” for the program, if necessary. Here is a sample; alter the names:

Yoyodyne Inc., hereby disclaims all copyright interest in the program “Gnomovision” (which makes passes at
compilers) written by James Hacker.

<signature of Ty Coon>, 1 April 1989

Ty Coon, President of Vice

This General Public License does not permit incorporating your program into proprietary programs. If your program is
a subroutine library, you may consider it more useful to permit linking proprietary applications with the library. If this
is what you want to do, use the GNU Library General Public License instead of this License.
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Copyright
The XFree86 Project, Inc.

Copyright © 1994, 1995 The XFree86 Project, Inc. All Rights Reserved.

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated
documentation files (the “Software”), to deal in the Software without restriction, including without limitation the rights
to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons to
whom the Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial portions of the
Software. THE SOFTWARE IS PROVIDED “AS IS”, WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED,
INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE
AND NONINFRINGEMENT. IN NO EVENT SHALL THE XFREE86 PROJECT BE LIABLE FOR ANY CLAIM, DAMAGES OR
OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN
CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

Except as contained in this notice, the name of the XFree86 Project shall not be used in advertising or otherwise to
promote the sale, use or other dealings in this Software without prior written authorization from the XFree86 Project.

$XConsortium: CPYRIGHT.sgml,v 1.2/95/01/16 13:17:39 kaleb Exp $

Generated from XFree86: xc/programs/Xserver/hw/xfree86/doc/sgml/CPYRIGHT.sgmlv 3.3 1995/01/28 16:01:20
dawes Exp $

$XFree86: xc/programs/Xserver/hw/xfree86/doc/COPYRIGHT,v 3.8 1995/07/24 06:52:11 dawes Exp $

CIECAMO2 Copyright
Copyright (c) 2003 Billy Biggs <vektor@dumbterm.net>

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated
documentation files (the "Software"), to deal in the Software without restriction, including without limitation the rights
to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons to
whom the Software is furnished to do so, subject to the following conditions: The above copyright notice and this
permission notice shall be included in all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT
NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND
NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM,
DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,
OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.
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